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HOPEX IT Business Management




INTRODUCTION TO HOPEX IT BUSINESS
MANAGEMENT

HOPEX IT Business Management is a tool in the AQUILA Enterprise Architecture solution that
helps enterprise architects manage their application portfolios, design IT solutions aligned with
business needs, and plan changes to their information systems.

HOPEX IT Business Management complements the application inventory and management
functions of HOPEX IT Portfolio Management, which it integrates by default, with strategic
planning functions.

The purpose of this guide is therefore to present how to make best use of these functionalities for
the successful evolution of your information system.

Presentation of HOPEX IT Business Management

Connecting to HOPEX IT Business Management

Preparing the Work Environment HOPEX IT Business Management
Using ArchiMate Diagrams in an Enterprise Architecture solution
About This Guide

SSENENENEN
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PRESENTATION OF HOPEX IT BUSINESS MANAGEMENT

Combined with the solutions of HOPEX suite, HOPEX IT Business Management
provides the methodology and the tools you need to plan your business
transformation.

Positioning of the HOPEX IT Business Management solution

HOPEX IT Business Management offers a formalism of reflection on the
company's value streams and business capabilities. This solution makes it possible
to define a business transformation strategy divided into phases with clearly
identified objectives and means. At each of these phases, standard reports are
proposed to simplify analysis of the subject and assist in decision-making.

HOPEX IT Portfolio Management

The HOPEX IT Business Management solution includes HOPEX IT Portfolio
Management product that offers the following possibilities:

e Aligning the application assets with business requirements;

e Reducing IS operating costs by removing applications no longer used;

e Managing technologies relating to applications;

e Identifying the business services covered by applications or application

versions;
e Deciding on investments for maximum profits.

HOPEX Customer Journey

The HOPEX IT Business Management solution includes the HOPEX Customer
Journeyproduct to represent the acquisition process of a product or a service by a
specific customer. Mapping a customer journey provides an overview of customer
expectations, painpoints encountered, and the resources used at each step of the
journey. Last but not least, touchpoints, which are the points of interaction between
the customer and the company, are used to measure and improve overall customer
satisfaction.

[ A customer Jjourney is used to describe and organize all service
interactions between the enterprise and a persona for a given result.

Representing a customer journey will allow you to easily identify these critical

points. HOPEX Customer Journey is used to describe solutions for improvement
and to assess them at different dates.

w  For more details on product, see "The customer journey" chapter
in the HOPEX Business Process Analysis guide.
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HOPEX Business Process Analysis

The HOPEX Business Process Analysis solution provides HOPEX IT Business
Management with:

e The description of organizations that implement the business functions
and/or the business capabilities identified in HOPEX IT Business
Management ;

e The description of organizational processes that implements the value
streams identified in HOPEX IT Business Management .

HOPEX IT Architecture

The HOPEX IT Architecture solution provides HOPEX IT Business Management
with the possibilities to model the information system architecture according to a
number of analysis perspectives:

e Description of application architecture offers a detailed view of
information exchanges between applications, services, databases and
organizational.

e Description of information system technical infrastructure enables
monitoring of applications deployment on the different enterprise.

e Description of complex systems involving different types of IT and non IT
resources.

The HOPEX IT Business Management solution provides HOPEX IT
Architecture with the possibilities to support the description, analysis and
transformation projects of the IT system.

HOPEX for the ArchiMate® Framework

The HOPEX for the ArchiMate® Framework module complements HOPEX IT
Business Management by describing the environment of certain Enterprise
Architecture building blocks in the ArchiMate® formalism.
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CONNECTING TO HOPEX IT BUSINESS MANAGEMENT

The menus and commands available in HOPEX IT Business Management depend
on the profile with which you are connected.

Connecting to the solution

To connect to HOPEX IT Business Management , see HOPEX Common Features,
"HOPEX Desktop", "Accessing HOPEX (Web Front-End)".

HOPEX IT Business Management Profiles

The rights of different users on objects depend on their assigned profiles. For more
information on creation of users and assignment of profiles, see the chapter
"Managing Users" in the HOPEX Power Supervisor guide.

In HOPEX IT Business Management , there are default user profiles with which
specific rights and accesses are associated. These profiles are:

e Enterprise architect

e EA functional administrator
e EA Contributor
e EA Viewer
Profile Tasks
Enterprise architect The enterprise architect manages the structure
of an organization to ensure that IT systems are
aligned with current business strategies and
capabilities. valider définition
EA functional administrator The EA functional administrator has rights on all
objects and workflows.
He/she prepares the working environment and
manages reference data used in the solution.
EA Contributor The EA contributor is responsible for validating
the design of the objects assigned to him/her.
EA Viewer The EA viewer has read-only rights on objects in
the repository.
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THE HOPEX IT BUSINESS MANAGEMENT DESKTOP

The menus available in HOPEX IT Business Management depend on the profile
with which you are connected.

For a detailed description of the HOPEX interface, see PLATFORM - Common
Features > HOPEX Desktop > Interface Presentation.

ITBM Home Page

The ITBM solution home page consists of the following sections.
e The header presents some information of general interest.

w These can be defined in the Administrator’ Administration>
Methodological Domain menu.

My priorities: indicates the main strategic themes of interest to
solution users.

Help: points to user documentation and the user community.

The My Scope provides useful indicators of the repository content. See
Scope Indicators below.

The Quick Access provides useful shortcuts:

e Recently viewed: last objects and diagrams accessed by the user
Favorites: user favorites and shared favorites

Actions: quick access to the creation of architecture elements.

My favorite report: displays the user-defined or administrator-

predefined report, which can be used as an entry point into the
repository.
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Scope Indicators

The My Scope section provides useful indicators on application assets. Clicking the
indicator takes you to all the corresponding objects. There are three groups of
indicators:

e Application governance
e Risk and compliance
e Inventory

o'« Application governance [¢] +'s Risk and compliance c o'» Inventory (c)
111 Applications without owner 29 critical applications 168 Applications
71 Applications not linked to a Portfolio 74 Applications with an obsolescence risk 135 On-premises Applications
24 Applications included ina O Applications with sensitive data 33 Cloud Applications
transformation project
echnologies soon obsolete echnologies
Technologi bsol Technologi
BE5 Applications not mapped to Business
Capabilities
248 Technologies without lifecycle 12 Microservices

139 Applications without exposed
exchanges

Application governance

This tile lists the following objects:

e Applications without owners

e Applications lot linked to a portfolio

e Applications without exposed exchanges: applications that neither
receive nor send flows.

w  See Specifying Data Exchanged With Other Applications.

e Applications included in a transformation project: these are the
applications that are part of the deliverables of a transformation project.

m  See Defining the Business Case of a Project.
e Applications not mapped to business capabilities.
w  See Defining Application Functional Scope.

Risk and compliance

This tile lists the following objects:

e Critical applications: all applications that cover a strategic business
capability, in other words, whose Business Value is "Significant”.

w This is the business value defined during the last business
capability assessment. For more details on assessing a business
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capability, see Using assessment for Business Capabilities and their
Implementation.

e Applications with an obsolescence risk: applications whose risk of
obsolescence is between “*Medium” and “Very high”.
w  The risk of application obsolescence corresponds to the highest risk

of the technologies linked to it. See the obsolescence risk in the
Overview of a technology.

e Applications with sensitive data: applications linked to data stores
containing data (classes, MD entities, data views) or Concepts in the

"Sensitive data" category.
w  See also: Defining the Data Used by an Application.

e Technologies soon obsolete
e Technologies without lifecycle

Inventory

The Inventory tile displays the number of following objects:
e Applications
e On-premises Applications

w This s the type of application installation. See Application
identification> Cloud Computing.

e (Cloud Applications

w This s the type of application installation. See Application
identification> Cloud Computing.

e Technologies
e Microservices

Enterprise Architect Desktop
The HOPEX IT Business Management navigation menus are:

Business function
The Business menu is dedicated to strategic transformation.

See Introduction to strategic transformation.

Applications

The Applications menu shows all the applications in the repository, as well as the

application portfolios.

See Drawing up an Application Inventory.

Technologies
The Technologies menu lets you manage application-related technologies.

See Drawing up a Technology Inventory.
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Data

The Data menu allows you to make an inventory of the conceptual and logical data
exchanged within the application assets.

See Managing the Data Used in the Application Assets.

Tools

The Tools menu gives access to the following submenus:

e SMART Analysis to analyze the business value of portfolio applications
and their migration to the Cloud.

=  See SMART Analyses.
e IT-Pedia to import and standardize technologies in HOPEX.
w  See Importing Technologies from IT-Pedia.
e AI-Driven APM, to distinguish technologies from business applications.
w  See Distinguishing Applications from Technologies.
e Assessment and data call.
m  See Collecting Data for a Set of Applications.

Reports

The Reports menu provides a search tool for all report templates and saved
reports.

w  For more details on reports, see PLATFORM - Common Features >
Documentation > Generating Documentation > Generating Reports.

w  For more information on HOPEX IT Business Management
reports, see Portfolio Analysis Reports and List of Analysis Reports
Available on Applications and Application Systems.

Projects
The Projects menu is dedicated to transformation project management.

See Introduction to Project Portfolio Management.

Inventories

The Inventories menu gives access to the following subjects, divided into several
themes.
e Business Architecture theme, giving access to the following
elements:
e business architecture environment

A business architecture environment represents the relationships of
a business functional area with its partners.

e Business Functions

A business function is a conceptual unit of the division of
responsibilities in an enterprise. It is used to structure the management
of information processing, energy, and equipment produced or used.
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Business functions define the skills and the functionalities necessary to
the enterprise to fulfill its mission.

e Business Partners

A business partner designates a third-party who is in relation with
the enterprise within the framework of a given business architecture
envir/qnment. Examples: private sector client, regulatory organization,
supplier.

e Capabilities theme, giving access to the following elements:
¢ Functionalities
e Technology Capabilities
e Hardware capabilities

w  For more information on technology and hardware capabilities, see
Describing a Technology Capability Map with HOPEX IT Architecture.

e Software theme, giving access to the following elements:
e IT Services

An IT service is a software component of an application, that can’t
be deployed alone and that realizes a sub-set of the functionalities of
this application either for end users of this application or inside the
application (or another application). This includes batch programs.

w  For more details on applications services, see Describing an IT
Service with HOPEX IT Architecture.

e Microservices

A microservice is a software component that can be deployed
autonomously, but which does not directly provide an end user service.
It can interact with other application services, applications or application
systems. This is a deployable software component that uses software
technologies. For example: an authentication service, a PDF file printing
service.

w  For more details on microservices, see Describing a microservice
with HOPEX IT Architecture.

e System process

A system process is the executable representation of a process. the
events of the workflow, the tasks to be carried out during the
processing, the algorithmic elements used to specify the way in which

25



26

the tasks follow each other, the information flows exchanged with the
participants.

w  For more details on system processes, see Describing System
Processes.

e Application Hierarchy, to view applications associated with the
following object types: business line, process category, business
capability, etc.

¢ Logical software architecture, to describe the elements contained
in the information system logical architecture.

w  For more details on logical architecture, see Describing Logical
Application Architecture.

e Technologies theme, giving access to the following elements:
e Technologies Hierarchy, to view technologies associated with the

following object types: technology capability, technology type, vendor,
etc.

e Technology Stacks, which are groups of technologies.
w See Defining a Technology Stack.
e Installations theme, to describe application deployment elements.
A facility is a model of site of interest for the enterprise. Examples:
Data Center, Factory or Outlet
w  For more details on facilities, see Describing a Facility.

e Services Catalogs theme, giving access to the following elements:
e Cloud services

m See Using Cloud Services.

e Technical Services, to list the technical services covered by
applications.

e Business Services, to list the business services covered by
applications.

e Hardware Service Catalogs

m  For more details on service catalogs, see the"Using Service
Catalogs" chapter from the HOPEX IT Architecture guide.

e Infrastructure theme, giving access to the following themes:
e IT Infrastructure
e Resource Architecture
e Resource Configuration

Governance

In the Governance menu you can define the regulations to which application
architecture objects are subject.

w In the properties of an application, the Governance page defines
the regulations to which application is subject. By default, this page is
hidden, you can display it using the Show/Hide button of the
application properties.
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Environment

The Environment menu gives access to the following submenus:
e Containers, to access the features of library and environment

management.

w For more details on Containers and Organization, see Preparing
the Work Environment HOPEX IT Business Management.

e Organization, to access the main objects processed with the HOPEX IT
Business Management solution.
e Business lines

A business line is a high level classification of main enterprise

activities. It corresponds for example to major product segments or to
distribution channels. It enables classification of enterprise processes,
organizational units or applications that serve a specific product and/or

specific market.
* Process categories

A process category defines a group of processes. It is linked to a
Process Map or higher level Process Category. It regroups several
processes and/or other categorized elements (e.g. Value Streams,
Applications). It serves as an intermediate categorization level in the
process hierarchy, so as to provide a guided and progressive access to
finer grained processes.

* Processes

A process is a set of operations performed by org-units within a
company or organization, to produce a result. It is depicted as a
sequence of operations, controlled by events and conditions. In the
BPMN notation, the process represents a sub-process from the
organizational point of view.

e Sites

A site is a geographical location of an enterprise. Examples: Boston
subsidiary, Seattle plant, and more generally the headquarters,
subsidiaries, plants, warehouses, etc.

e Org-Units

An org-unit represents a person or a group of persons that
intervenes in the enterprise business processes or information system.
An org-unit can be internal or external to the enterprise. An internal
org-unit is an organizational element of enterprise structure such as a
management, department, or job function. It is defined at a level
depending on the degree of detail to be provided on the organization
(see org-unit type). Example: financial management, sales
management, marketing department, account manager. An external



org-unit is an external entity that exchanges flows with the enterprise.
Example: customer, supplier, government office.

w  For more details on the use of Org-units, see Defining Enterprise
Org-Units.
e Report DataSets

A Report DataSet is a set of data extracted from the HOPEX
repository and used as a data source in reports.

w For more information, see Platform - Common Features >
Documentation > Generating Documentation > Managing Report
DataSets.

e All Sketches, to access all the skectches of your repository.

A sketching diagram is a drawing that enables you to exchange
with your coworkers without an issue of methodology or formalism.

w  For more details on the use of sketches with HOPEX IT
Architecture, see Creating a Sketching diagram with HOPEX IT
Architecture.

e Tags
A tag is a classifying description used to characterize objects.

w  For more details on the use of tags, see Platform - Common
Features > Collaboration Tools > Communicating in HOPEX.
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PREPARING THE WORK ENVIRONMENT HOPEX IT
BUSINESS MANAGEMENT

Inventory and evaluation of the application assets are based on description of
business elements - in order to map business requirements with the application
architectures that serve as their support - as well as organizational elements such
as org-units and deployment sites.

The following points indicate how to create elements that constitute your working
environment. This step is executed by the Functional Administrator.

Defining Enterprise Org-Units

HOPEX IT Business Management is used to describe the org-units of your

enterprise.
An org-unit represents a person or a group of persons that
intervenes in the enterprise business processes or information system.
An org-unit can be internal or external to the enterprise. An internal
org-unit is an organizational element of enterprise structure such as a
management, department, or job function. It is defined at a level
depending on the degree of detail to be provided on the organization
(see org-unit type). Example: financial management, sales
management, marketing department, account manager. An external
org-unit is an external entity that exchanges flows with the enterprise.
Example: customer, supplier, government office.

Creating an org-unit

To create an org-unit:
1. Click the Environment > Organization navigation menu.
2. In the edit area, click the Org-Units folder then New > Org-Unit.
3. Enter the name of the org-unit.
4. Click OK.

Specifying org-unit properties

To specify the properties of an org-unit:
1. Click the org-unit to open its Properties window.
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2. In the Characteristics page, in the Org-Unit Type field, select the org-
unit.
There are several types of org-units:
e An "Accountable" org-unit (for example, Sales Manager).
e A "Generic" org-unit corresponds to a role to be played during a
project (for example, Writer, Requester).
e A "Structure" org-unit (for example, Sales Management).
e A "Function" org-unit (for example, Sales Engineer).

m  You can also specify its details (company name, e-mail address,
telephone number, etc.).

Defining Categorization Schemas

Several categorization schemas can be proposed:

e Data categories,
e Measure Schemes Categorization.

Data categories

HOPEX IT Business Management Solution enables data classification using data
categories.
w  For more information on Data Categories see the HOPEX Data
Governance guide.
To access the list of data categories from the Administration navigation menu:
} Select Categorization Schemas and unfold the Data Categories.
The list of the repository data categories appears.

To create a data category from the Administration navigation menu:
1. Select Categorization Schemas.
2. Select the Data Categories folder and click New > Data Category.
3. Enter the Name of your data category well as its Owner and click OK.
The new data category appears in the list.

To connect a data to a data category :

1. Open the Entities property page.
2. Select the tab that corresponds to the data you want to classify.
3. Click the Connect button ans select the data that interests you.

Measure Schemes Categorization

The Measurement Schemes allow you to define measurement systems specific to
the area you want to deal with.
For example: the "Retail bank” schema or the “investment bank” schema.
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The Measurement Schemes are principally based on:
e flow Measures provide a way to define parameters of the flows described
in the flow scenario using les Measurement Types,
e The Qualifying Values and Measurable Properties are used to define
performance constraints that must be complied with by the enterprise
plan.

Flow Measure and Measurement Type

Flow Measures provide a way to define parameters of the that are used described
in the scenario of flows.
An application flow represents the circulation of information

between applications or within an application. An application flow can
carry a content.

w  For more information message flow scenarios, see chapter “Using a
Scenario of Application Flows diagram” chapter in the HOPEX IT
Architecture guide.

A Flow Measure is characterized by Flow Measure Type.

A Measurement Type is defined by several item types:

e Measurement types,

e flow Measure types, which are defined by a set of Flow measures.

e Technical flow measure types, which are defined by a set of Technical
flow measures.

Measurable Properties and Set of Constraining Properties

The nature of a Qualifying Value is defined by a Measurable Property.

A measurable property expresses the nature of indicators
(duration, mass, cost, etc.) and defines the unit used to measure them
(minutes, kilograms, euros, etc.). Measurable properties are used to
define indicators, they can be elementary or composite. Elementary
measurable properties are described by measurement units: kg, Liter,
Gallon, Hour, Minute.
A Set of Constraining Properties is a set of Measurement Types used to define the
performance constraints that must be complied with by the building blocks making
up the enterprise, at the forefront of which are the business capabilities and the
exhibited business capabilities in a transformation stage.

For example: “"Security” or "Performances” measurement types

A Set of Constraining Properties is defined by different component types:

e Sets of Constraining Properties,

e Measurable Properties,

e Flow Measure types, which are defined by a set of Flow measures.

e Technical flow measure types, which are defined by a set of Technical
flow measures.

w  For more details on Sets of Constraining Properties, see Using
performance indicators.
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Defining the Process Categories

APQC proposes standard repositories of process categories specific to each major

activity sector.

A process category defines a group of processes. It is linked to a
Process Map or higher level Process Category. It regroups several
processes and/or other categorized elements (e.g. Value Streams,
Applications). It serves as an intermediate categorization level in the
process hierarchy, so as to provide a guided and progressive access to

finer grained processes.
A set of standard process categories repositories from APQC is supplied with HOPEX
IT Business Management .
If you want to use APQC process categories for the different activity sectors, you
can also import the corresponding libraries.

To import the APQC libraries, see the chapter "Prerequisites to using APQC libraries"
of the HOPEX Business Process Analysis guide.

To access process categories of your enterprise:
1. Click the Environment > Organization navigation menu.
2. Expand the Process Categories folder.
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USING ARCHIMATE DIAGRAMS IN AN ENTERPRISE
ARCHITECTURE SOLUTION

HOPEX for the ArchiMate® Frameworkproduct provides facilities to use the set
of concepts defined by the Open Group for ArchiMate® 3.1. ArchiMate® concepts
are mapped with HOPEX Enterprise Architecture building blocks so as to manage
compatibility and continuity with other models.
w  For more details on HOPEX for the ArchiMate® Framework
implementation, see The HOPEX MetaModel for ArchiMate.
Depending on the licenses you have access to ArchiMate® formalism to build
sketches that represent the models of your enterprise architecture. These sketches
can then be synchronized with HOPEX solution inventories, if needed, by
associating their elements with objects in your repository.

Note that the ArchiMate® diagrams thus constructed are linked to ArchiMate models
and views in accordance with ArchiMate® standards.
w  For more details on the relationship between the elements of

ArchiMate diagrams and the elements of used in HOPEX solution, see
Synchronizing an ArchiMate model Elements.

Prerequisites to use of ArchiMate diagrams

ArchiMate Diagrams can be accessed from an Enterprise Architecture Building Block
if you have a suitable configuration:
e Using the Enterprise Architecture desktop and products such as: HOPEX
IT Architecture, or HOPEX IT Portfolio Management or HOPEX IT
Business Management .
¢ Having the HOPEX for the ArchiMate® Framework module deployed
and its license accessible for your user.

To use HOPEX for the ArchiMate® Framework, you must import the ArchiMate
module in your environment and the PPM module in each HOPEX repository of the
environment.

To import a module in HOPEX, see Modules > Importing a Module into HOPEX
documentation.

& You must import the ArchiMate module only once even if you
have several repositories.
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Using ArchiMate Diagrams in an Enterprise Architecture solution

To simplify the use of ArchiMate® formalism in an HOPEX Enterprise Architecture
solution, the following facilities are offered to you when creating an ArchiMate
diagram from an EA Building Block:

e Modeling an object in the ArchiMate® formalism, see Creating an
ArchiMate Diagram from an EA Building Block.

e Management of the ArchiMate® model associated with the described
object, see Management of the ArchiMate model in an Enterprise
Architecture solution.

e Management of the ArchiMate® view associated with the described
object, see Managing of the ArchiMate views in an Enterprise
Architecture solution.

e For more details on the relationship setting of ArchiMate diagram items
with the repository HOPEX building blocks, see Synchronizing an
ArchiMate Diagram Elements.

The Architecture Building Blocks (EA building blocks) from which you can create an
ArchiMate diagram are:

e Enterprise,
Processes
Application System
Application
Microservice,
Software Installation,
IT infrastructure,
Facility,
Project.

Creating an ArchiMate Diagram from an EA Building Block

With the ArchiMate® framework, a diagram is created in the context of a Model and
a View. When an ArchiMate diagram is created from an EA building block, the
following actions are done:

e If no model has been defined for the user, an ArchiMate Model is
automatically created. For more details, see Management of the
ArchiMate model in an Enterprise Architecture solution,

e An ArchiMate® View is automatically created and connected to the
described object. For more details, see Managing of the ArchiMate views
in an Enterprise Architecture solution.

e If the type of the described object corresponds to an ArchiMate type, an
ArchiMate® element is automatically created with the same type. The
new ArchiMate® element is associated with the object described. For
more details, see Synchronizing an ArchiMate Diagram Elements.

For example, to create an ArchiMate Diagram from an application:

1. From the Applications navigation menu, select the application of
interest to you and click Create a diagram.
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2. In the selection window, click ArchiMate Diagram.
The diagram opens in the edit area. The ArchiMate component associated
with the application is created and inserted in the diagram.

> Edit: Appli My Appli i Diagram

Application-My Application-ArchiMate Diagram

c Y 0 - 100% ~ = i select Al
My
Application
¥ ® 4 N
& N
o~
A

o @
Q0 B
0
]

4
=
E]

w The created ArchiMate component is connected to the ArchiMate
Model, see Management of the ArchiMate model in an Enterprise
Architecture solution.

w The created ArchiMate diagram is connected to the ArchiMate View,
see Managing of the ArchiMate views in an Enterprise Architecture
solution.

Creating an Object in the ArchiMate diagram of an EA Building Block

To create an Application component, for example:
1. In the diagram insert toolbar, click the Application component button.
2. Click in the diagram.
The adding window opens.
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3. Enter the name of the new element.
A message confirms that no objects match this name within the current
ArchiMate model.

Adding Application Component X

lsearch for an object or name a new one ~

Suggested candidates (0 item)

Advanced search

4. Click Create.

The Application component appears in the diagram with the specified
name.

Adding an existing object in the ArchiMate diagram of an EA Building Block

To add an existing object to an ArchiMate diagram, you can drag and drop the object
from a hierarchical view or from the insert toolbar of the diagram.

To add an Application component, for example, using the insert toolbar of an
ArchiMate diagram:

1. In the diagram insert toolbar, click the Application component button.
2. Click in the diagram.
The adding window opens.
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3. In the object name box, click the down arrow.
The list of the model Application components is displayed.

Adding Application Component X

kearch for an object or name a new one v

Select All
Suggested candidates (0 item)

Other candidates (4 items)

& Benefits Tracker
& Customer Management
€] Internet Ordering

& Stock Management

Advanced search

4. Enter the name of the element you wish to create.
The application component appears in the diagram with the specified
name.

w  You can select several components. Each one will be added to the
diagram.

Creating a relationship in an ArchiMate Diagram
In an ArchiMate diagram a link corresponds to an ArchiMate® Relationship.

A Relationship can be created with the Link button of the diagram insert toolbar.
When you select the link button, a dialog box opens to display the available
relationship types.

w  For more information on ArchiMate® Relationship types, see
ArchiMate Relationships.
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ArchiMate element properties in an EA solution

The Characteristics properties of an ArchiMate element provide access to several
sections.
e The Identification section provides access to the following information:
e its Name
e its Owner, by default, the Model associated to the current diagram.
e The EA building block is the repository building block connected to
the ArchiMate element (optional, if synchronized).

w  For more details on links between the repository building blocks
and the ArchiMate elements, see Synchronizing an ArchiMate model
Elements.

e the text of its Description.
e The ArchiMate Views section provides the list of views describing the
object (optional).

The Diagram properties of an ArchiMate element provides access to the diagrams
containing the element and can be used to create a new one.

The Reporting properties of an ArchiMate element provides access to the ArchiMate
Element Graph representing the relationships between the current element and the
other model elements.

Home & Away Policy Administration

Characteristics Diagrams Reporting Activity Feed Workflows n

ArchiMate Element Graph v

Relationship Type v

olicy Data Managernent () e {I\’—"'-r
Hame&Away Do\lcyAdmmta at+of_\'\{\ ; %] Customer Data Ac
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Management of the ArchiMate model in an Enterprise Architecture
solution

The ArchiMate model is the ArchiMate elements root; a model provides access to the
folder describing views and elements.

w  For more details, see Using HOPEX for the ArchiMate Framework
Folders.

Accessing ArchiMate Models list in an Enterprise Architecture solution

To access the list of ArchiMate models:

) From the Environment navigation menu, select ArchiMate Models.
The list of models is displayed as an object tree.

The functionalities proposed from the navigation menu Environment > ArchiMate
Models are the functionalities proposed in the HOPEX product.

w  For more details on how to use HOPEX for the ArchiMate®

Framework solution, see Starting with HOPEX for the ArchiMate
Framework.

ArchiMate Models properties

The Characteristics properties of an ArchiMate model provides access to several
sections.

e The Identification section provides access to the following information:
e its Name
e the Owner. by default the current library (optional).

e the text of its Description.

e the Persons sections provides the list of persons (System) using this
model as their default one. See Defining the default ArchiMate Model for
a user.

e The EA Elements section providing the list of EA Elements owned by the
model. See Mapping an ArchiMate® Element to an EA Object.

e The Standalone Elements section providing the list of standalone
Element owned by the model. See Mapping an ArchiMate® Element to
an EA Object.

e The Views section providing the list of Views owned by the model. See
Managing of the ArchiMate views in an Enterprise Architecture solution.

e The Sub-Folders section providing the list of Sub-Folders owned by the

model. See Managing of the ArchiMate views in an Enterprise
Architecture solution.

Defining the default ArchiMate Model for a user

When an ArchiMate diagram is created from an EA building block, an ArchiMate
model is automatically created if no default ArchiMate model is defined for the user.

To assign a default ArchiMate model to a user:

1. From the Environment navigation menu, select ArchiMate Models.
The list of models appears.
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2. Open the Characteristics properties of the model that interests you and
expand the Persons section.
3. Connect the user to the model.

w [f a default model is already connected to a user, the current model
will replace the previous one.

Managing of the ArchiMate views in an Enterprise Architecture
solution

In accordance with ArchiMate® standards:
e A Viewpoint specifies the list of concepts (elements and relationships)
mandatory in a specific View type.
e A new View is created depending on a specific Viewpoint in an
ArchiMate® model context.
w  For more details on the types of the elements associated to a
Viewpoint, see The properties of a viewpoint.
When an ArchiMate diagram is created from an EA building block, the corresponding
view is automatically created from “Layered” viewpoint.

w To access the list of views associated the an EA Building block:
open the ArchiMate Views properties of the object.

Accessing ArchiMate Views list

To access the list of Views associated to an ArchiMate model:
1. From the Environment navigation menu, select ArchiMate Models.
2. Expand the folder of the model that interests you.
3. Expand the Views folder.
The list of Views appears.

ArchiMate Views properties

In the Characteristics properties of an ArchiMate View, the Identification
section provides access to the following information:

its Name

its Owner, by default the ArchiMate model associated to the View.
the text of its Description.

the Viewpoint,

its Status.

Synchronizing an ArchiMate Diagram Elements

ArchiMate® concepts are mapped with HOPEX EA building blocks enabling
compatibility and continuity with other models. Thus, an ArchiMate Business Process
can reference a Process which can be described in a BPMN diagram, so that the user
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can navigate from an overview ArchiMate diagram putting a process into its EA
context, to a more detailed BPMN description.

w  For more details on HOPEX for the ArchiMate® Framework
implementation, see The HOPEX MetaModel for ArchiMate.

The synchronization consists in mapping an ArchiMate element created in the
context of an ArchiMate diagram with an EA building block.

Two possibilities are provided to synchronize an ArchiMate element:
e In a unitary manner by opening the Characteristics properties of an
ArchiMate Element, see Synchronizing an ArchiMate model Elements.
e Generally using the Synchronize button of an ArchiMate diagram, see
Synchronizing Elements from an ArchiMate diagram using the
synchronization wizard.

Synchronizing an ArchiMate model Elements

w  For more details on ArchiMate® elements mapping with HOPEX
MetaClasses, see Concepts mapping.

The HOPEX for the ArchiMate® Framework solution provides two types of
element:
e The ArchiMate® EA Elements which can be associated to a repository
object.

w  For more details, see Mapping an ArchiMate® Element to an EA
Object.

e The Flow type Relationships whose sender and receiver are
synchronized with the ITPM “flows” between applications.

w  For more details, see ArchiMate Relationships.

Mapping an ArchiMate® EA Element to an HOPEX object in
properties

w  For more details on HOPEX for the ArchiMate® Framework EA
Elements, see Mapping an ArchiMate® Element to an EA Object.

To synchronize an Application component, for example:
1. Open the Characteristic property page the Application Component you
are interested in.
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2. In the Identification section, from the EA building block field, click
the right arrow and click the Connect button.

m The name of the field depends on the type of the selected
ArchiMate Element.

A connection window opens.

Connecting... .

Information: Connecting a(n) 'Model Building Block' to the 'Application Component'
'Customer Management' using the Link 'Referenced EA Block'

Medel Building Block]

Model Building Block
L Name v
‘ Application

o IT Service

% Microservice

3. Select the type of EA building bock you want to connect to the
Application component.

4. Select the repository instance you want to connect to the Application
component.

Synchronizing Elements from an ArchiMate diagram using the
synchronization wizard

From an ArchiMate diagram, you can synchronize all the elements of the diagram
which have a possible mapping to HOPEX objects, or create new corresponding
HOPEX objects of the relevant type.

This enables to reference existing Building Blocks in HOPEX inventories used by
other solutions (e.g., Processes from HOPEX Business Process Analysis or
Applications form HOPEX IT Business Management).

To synchronize a Device, for example:
1. Open the diagram in edit mode.
2. Click the Synchronize button.
A window opens and shows a table of all the elements of the diagram
which can be synchronized. The Building Block column allows the
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synchronization of the diagram elements of the ArchiMate EA elements
type.

ArchiMate Synchronization - ArchiMate to EA Elements

‘lements to synchronize

Name Building Block Create new building block Type
= Benefits Tracker Benefits Tracker 5 Application
= Customer Customer B org-unit
= Customer Management Customer Management B 1T Service
= Internet Ordering Internet Ordering 5 Application
= Stock Management Stock Management B Application

3. Click the Building Block box of the element that interests you.

w [n a case of a "multiple” mapping, you may choose the type of the
associated repository object. For more details, see Mapping an
ArchiMate® EA Element to an HOPEX object in properties.

e If the item is already mapped or synchronized, "Mapping already
exists" or "Element synchronized" message appears in the
Synchronization status cell.

e If no item of the default type with the element name is found, then
"No match" is displayed in the Synchronization status cell.

e If one item of the default type with the element name is found, then
then "one match" is displayed in the Synchronization status cell.

e If many items are found, click on the Building Block cell to select the
appropriate one (the context is given by the owner / long name).

e When you want to create a new building block of a different type than
the default one, check the Create new building block box and select
the desired type in the Type cell.

Click Next.

The list of Flow type Relationships with synchronized sender and

receiver is displayed.

6. An EA flow is created between the repository EA objects if the box in the

ArchiMate Relationships Synchronization column is checked.

7. Click OK.

Once ArchiMate® EA Elements are mapped to HOPEX Building Blocks, the
navigation to these objects is possible via the ArchiMate® EA Elements
properties.

ok

Reaching these objects describing diagrams can be achieved:
e through the Diagrams properties of the referenced objects,
e Using Diagrams containing objects feature from:
e the ArchiMate® EA Element Diagrams properties
e using the object pie menu in a diagram preview.
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ABOUT THIS GUIDE

This guide explains how to make best use of HOPEX IT Business Management
to ensure efficient management of your Business Architecture projects.

Guide Structure

The guide HOPEX IT Business Management is divided into two parts consisting
of the following chapters:

e concerning the strategy part

Business Capability Maps and Value Streams; explains how HOPEX IT
Business Management helps you in analyzing the business
capabilities of your enterprise to check their suitability with your
business functions and your skills.

Identifying Strategic Transformation Elements; describes how the list
of drivers specified to assess them in order to refine the list of
transformation strategic goals of the enterprise.

Drawing the Transformation Roadmap; explains how to identify and
plan the transformation stages necessary to acquire the business
capabilities used to reach the enterprise goals.

e Concerning the portfolio management

Drawing up an Application Inventory: presents functionalities
proposed by HOPEX IT Portfolio Management to identify and
characterize application assets.

Evaluating Application Assets: introduces the portfolio concept
available in HOPEX IT Portfolio Management and explains how to
evaluate applications during the inventory phase. This chapter also
describes the project concept on which the transformation phase of
the application assets relies.
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Additional Resources

This guide is supplemented by:
e the HOPEX Common Features guide describes the Web interface and
tools specific to HOPEX solutions.

w ]t can be useful to consult this guide for a general presentation of
the interface.

e The HOPEX Business Process Analysis guide, which describes the
functionalities proposed to manage processes;

e The HOPEX IT Architecture guide, which describes the functionalities
proposed IT systems;

e The HOPEX Project Portfolio Management guide describes the
functionalities proposed to manage your portfolio projects;

e The HOPEX Digital Transformation Desktop guide, which describes
how to use the Enterprise Architecture HOPEX solutions in a dedicated
working environment;

e The HOPEX Assessment guide, which describes functions proposed by
HOPEX to use and customize assessment;

e the HOPEX Power Supervisor administration guide.

Conventions used in the guide

w Remark on the preceding points.
Definition of terms used.

© a tip that may simplify things.

JR’ Compatibility with previous versions.
é& Things you must not do.

A

‘ I Very important remark to avoid errors during an operation.

Commands are presented as seen here: File > Open.

Names of products and technical modules are presented in bold as seen here:
HOPEX.
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HOPEX IT Business Management



INTRODUCTION TO STRATEGIC
TRANSFORMATION

HOPEX IT Business Management provides the tools to transform IT architecture, based on the
analysis of business capabilities.

Business Architecture helps managers define the operating architecture to remain in compliance
with their Business Model and adapt to changes in their economic and regulatory environment.
HOPEX IT Business Management is thus a key tool for enterprise transformation.

The method offered by HOPEX IT Business Management is used to take into account the
enterprise strategy: from driver analysis to the definition of objectives and action resources.
HOPEX IT Business Management also constitutes an analysis solution for enterprise business
capabilities to ensure the services it plans to provide.

Last but not least, HOPEX IT Business Management is combined with other HOPEX solutions
dedicated to the enterprise architecture used to define organizational, application or infrastructure
building blocks.

The following points are covered here:

v/ The HOPEX IT Business Management Method
v Before starting with the strategic transformation
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THE HOPEX IT BUSINESS MANAGEMENT METHOD

The method described in this guide is represented in the steps below.

Identifying Strategic Transformation Elements: this step consists in defining
the enterprise transformation goals and identifying the associated means
(Strategies and tactics) to be implemented. The means are specified in the
enterprise transformation stages.

w  For more details about exhibited business capabilities, see
Identifying Exhibited Business Capabilities.

Value Streams and Business Capabilities description: this step consists in
drawing up the elements that provide value to the enterprise (using value streams)
and how the enterprise can deliver those elements (using business capabilities). For
a business capability, you can identify the associated functionalities and the
components that implement them.

w  For more details on this step, see Describing the Enterprise
Capability for Creating Value.

Each transformation stage highlights Exhibited Business Capabilities.

An exhibited business capability is exhibited by an Enterprise Stage
with quantified measure (KPI) and potential geopolitical scope (Site) for

a defined market segment (Business Partner).
For an exhibited business capability, you can identify the measurable properties of
interest for the capability which are used to assess business value and performance
(e.g.: for a delivery capability, we are interested in the "delivery time" expressed in
minutes). The components that implement the exhibited capability are thus
identified and are concerned by the transformation.

w  For more details about exhibited business capabilities, see

Identifying Exhibited Business Capabilities.
Defining the enterprise architectures: this work, performed during the
transformation stages, can be done using HOPEX IT Business Management with
other Enterprise Architecture solutions. This consists of identifying and describing
the solution building blocks that contribute to the exhibited business capabilities
implementation. The additional solutions of the HOPEX platform are used to
describe in more detail your models (organizational, application and technological
solution building blocks).

w  For more details on solution architectures, see Describing the

Enterprise Architecture.
Consulting the transformation roadmap: reports are provided to help you to
analyze and reviewing the transformation stages of your enterprise.

w  For more details on the road map, see Consulting the
Transformation Roadmap.
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Defining the Transformation Strategy

After having described the current state and analyzing the suitability between the
business capabilities of the enterprise and value architecture elements, this step
consists in drawing up the list of needs for change (or driver) identified at the
various levels by the stakeholders (or interested parties), and assessing them in
order to establish the list of enterprise goals.

A goal tends to be longer term, and defined qualitatively rather
than quantitatively. It should be narrow-focused enough that goals can
be defined for it.

Defining the enterprise and its evolution in time

An enterprise is described by the following elements:
e a business capability map,
e value streams,
e goals and strategies of the transformation,
e Transformation stages which define the concrete implementation of the
transformation.

A Business Transformation Stage is a kind of Enterprise

Transformation Stage aiming at the alignment of the enterprise
business operating model to its business strategy and corresponding
exhibited business capabilities (business model).

w For more details, see Creating an Enterprise.

Identifying transformation strategic elements

This step consists of identifying the strategic elements that meets the
transformation drivers.
w For more details, see Defining Enterprise Strategic Elements.
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An enterprise diagram is used to describe the links between the strategic elements
(goals, strategies, tactics and transformation stages).

#. Purchasing Enterprise

% Starting Transformation Stage(Courant)

~
@ Objective
@ Goal §
New Internet Site
Internet major sales channel ~ T
-
it Tactic
@ Goal
. In-house web site for sale
24/7 web site without service interruption \_

## Swrategy

it Tactic
Internalize Web site
Hire sports specialists as sales suppart

% Final Transformation Stage(Futur)

~
@ Objective
@ Goal
24/7 purchasing
Broaden Customer Base -
@ Objective
@ Goal
. All countries Purchasing
Increase revenue an emerging market -
#E Strategy i Tactic
. ™\
Develop customer fidelity # Strategy Open Asian Office

Turnover on emerging high potential.
peaple

# Strategy ) it Tactic
Focus on High end Travels Local partnerships with operators
.

Vision : Untiliser les nouvelles technologies pour accéder 4 de nouveaux marchés

Mission - Déployer un site intemet pour atteindre une nouvelle clientéle

w  For more information on this diagram, see Building an Enterprise
Diagram.

Describing the Enterprise Capability for Creating Value

Describing the Architecture of Business Capabilities

Building the business capability map

A business capability map describes what the enterprise is capable of producing for
its internal needs or for meeting the needs of its clients.

A business capability map is a set of business capabilities with their
dependencies that, together, define a framework for an enterprise
stage.

.A business capability is a set of features that can be made
available by a system (an enterprise or an automated system).



The business capability map thus presents the business capabilities of the highest
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level for one of the transformation stages.

iqn-s(:apahiiqlhp ]

Information Technology I Manage Operations ™
Manage Cusiomer car Renti

fanage Custorr
Zge customer n survey after retumn
vMianage Customer Tr ervation

= _ 2 -
“ - “ f —
Reserves | ( Customer | Billing
Management Management

w  For more details on business capability map diagrams, see Creating
a business capability map diagram.

Describing the business capability breakdown

Business capabilities are then described more precisely to identify:

a more detailed granularity capability breakdown;

the expected effects of the capability;

the business skills or functionalities required for each of them;

the dependencies between capabilities (expected effect of one dependent
from the result of the other).

For example, the business capability that consists of
managing operations is broken down into a number of business
capabilities: “Handle customer complaints”, “Manage
reservations”.

( Manage Customer | { Manage customer |
Claims satisfaction
survey after return

( Manage Customer | { Manage Customer |

Travel Reservation car Rental
Reservation

& Contract agreement
@ Received Product or Service
& Travel Order

0 Display the Catalog Content
0 Get customer information
10 Get stock information
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Defining the business skills and functionalities associated with

business capabilities

To be able to then check that each business capability is correctly implemented by
suitable solution building block, you must define the required business skills and

functionalities.

A technology capability is the ability to deliver a technology service
which is required by a technology artifact or an application.

w  For more details on skills and the business capability functionalities,
see Defining the business skills and functionalities associated with

business capabilities.

Describing value streams
A value stream is represented by a sequencing of value creation steps managed by

the business functions of the architecture.

A value stream is an end-to-end collection of Value Stages that
creates an outcome for a customer, who may be the ultimate customer
or an internal end-user of the value stream.

A value stage is a distinct, identifiable phase or step within a value
stream that has a unique entrance criteria, exit criteria, and identifiable
participating business function or business functional area.

The following diagram presents an example of a value stream:

ENTTTENET

Procuct or Sarvice Avilsle
.mé

w  For more details on value streams, see Describing value streams.
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Describing business capability implementation by the business functions

This involves connecting the business capability, which corresponds to what we
know how to do or what we want to do and which represents the goal to be
achieved, to a way of achieving what is represented by a business function or a
business functional area at a conceptual level, that is, upstream of organizational
and technical choices.

A Business functional area is a set of business functions and their
associated value streams on the conjunction of two main criteria: their
need in accomplishing one or more business capabilities and the
common skills and functionalities required to accomplish these business
capabilities.
This business functional area will itself carry the value processes whose steps will
require its business function components.

Construction of the business capability map on the one hand and the business
architecture environment on the other hand is used to check that the business
capabilities are implemented by the business functions.
w  For more details on the businesses associated with business
capabilities, see Creating Fulfillment of a Business Capability.
HOPEX IT Business Management provides a report that presents the result of
the implementation of business capabilities by business functions.

w  For more details on the breakdown of business capabilities, see
Creating Fulfillment of a Business Capability.

Identifying Exhibited Business Capabilities

An exhibited business capability is exhibited by an Enterprise Stage
with quantified measure (KPI) and potential geopolitical scope (Site) for

a defined market segment (Business Partner).
From a transformation stage, it is possible to create exhibited business capabilities
that can connect the transformation strategic elements to the technical or
organizational elements that assure their implementation.
w  For more details on exhibited business capabilities creation, see
Managing Exhibited Business Capabilities.
The exhibited business capabilities are assessed with respect to different criteria or
measurable properties.

For example, the competitiveness of a delivery capability
is measured according to the ‘delivery time at target
cost’ measurable property.

These measurable properties give rise, for a given transformation stage, to key
performance indicators.

For example, a delivery capability can have a target of
'delivery time in less than 48 hours for a cost price less
than 10% of the sales price' within the framework of a given
transformation stage.

A set of constraint values defines the grouping of elementary

Qualifying values that should be examined together in order to
appreciate the actual performance of a KPIed item. E.g.: a delivery
must take place in less than 20 minutes and cost less than 5 euros.

w  For more details, see Using performance indicators.
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Describing the Enterprise Architecture

Business capabilities are implemented by components of the enterprise
architecture. Technical and functional architectures may be described using
different formalisms:

e by a business function architecture environment, which contains the
elements that define the enterprise model (operating model) for the
current stage.

e the definition of the ecosystem of the enterprise (interactions with
partners),

e the business function architectures,

e the business functions.

e By the solution building block environments that depend on product
licenses used, for example, with HOPEX IT Architecture: the
environment for Logical Application Systems, the environment for
Application Systems, the environment for Resource Architectures, etc.

m  For more details, see Describing an Enterprise Architecture.

Describing the business architecture environment

A business architecture environment represents the relationships of

a business functional area with its partners.
In this example, the business function architecture
environment of company is made up of the historical business
function architecture and its interactions with external
partners: clients and suppliers. You can see in the diagram
that delivery is outsourced to a third party deliver
partner.

An application deployment architecture describes one possible
deployment configuration of an application. It contains the deployment
architectures to be hosted, recommends hosting architectures and
identifies required communication techniques (communication protocols
and port numbers) they use to communicate with each other. . An
application may have several deployment architectures (E.g.:
autonomous installation, horizontal or vertical deployment, etc.)

A business partner designates a third-party who is in relation with
the enterprise within the framework of a given business architecture
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environment. Examples: private sector client, regulatory organization,
supplier.

Pizza Consumer

Standard Pizza Pizza Delivery Partner
Business Architecture

[30-40]

Supplier of Pizza
Ingrediznt

2]
Communications between the objects are represented by interactions service.

A Service Interaction represents an interaction for service purpose
between entities in a specific context inside or outside a company.
These entities can be enterprise org-units, applications, activities or
processes, as well as external org-units. The content of this interaction
is described in a service interface.

Describing a business functional area

An application deployment architecture describes one possible
deployment configuration of an application. It contains the deployment
architectures to be hosted, recommends hosting architectures and
identifies required communication techniques (communication protocols
and port numbers) they use to communicate with each other. . An
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Pizza Delivery
2]

application may have several deployment architectures (E.g.:
autonomous installation, horizontal or vertical deployment, etc.)

In this example, the history functional area is based on the
business functional areas for selling, delivering and

command.

Sales & Delivery

Pizza External Delivery

Administration

Pizza preparation Procurement

Pizza Ingredient Purchasing

Defining the business skills and functionalities associated with
business functions

To be able to subsequently check that each business capability is implemented by a
suitable business function, you must define the required business skills and
functionalities, for each business function.
A technology capability is the ability to deliver a technology service
which is required by a technology artifact or an application.

w  For more details on skills and the business capability functionalities,
see Defining the business skills and functionalities associated with
business capabilities.
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Consulting the Transformation Roadmap

The transformation roadmap is presented in the form of a report that can be
accessed from the Enterprise property page.

w For more details on transformation plans, see Drawing the
Transformation Roadmap.

Purchasing Enterprise x

vy Reporting

Project Impact on Transformation Roadmap v
Parameters ~

Project Portfolios

>
Hide Business Capability
Refresh the report
oo
[

1. Transformation Goals and Objectives

RIS

24/7 web site without service interruption

Starting Transformation Stage MNew Internet Site
Internet major sales channel
24/7 purchasing Broaden Customer Base
Final Transformation Stage Increase revenue on emerging market

All countries Purchasing
Broaden Customer Base

2. Planning and Impact of Transformation Project Deliverables
@), ) Scale step: year

2019 2020 2021 2022 2023 2024

D Starting Transformation Stage Starting Tr
[} Final Transformation Stage

59



60

BEFORE STARTING WITH THE STRATEGIC TRANSFORMATION

Defining a work context

w  For more details on managing your work context, see the
"Er_zéerprises and Libraries" chapter in the HOPEX Common Features
guide.

A library and an enterprise are used to represent a unique work context.

In the context of the HOPEX IT Business Management solution, a library can
hold all the elements of your project: processes and org-units, for example.

Libraries are collections of objects used to split repository content
into several independent parts. They allow creation of virtual partitions

of the repository. In particular, two objects owned by different libraries
can have the same name.

An Enterprise is used to represent the work context of a transformation project.

An Enterprise is a purposeful undertaking, conducted by one or
more organizations, aiming at delivering goods and services, in
accordance with the enterprise mission in its changing environment.
During its development over time, an enterprise has to adapt to its
environment and sets up transformation goals and objectives along with
course of action to achieve these objectives. The design and realization
of the resulting transformation stages may transcend organizational
boundaries and consequently require an integrated team working under
the direction of a governing body to involve stakeholders in
transformation initiatives. This requires the implementation of an
integrated team, under the responsibility of a governing body, to
involve the stakeholders in the transformation.

Accessing the list of libraries with HOPEX IT Business Management

To access the list of libraries from the Environment navigation menu:

)} Select Containers > Libraries.
The library tree appears.

L

w For more details on libraries, see “Using libraries” chapter in the
HOPEX Common Features guide .

Using Properties Pages

HOPEX IT Business Management provides properties pages available for several
solutions.

w  Using the facilities described in the HOPEX Power Studio guide,
you can customizing the properties pages of your solution.
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The pages below are common to main HOPEX IT Business Management objects.
e the Measurable Property is used to access to:
e the Measurable Property section which provides the list of
measurable properties associated to the described object.
e the Set of Constraining Properties section which provides the list of
Sets of constraining properties associated to the described object.
w  For more details, see Using performance indicators.
e The Implementation page provides access to the list of Enterprise
Architecture solution building blocks that implement the described
object.

w  For more details on implementation of business capabilities, see
Describing Component Fulfillment.

e The Reporting page provides access to the reports available for the
described object.

Importing an Existing Breakdown of Business Capabilities

HOPEX IT Business Management uses Excel data exchange wizards to export
and import a breakdown of business capabilities. The Excel template used is
Business Capabilities Template.xlsx.

w  For more details on Excel data exchange wizards, see the

“"Exchanging Data with Excel” chapter in the HOPEX Common
Features guide.

w  For more information on managing you work context, see Data
Exchange with Excel.
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Structure of the import/export Excel template of HOPEX IT Business
Management

The Business Capabilities Template.xlsx Excel template of HOPEX IT Business
Management allows you to import a breakdown of business capacities and a
breakdown of functionalities.
e At the level of business capabilities, the elements are as follows:
e Business Capabilities

.A business capability is a set of features that can be made
available by a system (an enterprise or an automated system).

e Business capability maps

A business capability map is a set of business capabilities with their

dependencies that, together, define a framework for an enterprise
stage.

e Business capability components, which define the link between a
business capability and the business capability map (or business
capability) in which it is referenced.

e Business Capability fulfillments, which define the link between a
business capability and the application that implements it.

e At the level of functionalities, the elements are as follows:

e Functionalities

A technology capability is the ability to deliver a technology service
which is required by a technology artifact or an application.

e fFunctionality maps

A technology capability map is a set of technology capabilities and
their dependencies that, together, defines the scope of a hardware or
software architecture.

e Sub-functionalities, which define the link between a functionality and
the functionality map (or the functionality) in which it is referenced.
e Functionality fulfillments, which define the link between a functionality
and the application that implements it.
e Applications, which here represent the supports for implementing
business capabilities or functionalities.

An application is a software component that can be deployed and
provides users with a set of functionalities.
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The information contained in the Excel template delivered with HOPEX IT
Business Management is presented as follows:
e One page per element type: Business capability, Business capability
map, Functionality, Functionality map, Application, ...
e For each element of Business capability, Business capability map,

Functionality, Functionality map or Application type:

e Short Name : name of the object concerned.

e For each element of Business capability component (or Sub-
functionality) type:

e Business Capability Building Block (or Owner Functionality
Building Block): name of the composite object (business capability
map, for example).

e Business Capability Used (or Sub-functionality): component
object name.

e For each element of Business Capability fulfillment (or Functionality
fulfillment) type:

¢ Fulfilled Business Capability (or Fulfilled Functionality): name of
the implemented business capability (or functionality).

e Realizer Agent (or Fulfilling Enterprise Artifact): name of the
application that implements the capability or the functionality.

e Short Name : name of the object associated with the
implementation.

Importing the breakdown of business capabilities into an enterprise

Several steps must be followed in order for the Excel import of a business capability
breakdown to be performed correctly:

1. Advanced Options and Settings of Excel Wizards,

2. Specifying the current library,

3. Exporting data from your repository with HOPEX IT Business

Management,
4. Completing the import file for HOPEX IT Business Management,
5. Import your new file into your repository.

w For more details on Excel data exchange wizards, see the
“"Exchanging Data with Excel” chapter in the HOPEX Common
Features guide.

L

Specifying the current library

A library and an enterprise are used to represent a unique work context.

Libraries are collections of objects used to split repository content
into several independent parts. They allow creation of virtual partitions
of the repository. In particular, two objects owned by different libraries
can have the same name.

In order for the data you import with Excel to be linked to a specific /ibrary, you must
specify the current library.

To set the current library:
1. Click the Environment navigation menu then Containers > Libraries.
2. Expand the Libraries tree.
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3. Right-click the library that interests you to open its pop-up menu and
select Set As Default.
The selected library becomes the current library.

Exporting data from your repository with HOPEX IT Business
Management

If you want to export business capability maps or functionality maps that exist in
another repository than your current one, for example, you can use the Excel
template of HOPEX IT Business Management .

w For more details on Excel data exchange wizards, see the

“"Exchanging Data with Excel” chapter in the HOPEX Common
Features guide.

~
When the Excel file is filled with the names of the objects you want to import, you

must complete the necessary information for import into HOPEX IT Business
Management .

w  For more details on additional information, see Completing the
import file for HOPEX IT Business Management.
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Completing the import file for HOPEX IT Business Management

For your import file to be correct, you must have specified the following elements:

For each element of Business capability, Business capability map,

Functionality, Functionality map or Application type, you must enter the

name of each object:

For each breakdown (Business Capability Composition or

Functionality Composition Excel sheet), you must indicate:

e the name of the composite object in the Business Capability
Building Block (or Owner Functionality Building Block) column.

Name of a business capability map for example.

e the name of the composing object in the Business Capability Used
(or Sub-functionality) column.
Name of a business capability for example.

To specify that an application implements a business capability, for

example, you must indicate in the Business Capability

Fulfillment sheet:

e the name of the business capability implemented in the Fulfilled
Business Capability column.

e the name of the application concerned in the Realizer Agent column.

e the name you want to give to the object that represents the
implementation in the Short Name column.

To specify that a functionality is associated with a business capability,

you must indicate in the Expected Functionality Excel sheet:

e the name of the business capability in the Business Capability
column,

e the name of the functionality concerned in the Functionality column.

& The first two lines of each Excel worksheet are reserved for
file configuration; ensure that the first two lines of the imported
file remain identical to those obtained after an export.

w For more information on the structure of the Excel template, see
Structure of the import/export Excel template of HOPEX IT Business
Management.
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IDENTIFYING STRATEGIC TRANSFORMATION
ELEMENTS

This stage consists of drawing up a list of strategic elements for the enterprise's transformation.

You can access all the strategic elements of your enterprise and its transformation stages from the

Business > Strategic Planning navigation menu. The enterprise and its transformation stages
appear in the form of a tree.

The following points are covered here:

v Enterprise Strategic Elements,
v The strategic Elements of a Transformation Phase,
v Using performance indicators.
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ENTERPRISE STRATEGIC ELEMENTS

An Enterprise is a purposeful undertaking, conducted by one or
more organizations, aiming at delivering goods and services, in
accordance with the enterprise mission in its changing environment.
During its development over time, an enterprise has to adapt to its
environment and sets up transformation goals and objectives along with
course of action to achieve these objectives. The design and realization
of the resulting transformation stages may transcend organizational
boundaries and consequently require an integrated team working under
the direction of a governing body to involve stakeholders in
transformation initiatives. This requires the implementation of an
integrated team, under the responsibility of a governing body, to
involve the stakeholders in the transformation.

The strategic elements of an enterprise can be accessed from:
e Its properties pages, see Defining Enterprise Strategic Elements,
e Its enterprise diagram, see Creating an Enterprise Diagram,
e C(Click the Business > Strategic Planning navigation menu.

Creating an Enterprise

~

w  For more details Enterprises, see "Enterprises and Libraries”
chapter in the HOPEX Common Features guide .

Accessing the list of enterprises with HOPEX IT Business Management

To access the list of Enterprises:

) Click the Business navigation menu then Strategic Planning.
The enterprise tree appears.

Creating an enterprise with HOPEX IT Business Management

To create an enterprise from the Business navigation menu:
1. Click Strategic Planning.
The enterprise tree appears.

2. Click the New button.
The new enterprise is added to the list of Enterprises.
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Enterprise Characteristics

The Characteristics properties page of an enterprise provides access to:
e its Name,
e its Owner, by default the current library.
e The Strategic Theme table enables to define the enterprise strategic
themes.
A strategic theme is used to classify the enterprise goals.

Connecting the capability map to an enterprise

The business capabilities valid for the given enterprise are contained in a business

capability map.
A business capability map is a set of business capabilities with their
dependencies that, together, define a framework for an enterprise
stage.

The business capability map is used to identify the exhibited business capabilities

that meet the enterprise goals for the transformation.
w  For more details on the business capability maps management, see
Building the Business Capability Map.

To connect a business capability map to an enterprise:

1. Select Characteristics property page of the enterprise that interests

you.
2. In the Capability Architecture section, click the right arrow of the

Business Capability Map field and select Connect....
A selection window opens.
3. Select the business capability that interests you and click Connect.
The business capability map is associated to the enterprise and its

transformation stages.

Connecting the value stream to an enterprise

A value stream is an end-to-end collection of Value Stages that
creates an outcome for a customer, who may be the ultimate customer
or an internal end-user of the value stream.

w  For more details on the list of business capabilities, see Describing
value streams.

The value creation steps are connected to Business Capabilities valid for the

enterprise.
A value stage is a distinct, identifiable phase or step within a value
stream that has a unique entrance criteria, exit criteria, and identifiable
participating business function or business functional area.

To connect a value stream to an enterprise:

1. Select Characteristics property page of the enterprise that interests

you.
2. In the Value Stream section, click Connect.

A selection window opens.
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3. Select the Value streams that interests you and click Connect.
The value streams are connected to all the enterprise transformation
stages.

Defining Enterprise Strategic Elements

Strategic elements of an enterprise are classified in the following categories:
e Ends, see: Identifying enterprise ends,
e Means, see: Defining Means.
e The transformation stages, see Defining Transformation Stages.

Identifying enterprise ends

Describing the Enterprise Vision

A vision is the ultimate, possibly unattainable, state the enterprise
would like to achieve. A vision is often compound, rather than focused
toward one particular aspect of the business problem. A vision is
supported or made operative by missions. It is amplified by goals.

To describe an enterprise vision:

1. Open the Strategy properties page of an enterprise.
2. In the End section, select the Vision field.

Identifying enterprise goals

The enterprise goals are determining elements in your enterprise model since they
interconnect the ends of the enterprise transformation with the objectives of the
transformation stages.
A goal tends to be longer term, and defined qualitatively rather
than quantitatively. It should be narrow-focused enough that goals can
be defined for it.
To create an enterprise goal:
1. In the Strategy property page of an enterprise, open End section.
2. In the Goals section, click New.
The Creation of an Enterprise Goal dialog box opens.
3. Specify the goal name and click OK.
The goal appears in the list.

The Characteristics page of the property pages of an enterprise goal is used to
access:

its Name,

its Owner, by default the current enterprise.

the Comment text.

the Strategic Theme Category section, which specifies the Strategic
Themes connected to the enterprise goal.
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Defining Means

To ensure that the strategies and tactics implemented in the enterprise correspond
to the enterprise goals, you can use HOPEX IT Business Management to align
the objects representing the ends of the strategy with the means to be
implemented.

A strategy is a component of a mission. It represents a means of
action essential to achievement of ends of the enterprise, and more
practically its goals. A strategy channels enterprise efforts towards
these goals. A strategy is the approach considered by the enterprise as
being the best suited to achieving its goals, taking account of
constraints imposed by the environment and by risks.

To check the consistency of the transformation plan, chaque strategy is connected

to an enterprise goal.

Describing a Mission

LY The mission describes what the business is or will be doing on a
day-to-day basis. A mission makes a vision operative; that is, it
indicates the ongoing activity that makes the vision a reality. A mission
is planned using strategies.

To describe an enterprise Mission :

1. Open the Strategy property page of the enterprise.
2. In the Means section, select the Mission field.

Defining Strategies

A strategy is a component of a mission. It represents a means of
action essential to achievement of ends of the enterprise, and more
practically its goals. A strategy channels enterprise efforts towards
these goals. A strategy is the approach considered by the enterprise as
being the best suited to achieving its goals, taking account of
constraints imposed by the environment and by risks.
To create a strategy:
1. Open the Strategy properties page of an enterprise.
2. In the Mean section and the Strategy Sub-section.
3. Click New.
The Creation of a strategy dialog box opens.
4. Specify the strategy and click the OK button.
The new strategy appears in the list.

The Characteristics properties page of the strategy provides access to:

e jts Name,

e Its Enterprise,

e the Comment text.

e the list of Supported Goals.
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Building an Enterprise Diagram

An enterprise diagram is used to describe the links between goals, strategies, tactics
and transformation stages.

# [Purchasing Enterprise

4% Starting Transformation Stage{Courant) -~

@ Objective ]
@ Goal

Mew Internet Site
Internet major sales channel ~ T

-~

& Goal It Tactic

In-house web site for sale

24/7 web site without service interruption

## Strategy
I Tactic
Internalize Web site
Hire sports specialists as sales support

% Final Transformation Stage{Futur) -
@ Objective ]

@ Goal
24/7 purchasing

Broaden Customer Base

@ Objective
@ Goal
. All countries Purchasing
Increase revenue on emerging market .

£ Strategy IE Tactic
Develop customer fidelity 4 Strategy h Open Asian Office
Turnover on emerging high potential. -
3 Strategy people ) ik Tactic

Focus on High end Travels Local partnerships with operators

L.

Vision : Utiliser les nouvelles technologies pour accéder a de nouveaux marchés

Mission : Déployer un site intemet pour atteindre une nouvelle clientéle

Creating an Enterprise Diagram

To create an Enterprise Diagram:
1. Select the enterprise concerned and click New > Diagram.

2. Select Enterprise Diagram.
The diagram opens in the edit area. The frame of the described enterprise

appears in the diagram.

Describing the strategic elements

The components represented in an enterprise diagram are the strategic elements
connected to the enterprise and to its Transformation stages.

A Business Transformation Stage is a kind of Enterprise
Transformation Stage aiming at the alignment of the enterprise



Identifying Strategic Transformation Elements
Enterprise Strategic Elements .

business operating model to its business strategy and corresponding
exhibited business capabilities (business model).

w  For more details, see The strategic Elements of a Transformation
Phase.

The components represented in an enterprise diagram are :

e The enterprise ends, described by the enterprise goals and the
enterprise objectives (that are described at the transformation stages)).

A goal tends to be longer term, and defined qualitatively rather
than quantitatively. It should be narrow-focused enough that goals can
be defined for it.

An Enterprise Objective is a quantifiable end that a company/

organization wants to achieve for a given Enterprise Stage. An
Enterprise Objective may support an Enterprise Goal; it may be refined
into sub-objectives. An Enterprise Objective may concern a defined
Exhibited Capability and be addressed by a defined Tactic.

e The enterprise means that are described by strategies at the enterprise
level and by tactics at the transformation stage level.

A strategy is a component of a mission. It represents a means of
action essential to achievement of ends of the enterprise, and more
practically its goals. A strategy channels enterprise efforts towards
these goals. A strategy is the approach considered by the enterprise as
being the best suited to achieving its goals, taking account of
constraints imposed by the environment and by risks.

A tactic is a course of action that implements part of a strategy.
Tactics generally channel efforts towards objectives.
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The implementation of an enterprise is described by the enterprise stages that
correspond to its state at a given time.

An Enterprise is a purposeful undertaking, conducted by one or

more organizations, aiming at delivering goods and services, in
accordance with the enterprise mission in its changing environment.
During its development over time, an enterprise has to adapt to its
environment and sets up transformation goals and objectives along with
course of action to achieve these objectives. The design and realization
of the resulting transformation stages may transcend organizational
boundaries and consequently require an integrated team working under
the direction of a governing body to involve stakeholders in
transformation initiatives. This requires the implementation of an
integrated team, under the responsibility of a governing body, to
involve the stakeholders in the transformation.

A Business Transformation Stage is a kind of Enterprise
Transformation Stage aiming at the alignment of the enterprise
business operating model to its business strategy and corresponding
exhibited business capabilities (business model).
Thus, when an enterprise is created, the following two enterprise stages can also
been created:

e The current ('As-Is') stage that concerns existing elements;

e The target 'To-Be' phase that contains the target elements determined
by the review of the transformation strategic goals.

The business capability map is associated to the enterprise and its transformation
stages.
A business capability map is a set of business capabilities with their

dependencies that, together, define a framework for an enterprise
stage.

The strategic elements of a transformation phase Users that follow:
e The enterprise objectives and the corresponding tactics, see
Transformation stage characteristics,
e the business Capability assessments, see Using performance indicators,
e the exhibited business capabilities, see: Managing Exhibited Business
Capabilities.

Defining Transformation Stages

From an enterprise, you can create transformation stages.

Each transformation stage is scheduled in the enterprise project depending on real
or estimated dates. The scheduling is used to build the enterprise transformation
roadmap.
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Creating a Transformation Stage

To create a transformation stage from an enterprise:

1. Click the Business > Strategic Planning navigation menu.
The list of current Enterprises appears.

Open the Strategy properties page of the enterprise that interests you.
In the Stages section, click New.

An IT transformation stage creation dialog box opens.

Specify the Name of the transformation stage.

Specify the Period of the transformation stage: As Is, Future or Passed.
Specify the Begin Date and the End Date.

Click OK.

wn

No ok

Transformation stage properties
With HOPEX IT Business Management , a transformation stage is described by:
e the Characteristics page,

w  For more details on transformation stages, see Transformation
stage characteristics.

e the Assessment property page that provides access to the assessment
business capabilities of an enterprise stage.

w  For more details on assessing capability maps, see Using
performance indicators.

¢ the exhibited capabilities page that is used to access to the business
capabilities involved in the transformation stage.

w  For more details on strategic elements, see Managing Exhibited
Business Capabilities.

e The Architecture Description page that is used to access to the
architecture elements involved in the transformation stage.

w For more details on architecture elements, see Describing an
Enterprise Architecture.

Transformation stage characteristics

The Characteristics property page of an enterprise stage provides access to the
following information:

e Name,

e Owner the current enterprise,

e Period, As Is, Future or Passed. This attribute can be used if the dates
are not specified.
Begin Date of the phase,
End Date of the phase,
the Description text.
the objectives section, to define the transformation stage objectives as
well as associated tactics.

m  For more details on objectives and tactics, see Defining the
Strategic Characteristics of a Transformation Stage.
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Defining the Strategic Characteristics of a Transformation Stage

The enterprise strategic elements are aligned with strategic element of the
transformation stage: enterprise goals and objectives, strategies and tactics.

w  For more details on enterprise strategic elements, see Defining
Enterprise Strategic Elements.

Defining an enterprise objective

An Enterprise Objective is a quantifiable end that a company/

organization wants to achieve for a given Enterprise Stage. An
Enterprise Objective may support an Enterprise Goal; it may be refined
into sub-objectives. An Enterprise Objective may concern a defined
Exhibited Capability and be addressed by a defined Tactic.

Creating an Enterprise Objective

To create an Enterprise Objective:
1. Open the Characteristics properties page of a transformation stage.
2. In the Objectives section, click New.
The Creation of an enterprise objective dialog box opens.
3. Specify the objective name and click OK.
The new enterprise objective appears in the list.
4. In the Enterprise goals column of the table of enterprise objectives,
select the enterprise goals covered by the objective.
A goal tends to be longer term, and defined qualitatively rather

than quantitatively. It should be narrow-focused enough that goals can
be defined for it.

m  For more details on enterprise goals, see Identifying enterprise
ends

Enterprise Objective properties

The Characteristics property page of an enterprise objective is used to access:

e jts Name,

e jts Owner, by default the current transformation stage.
e the Comment text.

e the list of Enterprise goals the objective aims to satisfy.

Defining Tactics

A tactic is a course of action that implements part of a strategy.
Tactics generally channel efforts towards objectives.

Creating tactics

A tactic is a way to achieve an enterprise objective. So a tactic is created from an
enterprise objective.

To create a tactic:
1. Open the Characteristics properties page of a transformation stage.
2. In the Objectives section, select the objective that interests you.
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3. In the Contributing Tactic section, click New.
The new tactic appears in the list.

4. Specify the name of the tactic.
5. In the Strategy column of the tactic table of the transformation stage,
select the strategy corresponding to the tactic.

Tactic properties

The Characteristics property page of the tactic provides access to:

e its Owner, by default the current enterprise.
e its Name,

e the Comment text.

e the list of Supported enterprise objectives.

w  For more details, see Creating an Enterprise Objective.
e the list of Strategies that it implements.
w For more details, see Defining Strategies.
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USING PERFORMANCE INDICATORS

Qualifying Values and Measurable Properties are used to define the performance
constraints that must be complied with by the building blocks making up the
enterprise, at the forefront of which are the business capabilities and the exhibited
business capabilities in a transformation stage.

The nature of a Qualifying Value is defined by a Measurable Property.

A measurable property expresses the nature of indicators
(duration, mass, cost, etc.) and defines the unit used to measure them
(minutes, kilograms, euros, etc.). Measurable properties are used to
define indicators, they can be elementary or composite. Elementary
measurable properties are described by measurement units: kg, Liter,
Gallon, Hour, Minute.

A Qualifying value (key indicator) defines how much of something
can be quantified, either as a singular value or as range of values,
according to a Measurable Property. Key indicators are valued.
Example: Response Time < 20 seconds.

The Measurable Properties can be connected to different types of objects such as:

e business capabilities,

e value streams,

e Business Skill,

e application environment.

A Measurable Property for the "Command management" business
capability is "Delivery time".

Qualifying Values can be connected to exhibited business capabilities; that is, a
capability highlighted within the context of a transformation stage. A Qualifying
Value is attached to a Measurable Property.
For example, the Qualifying Values of the "Command
management" exhibition of the exhibited business
capability) in a given transformation stage (existing or
future) can be "Deliver a pizza in less than 20mn" or "Take
the order in less than 3mn".

Finally, Qualifying Values or Measurable Properties can be grouped to define Sets of
Constraint Values and Sets of Constraining Properties.

A set of constraint values defines the grouping of elementary

Qualifying values that should be examined together in order to
appreciate the actual performance of a KPIed item. E.g.: a delivery
must take place in less than 20 minutes and cost less than 5 euros.

The components of a Set of Constraint Values can be:
e A set of constraint values,
* A Qualifying Value,
* A Flow Measure or a Technical Flow Measure.

w  For more details on Flow Measure Types, see Defining
Categorization Schemas.
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A Set of Constraining Properties is defined by different component types:

A set of constraining properties defines the grouping of elementary

Measurable properties that should be examined together in order to
appreciate the actual performance of a KPled item. E.g: a delivery must
take place within a target timeframe AND at target cost

Sets of Constraining Properties,

Measurable properties,

Flow Measure types, which are defined by a set of Flow measures.
Technical flow measure types, which are defined by a set of Technical
flow measures.

w  For more details on Flow Measure Types, see Defining
Categorization Schemas.

Describing a Measurable Property

A measurable property expresses the nature of indicators
(duration, mass, cost, etc.) and defines the unit used to measure them
(minutes, kilograms, euros, etc.). Measurable properties are used to
define indicators, they can be elementary or composite. Elementary
measurable properties are described by measurement units: kg, Liter,
Gallon, Hour, Minute.

Accessing the list of Measurable Properties of a Library

To access the list of Measurable Properties:
1. Expand the Environment > Containers navigation menu.
2. Select the library that interests you and expand its folder.
The list of measurable properties appears in the Measures & Categories
> Measurable Properties folder.

Creating a measurable property from a business capability

To create a Measurable Property from a business capability, for example:
1. Open the Measurable Property page of the business capability that
interests you.
2. In the Measurable Property section, click New.
A Measurable Property creation dialog box opens.
Specify:
its Name,
the text that describes its Unit,
the text of its Description.
Click OK.
The new Measurable Property appears in the section. It's connected to the
current library.

s e o oW
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The properties of a Measurable Property

The Characteristics property page of a Measurable Property provides access to:

e jts Name,
e the text that describes its Unit,

e the text of its Description.

The Usage property page of a Measurable Property provides access to:

the Qualifying Value section provides the list of Qualifying Values that

are based on this Measurable Property.
w  For more details, see Connecting a Measurable Property to a
Qualifying Value.

the Set of Constraining Properties section which provides the list of

sets of constraining properties associated to the Measurable Property.
w  For more details, see Creating a Set of Constraining Properties from
an object of an enterprise.

Describing a Qualifying Value

A Qualifying value (key indicator) defines how much of something
can be quantified, either as a singular value or as range of values,
according to a Measurable Property. Key indicators are valued.
Example: Response Time < 20 seconds.

Accessing the list of Qualifying Values

To access the list of Qualifying Values of a library:
1. Expand the Environment > Containers navigation menu.
2. Select the library that interests you and expand its folder.
The list of Qualifying Values appears in the Measures & Categories >

Qualifying Value folder.

Creating a Qualifying Value from an exhibited business capability

A Qualifying Value can be used by an exhibited business capability. It appears in the
Qualifying Value property page of the exhibited business capability.
An exhibited business capability is exhibited by an Enterprise Stage

with quantified measure (KPI) and potential geopolitical scope (Site) for
a defined market segment (Business Partner).

w For more details on exhibited business capabilities, see Managing
Exhibited Business Capabilities.

m  You create a Qualifying Value from the Qualifying Value property
page of all the objects that can be connected to simple or composite

performance indicators
To create a Qualifying Value from an exhibited business capability:
1. Open the Qualifying Value page of the exhibited business capability
that interests you.
2. In the Qualifying Value section, click New.
The Qualifying Value creation dialog box opens.
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3. Select the Measurable Property that you would like to use.

For example, "Delivery time"
4. Select the operator that you want to use (less than, greater than or
equal to).
For example, "Less than"

5. Specify the Value.

For example “48 hours”
6. Click OK.
The Qualifying Value is created with a Name calculated from its
characteristics.

In the example, the name is "Delivery time < 48 hours"

The properties of a Qualifying Value

The Characteristics property page of a Measurable Property provides access to:

e its Name, which is calculated automatically on creation,

e Its Measurable Property which defines its nature,

e its Unit, which is that of the Measurable Property and which cannot be
modified,
its Operator which positions it with respect to its value,
its Value,

e the text of its Description.

The Usage property page of a Qualifying Value provides access to:
e the Set of Constraint Values section: provides the list of Qualifying
Values that use the Qualifying Value described.

w  For more details, see Creating a Set of Constraint Values from an
exhibited business capability.

e the Exhibited Capabilities section: provides the list of exhibited
capabilities connected to the Qualifying Value.

w  For more details, see Creating a Qualifying Value from an exhibited
business capability.

Connecting a Measurable Property to a Qualifying Value
The Measurable Property is mandatory for the creation of a Qualifying Value; it is
used in calculating the name of value: Measurable Property name + logical
operator + Measurable Property unit.

The Measurable Property is given in the Qualifying Value property page.

To connect a Measurable Property to a Qualifying Value:

1. Open the Characteristics property page of the Qualifying Value that
interests you.

2. In the Measurable Property field, select the Measurable Property you
are interested in.
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Creating a Set of Constraining Properties from an object of an enterprise

A set of constraining properties defines the grouping of elementary
Measurable properties that should be examined together in order to
appreciate the actual performance of a KPIed item. E.g: a delivery must
take place within a target timeframe AND at target cost
A Set of Constraining Properties uses either a Measurable Property, or a Set of
Constraining Properties.

A Measurable Property or a Set of Constraining Properties can be used by several
Sets of Constraining Properties. During creation of a Set of Constraining Properties,
you can thus reuse a Measurable Property or a Set of Constraining Properties that
already exists.

To create, for example, a Set of Constraining Properties from a business capability:

1. Open the Measurable Property page of the business capability that
interests you.

2. In the Set of Constraining Properties section, click New.
A Set of Constraining Properties creation window opens.

3. Enter the Name.

4. In the Owned property Component section, click New.
An Add window appears:

5. Select the Object Type: Set of Constraining Properties or
Measurable Property.

6. Select the object that interests you and click Next.
The new component appears in the list.

7. Click Add and proceed the same way to connect other Measurable
Properties or Set of Constraining Properties.

Creating a Set of Constraint Values from an exhibited business capability

A set of constraint values defines the grouping of elementary
Qualifying values that should be examined together in order to
appreciate the actual performance of a KPIed item. E.g.: a delivery
must take place in less than 20 minutes and cost less than 5 euros.
A Set of Constraint Values uses either a Qualifying Value, or a Set of Constraint
Values.

A Qualifying Value or a Set of Constraint Values can be used by several Qualifying
Values. During creation of a Set of Constraint Values, you can thus reuse a
Qualifying Value, or a Set of Constraint Values that already exists.

A Set of Constraint Values can be used by an exhibited business capability. It
appears in the Qualifying Value property page of the exhibited business capability.

An exhibited business capability is exhibited by an Enterprise Stage

with quantified measure (KPI) and potential geopolitical scope (Site) for
a defined market segment (Business Partner).

w For more details on exhibited business capabilities, see Managing
Exhibited Business Capabilities.
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To create a Set of Constraint Values from an exhibited business capability:

1. Open the Qualifying Value page of the exhibited business capability
that interests you.

2. In the Set of Constraint Values section, click New.
A Set of Constraint Values creation window opens.

3. Select a Set of Constraining Properties.

4. In the Set of Values Component section, click New.
An adding sub-indicator window opens.

5. Select the Object Type: Set of Constraint Values or Qualifying
Value.

6. Select the object that interests you and click Next.
The new component appears in the list.

7. Click New and proceed the same way to connect other key indicators
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BUSINESS CAPABILITY MAPS AND VALUE
STREAMS

To manage your business transformation initiatives, HOPEX IT Business Management offers a
methodological framework established from international standards (BIZBOK and other
architectural frameworks of NAF/DoDAF and TOGAF type), as well as our experience in this area.

The first step of this method consists in analyzing the value streams,of your enterprise and
connecting them to business capabilities you have identified. Then you can check the suitability of
your business capabilities with your business functions and your skills. This work leads to a better
understanding of the current state of your organization ('As-Is').

The following points are covered in this chapter:

Describing a Business Capability Map
Describing value streams

Describing Functional Coverage

Describing the Outcomes

Describing Component Fulfillment
Describing the Data of a Business Capability

ANENENENENEN
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DESCRIBING A BUSINESS CAPABILITY MAP

A business capability defines an expected skill.
.A business capability is a set of features that can be made
available by a system (an enterprise or an automated system).
For example, to respond to a customer satisfaction
objective, the organization must be able to provide
services conforming to contractual commitments.

A capability map describes what the enterprise is capable of producing for its
internal needs or for meeting the needs of its clients. It is thus based on the main
business capabilities of its activity at a given moment.

A business capability map is a set of business capabilities with their
dependencies that, together, define a framework for an enterprise
stage.

Billing

Building the Business Capability Map

A business capability map is used to represent the main business capabilities that
interact with an enterprise.

Creating a business capability map

To create a business capability map:
1. From the Business navigation menu, select Capabilities.
The business capability map tree appears.
2. Click New.
A creation dialog box opens.
3. Specify the Name and click OK.
The new business capability map appears in the list.
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Creating a business capability decomposition tree

A Business Capability Decomposition Tree is a diagram that describes the tree
structure of a business capability or a business capability map. Focusing on a
particular business capability, this type of diagram enables summary representation
of business capability breakdown into sub-business capabilities.

To create a business capability map diagram:

1. Click the map to open its properties.

2. Click the Diagram > Create a diagram page.

3. Select Business Capability Decomposition Tree.
The diagram opens in the edit area. The frame of the business capability
map described appears in the diagram.
You can build a hierarchical view of the business capabilities that interest
you.

Creating a business capability map diagram

A business capability map represents the main business capabilities that interact
within a company, and their dependencies.

To create a business capability map diagram:

1. Click the map to open its properties.

2. Click the Diagram > Create a diagram page.

3. Select Capability Structure.
The diagram opens in the edit area. The frame of the business capability
map described appears in the diagram.

You can construct this diagram in tabular input mode.

L

w For more information on using tabular entry, see the “"Diagrams in
Tabular Entry Mode" in the HOPEX Common Features guide.

Defining business capability components

A Business capability component is the involvement of a business capability in
the context of a business capability map (one and only one) linked to an enterprise.
To add a business capability composition to a business capability map diagram:

1. In the diagram insert toolbar, click Capability Composition.
2. Click in the frame of the business capability map.
The creation window for a capability composition opens.
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3. Click on the arrow associated with the Name field and select the
business capability that interests you.

Add Business Capability « X
Owner
Name™*
| A
Accounting '
Administration {hj
4. Click OK.

The capability composition appears in the diagram.

w [f the business capability is associated with functionalities, they
also appear. For more details on the capabilities and functionalities
associated with business capabilities, see Defining the business skills
and functionalities associated with business capabilities.

Defining business capability dependencies

A dependency link between one capability composition and another is used to
specify the elements on which this dependency is based.

For example, “Billing” uses “Order Management”. Note that
the expected result (business effect) of "Billing" is an
"Invoice" and the expected result (business effect) of
"Order Management" is a "Order to be delivered".

Dependent Business Effect and Desired Business Effect are the business
capability results.

w  For more details on the results of business capabilities, see
Describing the Outcomes.

w A single capability composition can have more than one
dependency within a single diagram.

To create dependency links between two capability compositions:
1. In the insert toolbar, click Business Capability Dependency.
2. Click the user component, and keeping the left mouse button pressed,
move the cursor to the assembly used.
3. Release the mouse button.
The capability composition appears in the diagram.

To enter the results concerned by a dependency between two business capability
components:

1. Open the Characteristics properties dialog box.
2. Enter the user component result in the Dependent Business Effect
field.

For example, “Invoice”.
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3. Fill the Desired Business Effect field with the result of the component
used.

For example, “Order to be delivered”.

Describing a Business Capability

Creating a business capability

You can create a business capability from a business capability map diagram:

1. Click the Business function > Capabilities menu
The business capability map list appears.

2. Move the mouse over the relevant business capability map and click the
New > Business Capability button.
A wizard prompts you to create or reuse a business capability.

3. Check the Create object option.

4. Click Create.
The new business capability appears under the map.

Defining the properties of a business capability

To display properties of a business capability:
) In the navigation tree, select the business capability in question.

The Characteristics property page of the business capability map provides access
to:
e its Owner. By default, when a business capability is created, it is the
current enterprise.
the text of its Description
its Sub-capabilities
its Supporting Assets
the Desired Capability Effect which constitutes an Outcome.

For example, the desired capability effect of "Manage
operations" is a "Contract acceptance"

w  For more details on results, see Describing the Outcomes.

w  For more details on the use of results, see Defining business
capability dependencies.
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Other pages can be used to complete the description of a business capability:
w  Note that they can be hidden by default.
e the Dependencies page: lists dependent business capabilities and

required business capabilities.
w  For more details on the structures of a business capability, see
Defining business capability dependencies.
e the Expected Capabilities page: it is used to specify a list of
functionalities and skills that are expected from the business capability.

w  For more details on the skills and functionalities associated with a
business capability, see Defining the business skills and functionalities
associated with business capabilities.

e the Transformation page: provides access to the transformation stages
for which the described capability becomes an exposed capability.
An exhibited business capability is exhibited by an Enterprise Stage

with quantified measure (KPI) and potential geopolitical scope (Site) for
a defined market segment (Business Partner).

w  For more details on transformation stages, see Defining
Transformation Stages.

Creating a business capability structure diagram

A business capability can be based on business sub-capabilities.

For example, the business capability that consists of
managing operations is broken down into a number of business
capabilities such as: “Handle customer complaints”, “Manage

travel reservations”.

With HOPEX IT Business Management , the capability structure diagram
describes the composition of a business capability.

& g cpeions

Manage Customer | Manage customer |
Claims satisfaction
survey after return

Manage Customer | Manage Customer |
Travel Reservation car Rental
Reservation

@ Contract agreement
[ Received Product or Service
& Travel Order

Display the Catalog Content
Get customer information
Get stock information

To create a capability structure diagram:
1. Click the map to open its properties.
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N

Click the Diagram > Create a diagram page.
Select Business Capability Map Diagram.
You can construct this diagram in tabular input mode.

Lad

-~
w  For more information on using tabular entry, see the “"Diagrams in
Tabular Entry Mode" in the HOPEX Common Features guide.
The frame of the business capability described appears in the diagram.
4. Define the components of the capability described.
A Business capability component is the involvement of a

business capability in the context of a business capability map (one and
only one) linked to an enterprise.

w  For more details on how to use business components in a diagram,
see Defining business capability components.
A dependency link between one capability component and another is used to specify
the elements on which this dependency is based, that is, the effect of one required
by the effect of the other.

w  For more details on creating dependency links between two
capability compositions, see Defining business capability dependencies.

Defining the business skills and functionalities associated with business
capabilities
Each business capacity is associated with business skills and functionalities.

To associate a skill with a business capability:
1. Open the Expected Capabilities properties window of the business
capability.
2. In the Expected Business Skill section, click New.
An Expected Business Skill creation dialog box opens.
Click, for the Connect a Business Skill check box.
Specify the name of the skill.
Click OK.
The business skill appears in the list of skills associated with the business
capability.

w For more information on enterprise skills, see Describing Business
Functions.

ok

To associate a functionality with a business capability:

1. Open the property pages of the business capability concerned and select
the Expected Capabilities page.

2. In the Expected Functionality section, click New.

An Add functionality window appears:

Click the down arrow.

Select a functionality.

Click OK.

The functionality appears in the list of functionalities associated with the

business capability.

w  For more information on enterprise functionalities, see Describing
functionalities.

Dl
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The business skills, functionalities and the expected effects appear in the diagrams,
at the bottom of the frame of the capability described.

@ Contract agreement
@ Received Product or Service
@ Travel Order

Display the Catalog Content
Get customer information
Get stock information

A report is available to check the suitability between the business capability map and
the operational environment, for more details, see Describing Component
Fulfillment.

Business Capabilities reports

Dynamic reports enable you to analyze the business capabilities of your repository
according to different perspectives.

w  For detailed information on reports, see Generating Reports.

Business Capability Map Breakdown Report

You can use a breakdown report to visualize the objects that make up a business
capability map and the realization of components by EA equipment.

This report is available in the Business Capabilities Properties Reports page.

Example

The example below shows the coverage of the business
capability map by applications, with the “Technical
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efficiency” and “Business value” criteria available on the

applications.
Objects Colored Criterion Criteria Levels
Y & Application X ~ B Technical Efficiency X v (O Business Value X v Al =
MEGA Bank 2 Legend b3
Business Strategy & Corporate Banking Business Value
Execution Management @ hannel Management Management Custorner Mansgremrit @ @® Cood
" | Power2Market] © Medium
L ] Checking Accounts
Brand Management [V — Customer Authentication @ Low
@ roor
¥ Marketing Management Amistad Tcichpolnt #® Account Management
Management ®
Customer Complaint Technical Efficiency
Management B cood
Business Entity
Channel Access Collections & Recovery i
Medium
e -
s Customer Initiation B Low
=¥ Communication
W roor

Business Performance Management

Management @ Coporate Lending

Customer Needs Analysis

Channel Acquisition

Business Strategy
Managament

Corporate Banking

Operations

0]

Customer Operational
g HOPEX] & Core Bank System Definition Management

Channel Development @
. |e-strategy|
@ Corporate Credit Cards Customer Portfollo
—S—" L S i

w  For more details on use of a breakdown report, see the, chapter
"Handling a Breakdown Report" in the HOPEX Common Features
guide.

Business Capability Coverage over Time

This report provides a temporal representation of the elements that make up a
business capability map and the applications or application systems that cover
them.

Applications are analyzed according to various possible criteria. A timeline shows
their evolution over several years.

The criteria selected applies to both views of the report:

e Capabilities Time analysis: a proportional map displays the various
business capabilities and the applications that cover them.

e Criteria Time Analysis: a table displays the values of the selected
indicators according to the dates indicated.

Example
Below is the coverage report for the "MEGA Bank” capability map.

The report displays the list of associated applications and the criteria selected
(Current state, Technology compliance, Functional support, Business value).
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A point on the timeline indicates the date of the values displayed in the report. You
can move this point to view the evolution of indicator values over time.

Capabilities Time Analysis Criteria Time Comparison

Object Symbol Criteria Levels Date
h 4 & Application X v (O Application Current State X ) Technology Compliance X (O Functional Support X {> BusinessValue X v Ay 7Mmpo24 [
-
2024 2025 2026 2027
MEGA Bank

Risk, Compliance, - -
Business Strategy & Internal Finance ) Retail Banking ) Digital Banking
Execution Management Financlal Regulations Management Management Management
Management
Policy Management Credit Risk Management

Practical Law Invoicing

‘Checking Accounts Checking Accounts
Management Management

‘Cash Management

Account Management Account Management

Collections & Recovery

[ R A 1o} o¢00 o¢00 o
Fraud Risk Management
Agent Commissions
Ma ment
Model Risk Management
IT Management
®¢+C0
Audit Management - * MEGA BANK Mobile App * MEGA BANK Mobile App
s LXK 5] L X4 15]
@s00

A Legend button shows the meaning of the indicators and their colors.

Collections & Recovery I

Account Management
( R X 1]

Credit Cards Management

Credit Cards Management

Application
Management
oo

CMDB Management
[ ]

]
IR

o~

= Legend X

Application Current

Scheduled

Preparation

Retirement

O
@
@ Production
@
@

Retired

Business Value
¢ Good

{ Medium
¢ Low
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Launch the report

To generate a Business Capability Coverage over Time report:
1. Click the Reports menu.
2. To the right of the edit area, click the Create a report button.
3. Find the “Business Capability Coverage over Time” report type.
The report appears in the edit area.
4. Select the report type and click Create a report.
The report creation wizard opens.
5. Select:
e the business capability map
e the analysis criteria
e if required, the portfolio of applications to be evaluated.

Business Capability Coverage over Time-4 Z

You can select up to 5 criteria, which will be used in the report for trend analysis and
comparison over time.

Business Capability

MEGA Bank
Criteria
Business Value\APM X Functional Support\APM X
Application Current State X Technology Compliance X

Portfolio

* MEGA Bank Core Applications

6. Click Preview then Continue.
7. Give the report a name and a description.
8. Click Save and open.
© You can also run the analysis on a set of applications: in the list of

applications, select those to be analyzed and click Reports >
Rationalization > Business Capability Coverage over Time.

Business Capabilities Tree Map

This report breaks down a capacity tree in the form of a proportional map according
to one of three possible criteria:
e Number of components: the surface area is proportional to the number
of sub-capabilities in the tree.
e Number of applications: the surface area is proportional to the number of
applications realizing current and descendant capabilities in the tree.
e Cost of applications: the surface area is proportional to the cost of
applications realizing current and descendant capabilities in the tree.
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Take note that:

e Since an application can realize several capabilities, the "Cost
Contribution Key" ratio is applied for the criteria "Number of applications"
and "Cost of Application".

e As a result of the application of this distribution coefficient, the number
of applications may not be an integer (it represents an application
coverage ratio).

e An application realizing an "intermediate" capability (i.e. not a leaf of the
tree) is considered to realize all its sub-capabilities in a uniform way
(strict pro rata between all sub-capabilities).

To generate the business capability map breakdown from an application portfolio:
1. Open the properties of the portfolio in question.
2. Click Reporting > Business Capability Tree Map.
3. Select a capability map.
4. Refresh the report.
L

w  For more details on use of a Treemap, see the chapter "Handling a
Treemap" in the HOPEX Common Features guide.
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DESCRIBING VALUE STREAMS

A value stream is an end-to-end collection of Value Stages that
creates an outcome for a customer, who may be the ultimate customer
or an internal end-user of the value stream.

w To display the Value streams, open the Options window and
check that Business Process and Architecture Modeling > Value
Stream Modeling is activated.

Value Stream Example

In this value stream diagram, the Business Function or the Business Functional Area
that create the value streams are linked to the participants represented in columns.

The following diagram presents an example of a value stream:

-+

"Purchase reception” value stream

The purchase request is recorded and must then be approved.
The requester is informed of the approval or rejection of
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the request. If the request is validated, an analysis of the
required order is carried out.

If stock is lower than a given threshold, an order is
prepared and sent to the supplier for resupply.

If the product is available, or as soon as it is received
from the supplier, it is made available to the requester.

In this example, the business functions concerned are represented in columns.

A business function is a conceptual unit of the division of
responsibilities in an enterprise. It is used to structure the management
of information processing, energy, and equipment produced or used.
Business functions define the skills and the functionalities necessary to
the enterprise to fulfill its mission.
In the organization previously presented, three org-units: purchasing assistant,
purchasing manager and buyer, systematically participate to execute the first four
steps: record and approve the request, analyze and send the order.

Optimization of the organized process "Process Purchase Requests" has saved one
step: when amount of the order is not significant, the purchasing assistant can
himself approve or refuse the purchase request.

In the case of urgent orders, you can again save steps by authorizing the purchasing
assistant to send the order when the amount is not significant.
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We obtain the following value stream for processing of urgent orders:

Prhauct ar Service Selivery

[E@Product o Sanvice avalasi

Saanacny

£

"Purchase reception" value stream

The first step consists of analyzing the purchase request.
If the total amount is large, normal processing is carried
out.

Otherwise, the availability request and a restock request
are sent, if necessary. Continuation of this value stream is
identical to the previous one: when the order has been
received, it is made available to the requester.

Value Stream representation principles

Highlighting organizational choices

Each enterprise has activities related to its business that must be performed
whatever the organization in place. These activities can be purchasing, sales, sales
administration, manufacturing, etc.

Defining their organization consists of assigning these activities to the org-units that
will perform them.

We can distinguish between:

® Processes relating to the business of the enterprise: these are difficult to
change unless the enterprise decides to totally review its business.
e Processing depending on organizational choices.
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Number of steps

Certain steps in an organizational process are exclusively linked to the chosen
organization. In such cases, it is useful to check whether these steps provide any
real added value to clients or only concern the way things are done.

Delivery times can also be reduced by restructuring the order of these steps.

To highlight possible improvements, you can represent a value streams by flows
exchanged between enterprise value stage.
A value stage is a distinct, identifiable phase or step within a value

stream that has a unique entrance criteria, exit criteria, and identifiable
participating business function or business functional area.

Using Value Streams

A value stream is an end-to-end collection of Value Stages that

creates an outcome for a customer, who may be the ultimate customer
or an internal end-user of the value stream.

Accessing Value Streams

To access the list of Value Streams from the Business navigation menu:

} Click the Value Streams menu.
The list of value streams appears.

Creating a value stream

To create a Value stream from the Business navigation menu:

1. Click the Value Streams menu.
2. Click New.
The value chain is created and added to the list of value chains.

3. Specify the name of the new Value Stream,

Creating a value stream diagram

To create a value stream diagram

1. Select the value stream that interests you and click Create Diagram.
A window opens and prompts you to choose the Diagram Type that you
wish to use:
Select the diagram type you want to create.

e a value stream diagram, see The value stream diagram;

e a value stream to capability diagram, see The value stream to capability
diagram;

The value stream diagram

The value stream diagram shows the sequence of the value
creation steps performed, the events that occur and the conditions
under which they are sequenced. It also makes it possible to assign the
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participants who carry out these value-creation steps to the business
skills needed to implement them. This representation of a Value Stream
helps to answer the following question: "What are the skills needed to
implement the Value Stream?".

This type of diagram makes it possible to describe precisely a value stream.

If the value stream is already connected to components, it is possible to initialize a

new diagram by inserting the existing components.

The value stream to capability diagram
The value stream to capability diagram can only be used in tabular entry mode.
~

w  Tabular entry mode is available with this diagram. For more
information about it, see the "Diagrams inTabular Entry Mode" in the
HOPEX Common Features guide.

This diagram makes it easy to initiate a value stream diagram by creating the value
stream steps and the links they have with the different business capabilities.
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Representing the Value Stream Implementation

You can represent the fulfillment of a value stream by a process.

To access the list of Processes from the Environment navigation menu:

1. Click the Organization > Processes menu.

2. Open the Characteristics property page of the process that interests
you.

3. In the Fulfillments section, click the New button.

101
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DESCRIBING FUNCTIONAL COVERAGE

Describing the Functionality Map

A technology capability map is a set of technology capabilities and
their dependencies that, together, defines the scope of a hardware or
software architecture.

Accessing the list of functionality maps

To access the list of functionality maps from the Inventories navigation menu:

} Select Capabilities > Functionalities in the navigation menu.
The tree of functionality maps appears.

The properties of a functionality map

The Characteristics properties page of a functionality map provides access to:
e its Owner, by default on creation of the business function, the current
enterprise.
its Name,
the text of its Description
e the Owned Functionalities section,

w  For more information on the functionality components, see Creating
a functionality component in a functionality map diagram and Defining
Functionality dependencies.

With HOPEX IT Business Management , a functionality map is described in the
Reporting property page.

Creating a functionality map

To create a functionality map diagram:
1. Right-click the functionality map that interests you and select New >
Diagram.
2. Select Functionality Map.
The diagram opens in the edit area. The frame of the functionality map

described appears in the diagram.

Creating a functionality component in a functionality map diagram

The components represented in a functionality map are Functionality
components.

A technology capability is the ability to deliver a technology service
which is required by a technology artifact or an application.

To add a functionality component in the functionality map diagram:
1. In the diagram insert toolbar, click Functionality Component.
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2. Click the functionality map frame.
The functionality component creation window opens.
3. Click, for example, Reusing an Existing Functionality.
4. Click Display Scope to access the list of functionalities linked to the

enterprise.
5. Select the functionality that interests you.
6. Click OK.

The functionality component appears in the diagram.

Defining Functionality dependencies

A dependency link between one functionality and another is used to specify the
elements on which this dependency is based.

To create dependency links between two functionalities in a functionality map
diagram:
1. In the insert toolbar, click Functionality Dependency.
2. Click the functionality component, and keeping the left mouse button
pressed, move the cursor to the functionality component used.
3. Release the mouse button.
The creation window for the functionality dependency opens.
4. Enter the user component result of the user functionality in the
Dependent Application Effect field.
5. Enter the content result of the functionality used in the Necessary
Application Effect field.
6. Click OK.
The link appears in the diagram.

w A single sub-functionality can have more than one dependency
within a single diagram.

Describing functionalities

A technology capability is the ability to deliver a technology service
which is required by a technology artifact or an application.

To access the list of functionalities from the Inventories navigation menu:

) Select Capabilities > Functionalities in the navigation menu.
The list of functionalities appears in the edit area.

To create a functionality:

1. In the Inventories navigation menu, click Capabilities > Business
Functionalities..

2. Select the desired functionality map and click New > Functionality.
A Functionalities creation dialog box opens.

3. Enter the name.

4. Click OK.
The functionality created appears in the list of functionalities.
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The Characteristics property page of the functionality provides access to:

With HOPEX IT Business Management , a functionality is described in the

its Owner, by default during creation of the functionality, the current
enterprise.

its Name,

the text of its Description

the Desired Application Effects:

w  For more information on the effects of expected functionalities, see
Defining Functionality dependencies.

following pages:

the Structure page is used to specify a list of functionalities owned and
the dependencies between them.

w  For more information on the structure of functionalities, see
Creating a Functionality Diagram.
the Implementation page provides access to the list of architecture
elements that implement the functionality.
In the Usage page, the Capability Component section provides access
to the functionality maps that use the described functionality.
w  For more details on relationships between functionalities, see
Creating a functionality component in a functionality map diagram.
In the Usage page, the Business Capability section provides access to
the business capabilities that require the described functionality.
w  For more details on the functionalities associated with business

capabilities, see Defining the business skills and functionalities
associated with business capabilities.

In the Usage page, the Business Function section provides access to
the business functions that require the described functionality.

m  For more details on businesses, see Business properties.
In the Usage page, the Capability Exhibition section provides access
to the exposed business capabilities that require the described
functionality.

An exhibited business capability is exhibited by an Enterprise Stage

with quantified measure (KPI) and potential geopolitical scope (Site) for
a defined market segment (Business Partner).

Creating a Functionality Diagram

To create a functionality diagram:

1.

2,

To create a functionality from a functionality diagram, see Creating a functionality

Right-click the functionality that interests you and select Create
Diagram.
Select Functionality diagram.

The diagram opens in the edit area. The frame of the functionality

described appears in the diagram.

component in a functionality map diagram..

To define the dependencies of sub-functionalities, see Defining Functionality

dependencies.
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Describing the Technology Capability Map

A technology capability map is a set of technology capabilities and
their dependencies that, together, defines the scope of a hardware or
software architecture.

Accessing the list of technology capability maps

To access the list of technology capability maps from Inventories navigation
menu:

) Select Technology Capabilities in the navigation menu.
The technology capability map tree appears.

Using the technology capabilities
The use of technology capabilities is identical to the use of functionalities.

For more details, see Describing the Functionality Map.
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DESCRIBING THE OUTCOMES

The outcomes of a business capability, a functionality, or a skill are represented by
a content.

The content designates the content of a message or an event,
independent of its structure. This structure is represented by an XML
schema linked to the content. A content may be used by several
messages, since it is not associated with a sender and a destination.
There can be only one content per message or event, but the same
content can be used by several messages or events.

The contents associated with the outcomes are used to describe the content of flows

exchanged in the value streams.

The outcomes are used to define the dependencies between:

e The business capabilities in the business capability maps, see Defining
business capability dependencies.

e The sub-functionalities in the functionality maps, see Defining
Functionality dependencies.

Connecting an outcome to a business capability

An outcome can be used by a business capability or by an exhibited business
capability. It appears in the Desired Capability Effect section of the
Characteristics page of the capability property pages.

For example, the desired capability effect of "Billing" is
an "Invoice"

To connect an existing outcome to a business capability, for example:

1. Open the property pages of the business capability that interests you.
2. Select the Characteristics page.
3. In the Desired Capability Effect section, click New.

The Creating a Desired Business Effect window opens.

4. Select Reusing an existing content.
5. Select the content that interests you and click OK.
The content appears in the list of Desired Capability Effects.
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DESCRIBING COMPONENT FULFILLMENT

To represent the implementation of a component such as a business capability or
functionality you must create a Fulfillment of the component.

Creating Fulfillment of a Business Capability

A business capability can be implemented by different types of object such as a
Business Function, Business Functional Area, a Process or an Application.

To associate a process to a business capability, you must create a business
capability fulfillment.
L) The creation of a business capability map represents the
organization of physical agents (Application Systems) or logical
(Business Function) agents that implements the business capacities of
the map.
To specify that a business capability is fulfilled by a process:
1. Open the Fulfillments property page of the business capability that
interests you.
2. Click New.
The Implementation creation dialog box opens.
Select Reusing an existing Process, Application...
Select Process.
Select the desired process and click OK.
The business capability realization appears in the list with the name and
the type of the selected object.

Ll

Reports can be used to visualize the coverage of business capability elements by
operational elements such as business functions, and according to different
perspectives: Organizational, Business/Data, Logical/Physical Application, etc.

w  For more details on fulfillment reports for enterprise capabilities,
see Business Capabilities reports.
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DESCRIBING THE DATA OF A BUSINESS CAPABILITY

Combined with HOPEX Data Architecture or HOPEX Data Governance, the
HOPEX IT Business Management solution can be used to define the data used
at the level of a business capability.

Create a Concept Domain Diagram on a Business Capability

Describing the data used in a business capability involves creating a concept domain
diagram. You can create this diagram from the business capability concerned.

The concept domain diagram presents business data, their properties and their

relationships.
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To create the concept domain diagram for a business capability:
1. Open the property windows of the business capability.
2. Click the Diagrams page.
3. Click Create a diagram.
4. Select the “"Concept Domain” diagram type.
The diagram is displayed in edit mode.

Diagram Content

A concept domain includes or references a set of business data.
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The data described in the diagram and defined as “components” of the concept
domain is visible in the business capability properties, in the Characteristics page,
in the Business data section.

w The Business Data section can be hidden by default. To display it,
click the Manage sections button and select Business data.

To connect a diagram element to the list of concept domain components :

1. Right-click the element to open its pop-up menu.
2. Select Add to “(Name of current concept domain)”.

For more information on creating diagram elements, see:

"Define Business Information > Concept Domain > Building a Concept Diagram" in
the HOPEX Data Governance documentation.



DRAWING THE TRANSFORMATION ROADMAP

Drawing up the roadmap consists of identifying the enterprise transformation stages that define the
timeframe of the transformation goals.

A Business Transformation Stage is a kind of Enterprise
Transformation Stage aiming at the alignment of the enterprise
business operating model to its business strategy and corresponding
exhibited business capabilities (business model).
The roadmap is used to plan the business capabilities that the enterprise must acquire to reach its
strategic objectives. The changes in these business capabilities over time takes place through
exhibited business capabilities.

An exhibited business capability is exhibited by an Enterprise Stage

with quantified measure (KPI) and potential geopolitical scope (Site) for
a defined market segment (Business Partner).

The exhibited business capabilities are connected, through the implementations, to the technical or
business components of the enterprise. The enterprise transformation takes place through the
architecture components transformation.

This chapter describes the procedures to be followed to:

Identifying Exhibited Business Capabilities,
Describing a Business Architecture Environment,
Describing an Enterprise Architecture,

Drawing up the Roadmap.

SNENENEN
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IDENTIFYING EXHIBITED BUSINESS CAPABILITIES

Managing Exhibited Business Capabilities

An exhibited business capability is exhibited by an Enterprise Stage

with quantified measure (KPI) and potential geopolitical scope (Site) for
a defined market segment (Business Partner).

Accessing the list of exhibited business capabilities

To access the list of exhibited capabilities of a transformation phase:

1.
2,

3.
4,
5

Click the Business > Strategic Planning navigation menu.

Select the enterprise that interests you and unfold the tree of strategic
components.

Expand the Transformation stages folder.

Expand the tree of the strategic component that interests you.

Expand the Exhibited Business Capabilities folder.

The exhibited business capabilities list is displayed.

Creating an exhibited business capability

To create an exhibited business capability from an transformation stage:

1.

Open the Exhibited Capabilities properties page of the transformation
stage.

A page presents the tree of the business capabilities of the enterprise
business capability map.

Select the business capabilities that interests you and click Add.

The exhibited business capability is created and appears in the Exhibited
business capability column.

Select the exhibited business capability.
The Exhibited business capability properties page opens on the right.

In the Enterprise objectives column, click the arrow to display the
transformation stage objectives.

Select the objectives concerning the exhibited capability.

In the Business Capability Realization column, click the arrow to
display the realizations of the current business capability in
transformation stage context.

w  For more details on implementation of business capabilities, see
Creating Fulfillment of a Business Capability.

Select the realizations concerning the exhibited capability.

w The details of elements connected to an exhibited business
capability are displayed in a transformation stage report, see Stages
Capabilities Synthesis report.
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The properties of an exhibited business capability

The Characteristics property page of the exhibited business capability provides
access to:
its Name,
its Owner, by default the current transformation stage,
e Desired Capability Effect, provides access to the exhibited business
capability outcomes.

An exhibited business capability is described by the following pages:

e the Structure page specifies a part of the list of business capability
components that constitute the exhibited business capability, as well as
the dependencies between these components,

m  For more details on business capabilities components, see Defining

business capability components and Defining business capability
dependencies.

e the Fulfillments page provides access to the list of Components
implement the business capability.

w  For more details on implementation of business capabilities, see
Creating Fulfillment of a Business Capability.

e The Qualifying value and Measurable property pages provide access
to the list of indicators associated with the exhibited business capability.
w  For more details, see Using performance indicators.
e the Assessment page provides access to the assessment results of the
business capabilities realization.

w  For more details on the assessments of business capabilities, see
Creating a business capability assessment.

e the Transformation page provides access to transformation stages
connected to the exhibited business capability.
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Stages Capabilities Synthesis report

This report is available on a dedicated Report properties page of the transformation
stage. It presents a view of the enterprise business capabilities highlighting the
exhibited business capabilities.
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Using assessment for Business Capabilities and their
Implementation
The assessment are based on a business capability map and are accessible using

the enterprise stages to which the map is connected. These assessments are
therefore valid in the context of a transformation stage and at a given date.
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Creating a business capability assessment

The assessment of business capabilities deals with the following characteristics:

e the Business Value: characterizes the value that the business capability
brings to the company. It can be used to position a business capability on
a strategic scale (very strategic or very non-strategic).

e the Capability Effectiveness: characterizes the quality of what the
business capability produces, regardless of the resources used. Allows
you to assess the conformity of the result with expectations.

e the Capability Efficiency: characterizes the resources used to produce
the expected result of the business capability. Shared resources can be
more efficient than dedicated ones.

e the Financial Impact: characterizes the impact of the result generated
by the business capacity on the company’s finances. Allows you to assess
the impact of a non-compliant result on the company’s finances.

From a transformation stage, you can create a new assessment with a view to
assessing some business capabilities connected to the enterprise business capability
map.

To create a business capability assessment for a transformation phase:

1. Open the Assessment> Capability Assessment properties page for
the transformation stage that interests you.
w  The transformation stage is connected to the business capability

map associated to the enterprise, see Connecting the capability map to
an enterprise.

2. Click the New Assessment button.
A selection window presents the tree of the business capabilities of the
enterprise business capability map.

3. Select the business capability that you want to assess and click OK.
The selected capabilities appear in the edition area.
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4. Click the capabilities to enter the evaluation criteria.
the business value,

capability effectiveness,

capability efficiency,

financial impact.
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6. Click the Validate Assessment button.
A validation window opens.

7. Define the Evaluation date and click OK.
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Creating an assessment of business capability implementation

The assessment of business capabilities realization deals with the quality of the
capability realization. The possible values are between very low and very high.

From a transformation stage, you can create a new assessment of business
capability realizations.

To create an assessment of business capability implementation in a transformation
stage:
1. Open the Assessment > Capability Realization Assessment
properties page for the transformation stage that interests you.

w  The transformation stage is connected to the business capability

map associated to the enterprise, see Connecting the capability map to
an enterprise.

2. Click the New Assessment button.
A selection window presents the tree of the business capabilities of the
enterprise business capability map as well as those capabilities
realizations.

3. Select the business capability realization that you want to assess and
click OK.
The selected capability realizations appear in the property page.

4. For each realization, complete the Capability Realization Quality
criteria.

5. Repeat the same procedure for Business Capabilities: Validating
Assessment by entering the assessment date.
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DESCRIBING A BUSINESS ARCHITECTURE ENVIRONMENT

One of the most important phases in describing a business architecture environment
is defining and understanding of the enterprise functional architecture.

The functional architecture enables the organization to understand, independently
of its physical structure, which capabilities and skills it includes, those it needs, and
how these contribute to its processes.

The description of the functional architecture also enables identification of areas of
the organization where skills and processes are duplicated and where synergies
exist. These areas are not necessarily visible from the organizational structure.

The following points are covered here:

e Managing a Business Architecture Environment.
Describing a Business Functional Area.
Describing Business Functions.

Describing Business Partners.
Drawing up the Roadmap.

Managing a Business Architecture Environment

A business architecture environment represents the relationships of
a business functional area with its partners.

A business architecture environment diagram describes the service interactions
between the main internal components of the environment described and the
external components. It thus describes:

e the internal and external business functional areas,

A Business functional area is a set of business functions and their
associated value streams on the conjunction of two main criteria: their
need in accomplishing one or more business capabilities and the
common skills and functionalities required to accomplish these business
capabilities.

e the business partners,

A business partner designates a third-party who is in relation with
the enterprise within the framework of a given business architecture
environment. Examples: private sector client, regulatory organization,
supplier.
In this example, the business function architecture
environment of company is made up of the historical business
function architecture and its interactions with external
partners: clients and suppliers. You can see in the diagram
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that delivery is outsourced to a third party deliver
partner.
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Communications between the objects are represented by service interactions that
represent requests and service provision.

L1 A service Interaction represents an interaction for service purpose
between entities in a specific context inside or outside a company.

These entities can be enterprise org-units, applications, activities or
processes, as well as external org-units. The content of this interaction

is described in a service interface.
w For more details on service interactions between components, see
Managing Service Interactions.

Accessing the list of Business Architecture Environments

To access the list of Business Architecture environments:

1.

In the Inventories navigation menu, click Business Architecture >
Environments.

The list of Enterprises appears.

Expand the business enterprise folder that interests you, as well as its
Architecture Environment folder.

Expand the Reference Operating Model folder.

A list of the different environments linked to the Enterprise appears.

Creating a business architecture environment

To create a business architecture environment:

1.

In the Inventories navigation menu, click Business Architecture >
Environments.

The list of Enterprises appears.

Expand the business enterprise folder that interests you, as well as its
Architecture Environment folder.
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3. From the Reference Operating Model folder, click New > Business
Architecture Environment.

4. Enter its Name.
The new business architecture environment appears in the list.

The properties of a business architecture environment

The Characteristics properties page of the business architecture environment
provides access to:
e jts Name,
its Owner,
the text of its Description
its Owned Realizations

w For more details on the realization of business capabilities, see
Creating Fulfillment of a Business Capability.
With HOPEX IT Business Management , a business architecture environment is
described by the following property pages:
e the Structure page which provides access to the list of components of
the business architecture environment.

w  For more details on the components of the business architecture
environment, see Creating a business architecture environment
diagram.

e the Implementation page, which provides access to the list of resource
architecture environments, applications, application system or logical
application system that implement the business architecture
environment.

Creating a business architecture environment diagram

To create a business architecture environment diagram:
1. From the list of business architecture environments, select the one you
are interested in and click Create diagram.
2. Select Business Architecture Environment Diagram.
The diagram opens in the edit area.
You can construct this diagram in tabular input mode.
~

w For more information on using tabular entry, see the “"Diagrams in
Tabular Entry Mode" in the HOPEX Common Features guide.

Creating an internal or external business functional architecture
area

To define that a functional area is used in the context of a business architecture
environment, you can:
1. Create a Business functional Area Use component that is part of the
architecture environment described or a Partner Business functional Area
Use type component if it is a business functional area that belongs to
another environment.
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2. Associating the Business functional Area fulfilled to the Business
functional Area Use created.

In our example, the history business function is an internal
environment element.

w  For more details on business partners, see Describing a Business
Functional Area.

To create a Business Functional Area Use:

1. In the insert toolbar for the business architecture environment diagram,
click Business Functional Area Use.

2. Click in the business architecture environment frame described.
A creation dialog box prompts you to Connect Business Functional
Area.

3. Select the business functional area that interests you and/or create a
new one.

Create, for example, the “Manufacturing" business
functional area.
4. Click OK.
The business functional area appears in the diagram.

w  Proceed in the same way to create an External Partner Business
Functional Area Use:

Creating a business partner component

To describe a business architecture environment that uses participants internal or
external to the environment described, you must:
1. Create a Business Partner Component.
2. Associate the person (or the person group) to the Business Partner
Component created.

In the example of the business architecture environment of
the manufacturing company, the business partners used are
the clients and the service provider who ensures the
delivery.

w  For more details on business partners, see Describing Business
Partners.

To create a Business Partner Component:

1. In the insert toolbar for the business architecture environment diagram,
click Business Partner Component and click in the frame of the
diagram.

A creation window prompts you to choose the existing Business Partner
or create a new one.

Create for example the "Clients" business partner.

2. Click OK.
The business partner use appears in the diagram.

Describing a Business Functional Area

L1 A Business functional area is a set of business functions and their
associated value streams on the conjunction of two main criteria: their
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need in accomplishing one or more business capabilities and the
common skills and functionalities required to accomplish these business

capabilities.

Accessing the business functional area list
To access the business functional area list:
1. In the Inventories navigation menu, click Business Architecture >

Business Functions.
The tree of business functional areas appears.

The properties of a business functional area
The Characteristics properties page of a functional area provides access to:

e its Name,
its Owner, by default on creation of the business functional area, the
current enterprise.
the text of its Description
its Owned Realizations
w  For more details on creating a business capability, see Creating
Fulfillment of a Business Capability.

With HOPEX IT Business Management , a business functional area is described

in the following pages:
the Structure page, which provides access to the list of components of

the business functional area.
w  For more information on the components of a business functional
area, see Describing a business functional area diagram.
the Performed Process page, which provides access to the value
streams executed in the context of the business functional area.
w  For more details on value streams, see Describing the Outcomes.

Describing a business functional area diagram

A business functional area diagram describes the service interactions between the
main internal components of the architecture described. It thus describes:

e the uses of the business functional area,

LI A Business functional area is a set of business functions and their
associated value streams on the conjunction of two main criteria: their
need in accomplishing one or more business capabilities and the
common skills and functionalities required to accomplish these business
capabilities.
In this example, the history functional area is based on the
business functional areas for selling, delivering and
command.
w  For more information on the use of a business functional area, see
Creating an internal or external business functional architecture area.

e the business components.

A business function is a conceptual unit of the division of
responsibilities in an enterprise. It is used to structure the management
of information processing, energy, and equipment produced or used.
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Business functions define the skills and the functionalities necessary to
the enterprise to fulfill its mission.

w  For more details on business functions, see Describing Business
Functions.
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With HOPEX IT Business Management , communications are based on:
e access points: service points and request points.

A service point is a point of exchange by which an agent offers a
service to potential customers.

A request point is a point of exchange by which an agent requests a
service from potential suppliers.

w  For more details on service interactions between components, see
Managing service points and request points.

® service interactions

A Service Interaction represents an interaction for service purpose
between entities in a specific context inside or outside a company.
These entities can be enterprise org-units, applications, activities or
processes, as well as external org-units. The content of this interaction

is described in a service interface.
w  For more details on service interactions between components, see
Managing Service Interactions.

Managing service points and request points

A business business functional area is created to ensure one or more services. These
services are represented by service points. The service is requested according to
precise terms defined by an service interface assigned to the service point.

A service point is a point of exchange by which an agent offers a
service to potential customers.

A Service Interface is a template of a contract between entities
(organizational, IT ...). The contract is described by available operations
which can be triggered trough messages exchanged by roles (vendor,

buyer..).
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A request point is used to represent the use of an external service.

A request point is a point of exchange by which an agent requests a
service from potential suppliers.
The service is requested according to specific terms that are defined by a service
interface assigned to the request point.

Components that issue a request are linked to the request point by a service
interaction.

In the example, the request point that represents the
"External delivery" is linked to the "Sales and deliveries"
business functional area by a service interaction.

Creating a service point or a request point
The process for creating a service point or request point is identical.

To create a service point:

1. In the diagram insert toolbar, click Service Point.

2. Position the object at the edge of the architecture frame.
A creation dialog box opens.

3. Click the arrow to the right of the Service Interface field to define the
service interface enabling activation of this service point, and select, for
example, Connect Service interface.

A query window opens.

4. Select the service interface associated with this service point.

5. Click Next.

A dialog box opens proposing a list of the service interface roles that can
be associated with the service point.

w  This second dialog box is not proposed if there is only one
candidate role that can be associated with the service point.

6. Select the role that interests you and click OK.
The service point appears in the diagram.

To change the service point name:

1. Click the name of the service point and press key F2.
2. Enter the new name used when specifying service interaction points.

Managing Service Interactions

A Service Interaction represents the exchange of information between architecture
components.

A Service Interaction represents an interaction for service purpose
between entities in a specific context inside or outside a company.
These entities can be enterprise org-units, applications, activities or
processes, as well as external org-units. The content of this interaction
is described in a service interface.

The content of a service interaction is described by an service interface.

A Service Interface is a template of a contract between entities
(organizational, IT ...). The contract is described by available operations
which can be triggered trough messages exchanged by roles (vendor,
buyer..).
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Creating a Service interaction

To create a service interaction:
1. In the objects toolbar of the diagram, click Service interaction.
2. Draw a link between the two communication entities.
3. In the Add service interaction window, specify the service interface you
wish to use.
w  You can also create a new service interface, see Creating a service
interface from a service interaction.

4. Click OK.

Creating a service interface from a service interaction

You can create a service interface:

e from a library,
e from a service interaction in a diagram.

To create a service interface, in a diagram, from a service interaction:
1. In the objects toolbar of the diagram, click Service interaction.
2. Draw a link between the two communication entities.
3. In the Add service interaction window, click the arrow at the right of the
field Service interface and select New.
The creation window appears.
4. Enter the service interface name in the Name field.

5. Click OK.
The service interaction and the service interface are created.

Describing Business Functions

A business function is a conceptual unit of the division of
responsibilities in an enterprise. It is used to structure the management
of information processing, energy, and equipment produced or used.
Business functions define the skills and the functionalities necessary to
the enterprise to fulfill its mission.

Accessing the list of business functions

To access the list of Business Functions from the Inventories navigation menu:
1. Select Business Architecture > Business Functions.
The tree of business functional areas appears.

2. Expand the folder of the business functional area that interests you.
The list of business functions connected to the concerned business

functional area appears.
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Business properties

The Characteristics properties page of a business function provides access to:
its Owner, by default on creation of the business function, the current
enterprise.
e jts Name,
e the text of its Description
e its Owned Realizations

w  For more details on creating a business capability, see Creating
Fulfillment of a Business Capability.

With HOPEX IT Business Management , a business function is described by the

following pages:
e the Required Abilities page is used to specify a list of skills and
functionalities required by the business.
w  For more details, see Describing functionalities.
e the Performed Process page, which provides access to the value
streams executed.

Describing Business Partners

A business partner designates a third-party who is in relation with
the enterprise within the framework of a given business architecture
environment. Examples: private sector client, regulatory organization,

supplier.

Accessing the business partners list
To access the list of Business Partners from the Inventories navigation menu:

) Select Business Architecture > Business Partners.
The list of business partners appears in the edit area.

The properties of a business partner
The Characteristics properties page of the business partner provides access to:
e its Owner, by default on creation of the business partner, the current

enterprise.

e its Name,
e Its business partner group, see Drawing up the Roadmap,

e the text of its Description.

With HOPEX IT Business Management , a business partner is described by:
e the Service and Request Points page, which specifies the services
expected or delivered by a business partner.

m  For more information on these service points and request points,
see Managing service points and request points.

The Usage page provides access to the business function architecture
environments that use the described object, see Describing a Business
Architecture Environment.
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DESCRIBING AN ENTERPRISE ARCHITECTURE

The enterprise architecture is described through the architecture description of each
transformation stage that represent the architecture evolution over the time.

A transformation stage is defined by a number of components that represent its
architecture. This consists of:

The lists of exhibited business capabilities;

An exhibited business capability is exhibited by an Enterprise Stage

with quantified measure (KPI) and potential geopolitical scope (Site) for
a defined market segment (Business Partner).

w  For more details on how to associate an exhibited business
capability with a transformation stage, see Creating an exhibited
business capability.

the business architecture environment;

A business architecture environment represents the relationships of
a business functional area with its partners.

w  For more details, see Describing a Business Architecture
Environment.

the solution building block environments.

w  For more details on how to access this information from an
enterprise or a transformation stage, see Describing physical solutions.

Describing the operating architecture

The business architecture environment contains the elements that define the
enterprise model (operational model) for the current stage.

w  For more details on the managing the business architecture
environment, see Managing a Business Architecture Environment.

The elements constituting the enterprise operational model are:

e the enterprise ecosystem defined by the service interactions with the
partners,

e the business function architectures,

e the business functions.

To describe the business architecture environment for a transformation stage:

1.

2,

Open the Architecture Description property page of the
transformation stage.

In the Functional Architecture section, click the right arrow of the
Operational Model field.

Click Connect a business architecture environment.

A selection window opens.

Select the business environment architecture that interests you and click
Connect.

The business architecture environment is connected to the transformation
stage.
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Describing physical solutions

The possibilities to describe physical solution depend on the product licenses that
you have, for example:

For example,

with  HOPEX IT Architecture, you have access to Logical

Application System Environments, to Application System Environments and
also to Resource Architecture Environments.

To connect technical or application architecture building blocks to an transformation

stage:

1.

2

Open the Architecture Description property page of the
transformation stage.

In the Functional Architecture section, click Connect.
A selection window opens.

Select the environment type concerned and click Find.

A business architecture environment represents the relationships of
a business functional area with its partners.

A resource architecture is the combination of physical and
organizational assets configured to supply a capability.

An application system environment allows presenting the other
application systems, applications or microservices with which this
application system can interact.

A logical application system environment presents a logical
application system use context. It describes the service interactions
between the logical application system and its external partners, which
allows it to fulfill its mission and ensure the expected functionalities.

4. Select the environment that interests you and click Connect.

The environment is connected to the transformation stage as well as to all
the building blocks that it comprises.
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Drawing up the Roadmap

DRAWING UP THE ROADMAP

A number of functionalities are available to display and analyze an enterprise’s
transformation strategy and the stages of its deployment.

Each transformation stage is positioned in the enterprise according to their period,
in order to define the transformation roadmap for the enterprise underway.

w  For more details on transformation stages, see Defining
Transformation Stages.

The transformation stages dates are presented in the colons of the dedicated report
of the enterprise.

Purchasing Enterprise x

o Reporting v

Project Impact on Transformation Roadmap
Parameters

Project Portfolios

Hide Business Capability

Refresh the report

~ H
[
1. Transformation Goals and Objectives
e
24/7 web site without service interruption
Starting Transformation Stage MNew Internet Site
Internet major sales channel
24/7 purchasing Broaden Customer Base
Final Transformation Stage Increase revenue on emerging market
All countries Purchasing
Broaden Customer Base
2. Planning and Impact of Transformation Project Deliverables
@), @ scale step: year
2019 2020 2021 2022 2023 2024

[ starting Transformation Stage Starting Tr
[ Final Transformation Stage
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The strategic components of the enterprise and its transformation stages are
displayed in another enterprise report.

w  For more details on strategic elements, see Identifying Strategic
Transformation Elements.

Purchasing Enterprise x

vy Reporting v

Enterprise Strategic Map Synthesis

Q

1. Synthesis of Enterprise Transformation Roadmap

2. Enterprise Strategic Map Synthesis

vy Purchasing Enterprise
& 24/7 web site without service interruption
@ Increase revenue on emerging market
@ Broaden Customer Base
% Accés au marché (FR)
% Turnover on emerging high potential. people
% Develop customer fidelity
@ Internet major sales channe!
=" Starting Transformation Stage
=" Final Transformation Stage
@ 24/7 purchasing

@ All countries Purchasing
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DRAWING UP AN APPLICATION INVENTORY

The application inventory phase consists of collecting information from different viewpoints:

descriptive, functional, financial, technical, etc.

This chapter presents functionalities proposed by HOPEX IT Portfolio Management to help you

inventory the application assets of your enterprise.

The following points are covered here:

NN N N N NS NN

Creating Application in HOPEX IT Portfolio Management

Defining the Properties and the Environment of an Application

Defining the Properties and the Environment of an Application System
Defining Application Life

Managing application installations

Managing Application Versions

Managing Application and Application System Costs

Evaluating Application Criticality

Recording Architecture Decisions

List of Analysis Reports Available on Applications and Application Systems
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CREATING APPLICATION IN HOPEX IT PORTFOLIO
MANAGEMENT

HOPEX IT Portfolio Management offers the possibility of describing simple
applications or more complex applications via the use of application systems.

Applications and application systems of the organization can be created by the
Enterprise Architect or the EA functional administrator.

Application portfolio managers can create applications and specify the owners of
those applications. They can then initiate update workflows (functional and
technical) so that the application owners can complete the data for their
applications.

See Application Update Workflow.

Creating an Application

As an Enterprise Architect you can access applications from the Applications
navigation pane of the HOPEX Architecture desktop.
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Under Applications, a drop-down list classifies the applications according to the

Drawing up an Application Inventory
Creating Application in HOPEX IT Portfolio Management

following criteria:

All applications of the repository

Applications of the connected user portfolio

Applications outside portfolio (those not belonging to any inventory
portfolio)

Applications without owner

etc.
HOPEX Applications
Enterprise
Architecture
Applications
-= Applications By Portfolio
Business
ﬂ d All Applications + New

Applications

& All Applications
& My Applications
Technologies & My Applications involved in GDPR

& Applications of my Portfolios

&¥ Applications of my portfolios involved in GPDR
& All Applications involved in GPDR

& Applications out of Portfolio

&¥ Applications without owner

& Applications to update (IT and Business Data)

& Applications with overdue update (IT and Business Data)

&¥ Applications to validate (IT and Business Data)

To create an application:

1.
2,

In the navigation bar, click Applications.

In the edit area, click Inventory.

The list of applications appears in the edit area.

Click the + New button.

In the an application creation window, you can specify:
the name

the life cycle

life cycle begin and end dates

the functional scope

the associated technologies

w  For further details, see Application Characteristics.
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5. Click OK.
w  The user that created an application becomes its manager.

Importing Applications from an Excel file

You can bulk import applications and other application assets via a dedicated Excel
file. For more details, see Importing Objects in HOPEX IT Portfolio Management.

Creating an Application System

An application system comprises applications and/or sub-application systems.

Prerequisite

Application systems are not visible by default. To use them in HOPEX IT Portfolio
Management:
1. On the desktop, click Main Menu > Settings > Options.
The options window appears.
2. In the tree on the left, click the HOPEX Solutions > Common
Features folder.
3. In the right pane of the window, select the option Use of Application
Systems.
4. Click OK.
5. Save the modification and restart HOPEX IT Portfolio Management.

w  Application systems may appear in certain analysis reports, such as
the business capability breakdown report, but if the option is not
checked, you cannot access their properties.

Creating an Application System

To create an application system as an Enterprise Architect:

1. In the navigation bar, click Inventories > Software > Application
Systems.

2. Click the drop-down list then All Application Systems.
The list of repository application systems appears.

3. Click the + New button.

4. In the dialog box for creating an application system, indicate:
* jts name
e its life cycle
e life cycle begin and end dates

w  For more details on life cycles, see Defining Life Cycles.

e version number

Cloud Computing: defines how the application system should be

installed.

5. Click Next if you also want to define the functional scope of the
application system (see Defining Application Functional Scope). If not,
click OK.
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Adding an application to the application system

To connect an existing application to the application system:

1.

2,
3.
4

oo

Aggregation Type

Display the properties of the application system.

Click the Characteristics page.

In the Component section, click Application.

Click + New.

The application component creation dialog box opens.

From the drop-down list, find and select the desired application.
Click OK.

Applications in the application system can be considered as components or as
independent applications. This distinction modifies evaluation data of application
system costs. See Application System Costs.
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DEFINING THE PROPERTIES AND THE ENVIRONMENT OF AN

APPLICATION

All elements of an application are accessible from its properties pages.

Accessing Application Properties

To access the properties pages of an application:

1.
2,

In the navigation bar, click Applications.

In the edit area, click the application to display its properties.

Certain property pages are hidden by default. To display them, click the
Show/Hide button, then select the desired page.

Application Overview

Colored indicators highlight for the application:

its Business Value: nesting level of the application in enterprise
production.
its Functional Support: support level of the application in enterprise
process.
its Technology Efficiency: assessment of evolution possibilities of the
application from the techniques that support it.
w  For more details on these indicators see Evaluating Application
Criticality.
Its Technology Compliance: attribute calculated on the basis of the
“Company Standard” defined on all the technologies used by the
application.
m See Company standard (calculated).

its Obsolescence Risk corresponds to the highest risk of the
technologies linked to it. If an application is linked to three technologies
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with “low”, “high” and “very high” risks, the application risk takes on the
maximum value, i.e. “very high”.

m  See the obsolescence risk in the Overview of an application.

* AirportMega.com
24 Overview HSI Assessment Characteristics Assessmen’ > + New page Versions W

®.® Good Q, Medium ENE Very High
ﬂg’ Business Value %) Functional Support = Obsolescence Risk

= Prohibited @ Partial Compliance
L5 Technology Compliance Compliance

Application Characteristics

To access characteristics that enable identification of an application:
} In the properties window of an application, select the Characteristics
page.
The page displays the following information.

Application identification

The identification includes:

e the Name
e the internal Code
e the Application Type

e In House Application: a specific application, also known as an in-
house or proprietary application, is a software application developed
specifically for use within a single organization. Unlike commercially
available software, in-house applications are tailor-made to meet the
specific needs and requirements of the organization developing them.
These applications are generally used to manage single process
categories, automate tasks and improve operational efficiency within
the organization.

e Middleware: middleware is a type of software that acts as an
intermediary layer between different applications, systems, or
components. It facilitates communication, data exchange, and
integration among various software systems, enabling them to work
together cohesively.

e Office System: an office system application typically refers to
software or a suite of tools designed to facilitate various office-related
tasks and streamline workflows. These applications are meant to
improve productivity, communication, and collaboration within an
office environment. Depending on the specific needs of the
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organization, an office system application can encompass a wide
range of functionalities.

Some examples of well-known office system applications include
Microsoft Office 365, Google Workspace (formerly G Suite), and Zoho
Office Suite. These applications typically offer a combination of the
features mentioned above and cater to the needs of businesses and
organizations of different sizes and industries.

e Software Package: a software package application is a specific type
of software package that provides a set of related programs or
applications to address a particular domain or solve specific problems.
It is a collection of software tools bundled together as a unified
solution, often with a common theme or purpose. These applications
are designed to be installed and used collectively to provide a
comprehensive solution to users' needs.

e System: a system application, also known as a system software or
system-level software, refers to a category of software that is
essential for the operation and management of a computer system.
Unlike application software, which is designed for end-users to
perform specific tasks, system applications work behind the scenes to
facilitate the functioning and interaction of hardware, software, and
users. System applications are critical for the overall operation,
performance, and security of a computer or device.

e the Cloud Computing, which indicates how the application should be
installed:

e On premises: the application is installed and runs on computers on
the premises (in the building) of the company.

e Infrastructure as a Service (IAAS): the application is installed and
runs on an external provider infrastructure (physical or virtual
machines and other additional resources such as images in a virtual-
machine image-library, raw (block) and file-based storage, firewalls,
load balancers, IP addresses, virtual local area networks (VLANs), and
software bundles).

e Platform as a Service (PAAS): the application is installed and runs
on an external provider computing platform including operating
system, programming language execution environment, database,
and web server. Internal/external developers can develop and run
their software solutions on a cloud platform.

e Software as a Service (SAAS): the application is designed, installed
and runs by an external delivery partner. Some customization can be
implemented during the design phase.

e a Comment.

Other characteristics
Some sections of the Characteristics page are hidden by default.

To display these:

) At the top of the Characteristics page, click the Manage sections >
Service Level Agreement button.
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Application characteristics include:

the Service Level Agreement: displays the indicators that define the
application quality level.

Functional Scope of the application. See Defining Application
Functional Scope.

Responsibility: it relates to the person or persons responsible for the
application. See Designate People Responsible for Applications.
Technology used. See Specifying the Technologies of an Application.
Exchanges with other objects. See Specifying Data Exchanged With
Other Applications.

the Data (Classes, Entities or Data views) handled by the application.
See Defining the Data Used by an Application.

the Concepts used.

the Risks associated with the application. See Specifying the Risks
Associated with an Application.

Gantt Chart of the application presenting the application lifeline. See
Defining Application Life.

associated Attachments. See Attaching Documents to an Application.

Defining Application Functional Scope

To indicate the objects that define application functional coverage:

1.

2,

Open the application properties.
m  See also Accessing Application Properties.
Click the Characteristics page.

3. Expand the Functional Scope section.

w A report covers functional characteristics of a list of applications.
See Portfolio Analysis Reports.

The types of data that define functional coverage of the application are:

the business lines that use the application

A business line is a high level classification of main enterprise
activities. It corresponds for example to major product segments or to
distribution channels. It enables classification of enterprise processes,
organizational units or applications that serve a specific product and/or
specific market. Regulation frameworks of certain industries impose
their own business lines.

w  See also: Defining Business Lines.
Process Categories using the application

A process category defines a group of processes. It is linked to a
Process Map or higher level Process Category. It regroups several
processes and/or other categorized elements (e.g. Value Streams,
Applications). It serves as an intermediate categorization level in the
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process hierarchy, so as to provide a guided and progressive access to
finer grained processes.

w  For more details on the list of available business processes, see
Defining Business Processes.

e The business capabilities covered by the application

w  For more details on the list of available business capabilities, see
Defining Business Capabilities.

w A report covers distribution of applications in business capabilities,
see Generating the Business Capability Map of a Portfolio .

e functionalities implemented by the application

A functionality is a service required by an org-unit in order to

perform its work. This functionality is generally necessary within an
activity in order to execute a specific operation. If it is a software
functionality, it can be provided by an application.

This data is used in the “Application Overview"” and “Application Environment Graph”
reports of the application.

See Application Environment Graph of an application.

Connecting a functionality to the application

To create a functionality and connect it to the application:

1. In the Functional Scope section, select Implemented Functions.

2. Click the + New button.
The new functionality appears in the list of functionalities of the
application.

To connect an existing functionality to the application:
1. In the Functional Scope section, select Implemented Functions.
2. Click the Connect button.
The connect wizard appears.
3. Click the Find button.
The list of repository functionalities appears.
4. Select the required functionality.
5. Click Connect.

Designate People Responsible for Applications

You can assign applications to persons who perform the following business roles:

e Application Owner
e Financial Controller
e IT Owner

e Business User

w  For more information on these roles, see the associated profiles in
HOPEX IT Portfolio Management Profiles.
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Defining a manager for an application

To assign an application manager, for example a business manager:
1. Display the properties of the application.
w See also Accessing Application Properties.
Click Characteristics.
Expand the Responsibilities section.
Click the Business Manager tab.
Click Connect.
The query dialog box appears.
Find and select the person concerned.
7. Click Connect.

Designated managers may be asked to complete the information on the applications
for which they are responsible. For more details, see Collecting Data for a Set of
Applications.

aRrODd

o

Assign an owner to a set of applications

On the Enterprise Architecture desktop home page, an indicator shows the list of
applications without an owner. You can display this list and designate an owner for
some or all of these applications.

To designate the owner of a set of applications:

1. Click the Home page.

2. Click the Applications without owner indicator.
The list of applications concerned appears.

3. Select the relevant applications.

4. Click the Assign Application Owner button.

See also Scope Indicators.

Specifying the Technologies of an Application

To specify technical characteristics of an application:
1. Open the application properties.
w  See also Accessing Application Properties.
2. Click Characteristics.
3. Expand the Technologies section.
You may:
e connect existing technologies to the application
e create new technologies.

A technology is a definition or format that has been approved by a
standards organization, or is accepted as a standard by the industry.

w A report covers the list of applications by technology. See Portfolio
Analysis Reports.

For more details on technologies, see Drawing up an Application Inventory.
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Attaching Documents to an Application

You can attach external references to an application.

External references are of URL type: They enable association with an object of a
document from a source outside HOPEX.

To attach an external reference to an application:

1. Open the application properties.

w See also Accessing Application Properties.

Click Characteristics.
Expand the Attachments section.
Click the New button.
Indicate the name and URL of the reference.
Click OK.

Sop N

Specifying Data Exchanged With Other Applications

You can describe the message flows exchanged between applications, with their
direction and content. This information enables creation of exchange mapping.

For more details on obtaining this report, see Generating an Application
Environment Report.

A message flow is information flowing within an enterprise or exchanged between
the enterprise and its business environment. A message flow can carry a content.

A Business data indicates content of a message flow. A Business data can be used
by several message flows, since it is not associated with a sender and a destination.
The same business data can be used by several message flows.

To create a message flow of a source application to a target application:
1. Open the properties pages of the source application.
w  See also Accessing Application Properties.
Click Characteristics.
Expand the Exchange section.
Click Sent Application Flows and click the New button.
The Creation of Message Flow - Content dialog box appears.
5. Select the Receiver application.
6. From the Content field, select the business data you want to associate
with the message flow.
7. Click OK.

See also Defining the Data Used by an Application.

pPODd

Specifying the Risks Associated with an Application

HOPEX IT Portfolio Management is used to identify the risks associated with an
application, and to retrieve the evaluations defined in the HOPEX Enterprise Risk
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Management solution. You can define a new risk using the application or connect
a previously defined risk.

To connect a risk to an application:
1. Open the properties pages of the application.
m  See also Accessing Application Properties.
Click Characteristics.
Expand the Risk section.

m  The section can be hidden by default. To display it: at the top of the
Characteristics page, click the Manage sections > Risk button.

4. Click Connect.
The query dialog box appears.
5. Find and select the risk required and click OK.

Lol

For more details on risks and their evaluation, see HOPEX Enterprise Risk
Management.

Generating an Application Environment Report

Application Environment Graph of an application

The “Application environment graph” report presents links between an application
and its environment. Components appearing in the graph can be applications,
installations, technologies, functionalities, consumer org-units or process categories
linked to the application.

To open the environment graph of an application:
1. Select the application to display its properties.
2. Inits properties window click the Reporting page.
3. In the report list, select Architecture > Application Environment

Graph.

The report consists of four report chapters:

e Exchange and Content: displays data flows between the application
and other applications. See also Application Exchange Graph for a set
of applications.

e Installation and Use :displays the sites that host the application.
See also Managing application installations.

e Functional scope: displays the objects that define application
functional coverage. See also Defining Application Functional Scope.

e All the Environment: provides a complete view of the application
environment. The Layers option associated with the graph allows you
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to filter the display according to the desired viewpoint (functional
scope, installations or data flows).
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Application Exchange Graph for a set of applications

You can generate an Application Exchange Graph from a selection of applications to
see their connecting links.

To generate an Application Exchange Graph on a set of applications:
1. Display the application list, for example from the Applications
navigation menu.
2. In the list displayed, select the applications and click Instant Report.
3. Select the Exchange Between Applications instant report type.
4. Click OK.
The instant report opens in the edit area.
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This report displays:
e in the form of nodes: the selected applications
e In the form of an arc: the flows that connect the applications. When

there are several flows between applications, they are grouped within
the same arc.
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You can filter display:

e by content: it is the exchanged data, defined in the application
properties. See Specifying Data Exchanged With Other Applications.

e by context: this concerns application flow scenarios, which you can
create if you have the HOPEX IT Architecture application.

For more visibility an option available under the report allows you to hide
applications without link.

See also: List of Analysis Reports Available on Applications and Application Systems.

147



148

DEFINING THE PROPERTIES AND THE ENVIRONMENT OF AN
APPLICATION SYSTEM

Similarly to applications, the inventory phase consists of collecting information on
application systems from different viewpoints: descriptive, functional, financial,
technical.

Prerequisite

Application systems are not visible by default. To use them in HOPEX IT Portfolio
Management:
1. On the desktop, click Main Menu > Settings > Options.
The options window appears.

2. In the tree on the left, click the HOPEX Solutions > IT Portfolio
Management folder.

3. In the right pane of the window, select the option Use of Application
Systems.

4. Click OK.

5. Save the modification and restart HOPEX IT Portfolio Management.

Accessing Application System Properties

To access application system properties:
) In the list of repository application systems, click the required application
system.

Its property pages appear:

e Characteristics. See Application System Characteristics.
Installation. See Creating an Application System Installation.
Projects. See Transforming the Application Portfolio.

Evaluation. See Evaluating Application Systems.

Cost. See Managing Application and Application System Costs.
Reports. See List of Analysis Reports Available on Applications and
Application Systems.

Application System Characteristics

To access characteristics that enable identification of an application system:
) In the application system properties, select the Characteristics page.
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You can specify:
e the Identification (name, internal code, etc.)
e the Service Legal Agreement: displays the indicators that define the
application quality level.

e the Components. See Adding an application to the application system.
¢ theFunctional Scope. See Defining Application Functional Scope.
¢ the Responsibility: see Responsibilities.
e the application system Gantt chart. See Application system Gantt chart.
e associated Attachments. See Attaching Documents to an Application.
Responsibilities
Owner

An owner should be defined on the application system. He/she is responsible for
application system technical and functional information He/she can be application
owner or portfolio manager.

Financial Controller

A financial controller should be connected to an application system. He/she is
responsible for defining application system financial information, in particular at
time of evaluation.

Business User

A business manager can be specified if necessary, but this is not mandatory.

Application system Gantt chart

The application system has its own life cycle. It is confronted with the life cycle of
its components so that possible conflicts in reports can be detected. The application
system Gantt chart therefore displays life cycle of the application system with that
of its components.

See Defining Application Life.

Evaluating Application Systems

Similarly to applications, the application manager can evaluate application systems
for which he/she is responsible on three criteria: business, functional and
technological. For more information, see Evaluating Application Criticality.

The Portfolio Manager can evaluate the application assets he/she supervises by
creating an application portfolio and associating with it additional evaluation criteria.
See Evaluating Application Assets.
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DEFINING APPLICATION LIFE

To enable detailed analysis of repository object evolution scenarios and the
associated costs, HOPEX IT Portfolio Management enables description, from an
object life, of the planning of steps in the object life cycle.

L The object life is a set of time periods representing the updated
calendar of object life cycle states.

Viewing Application Life (Gantt Chart)

An object evolving over time can take different states (preparation, production,
retirement, etc.).

The Object life enables viewing of the planning of these different states in the form
of a Gantt chart.

To view the Gantt chart representing the different states of an application for
example:
1. Open the application properties.
w  See also Accessing Application Properties.
2. Click Characteristics.
3. Expand the Gantt section.

The first line shows the synthesis of the life cycle of the application, with the
sequence of different states. Under this line you access the details of the time
periods associated with each state (preparation, production, etc.).

() @) Scale step: 5 years

Name 2016 - 2020 2021-2025 2026 - 2030

= 57 MEGA BANK Mobile A o prepaaton  produien ([ Retmement )
[} Preparation 07/03/2018 —
[7] Retirement _ o7/02/2

Initializing the life of the application

The object life is a set of time periods representing the updated calendar of object
life cycle states.

To create the life of an application:
1. In the Gantt section, click Initialize the Life of the Object.

w If the life of the object already exists, the Delete the Life of the
Object button appears.

The creation of object life dialog box appears.
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2. Specify the following characteristics:
e a Life Cycle which enables definition of the list of possible states of
the object.

w  For more information on proposed life cycles, see Defining Life
Cycles.

e a Begin Date and an End Date which enable positioning of the object
life in time.
3. Click OK.

The object life appears in the Gantt chart of the application.

From information on object life, the Gantt chart represents planning of the different
steps in time.

Updating the dates of an application life

By default, the different steps in the object life cycle are distributed in equal time
periods between object life begin and end dates.

These dates are accessible and can be modified in the application Gantt chart.

Accessing properties of a time period

In the Gantt chart, the pop-up menu of a time period presents commands specific
to the described application ("Billing" in our example), followed by the commands
relating to the time period itself.

To access properties of a time period of the application life:

1. In the Gantt chart, right-click the time period.
2. In the time period pop-up menu, select Properties.

See also: Defining Life Cycles.

Gantt Chart Report

On an application, a report in the form of a Gantt chart enables viewing of steps in
the application life cycle, its deployment and the technologies used. See Analyzing
Application Life Cycle and Installations.

Application decommissioning plan report

As an enterprise architect, you can analyze application end-of-life planning to
ensure that functional coverage is not compromised, and identify potential action
plans.

The Decommissioning Plan report covers a map of business capabilities and
associated applications. For each capability, it shows the number of applications
scheduled for retirement over the next few years, quarter by quarter.

You can filter applications by portfolio.

To create an application decommissioning plan report:

1. Click the Reports menu.
2. At top right of the edit window, click Create a report .
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Search for and select the report.
Click Create a report.

In the report creation wizard, select:
e a business capability map

e (optional) an application portfolio
Click Preview.

Click Continue.

You can specify the following elements:
e report name

e public concerned

e tags

e description

9. Click Save and open.

The report opens in the edit area.

Al ol

o

© N

For the defined capability map, the report shows the number of applications that will
be removed.

To display application details:

) Click the corresponding number.
Application details appear at the bottom of the report.

[@lfll=]=] « [a=]=]=]
2 2 1 2 1 1

W . BiaN Capability Map 7

» Enterprise Management and Controlling

’ Product and service enabling

v Enterprise Enabling
Facility and Equipment Management 1 1
Human Capital Management 1 1
Infarmation Management

t and Suooli anacement
Details
Local name T End life date @ Global Expense
‘ Office Supplies Management = A 10/1/2024
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MANAGING APPLICATION INSTALLATIONS

HOPEX IT Portfolio Management enables management of application
deployments.

Applications and Installations

HOPEX enables association of an application with one or several installations.

w A software installation represents use by a given population of an
application over time. The installation is therefore associated with a life
cycle which is specified at the time of its creation.

On each installation you can define:

e The Hosting Location: the application is hosted by a data center. An
application can be installed in several data centers, depending on the
context.

e The Deployment Support: this is the server on which the application is
deployed.

e The Usage Context: an installation is associated with one or more
usage contexts that allow to specify the Consumer (the user of the
application) and the Functionalities offered. See Creating an Installation
Usage Context.

O 7he usage context of an application or an application system
enables specification of the list of functionalities offered to each

population of users for a given installation over a period of time. Several
contexts can be created for a given installation.

Consulting Application Installations

To access the installations of an application:
1. Open the application properties.
2. Select the Installation page.
The list of installations associated with the application is displayed with:
e deployment date
e planned retirement date

To access characteristics of installations of an application:

) Select an installation.
The hosting, deployment support and usage contexts associated with the
installation appear in the following sections.

In Context of Use you can define :

e context begin date:
e proposed functionalities retirement date
e planned number of users
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By selecting a context, you display in the following section:

e The list of functionalities associated with the context (Implemented
Functionality)

e The list of users of these functionalities (Consumer)

~ Owned Usage Context

E Properties ° Remove $» Workflow [Z) Instant Report &

Local name T Deployment Date... Retirement Date...
European Market = B i 11/2023 1h/2028
Page 1 of1 & Afficher 50 elements
s» Consumer Implemented Functionality
00 Connect rli Reorganize @I Instant Report B

Short Name T

Beneficiary Management

Certificates Generation

Creating an Application Installation

Application installation on a data center offers functionalities adapted to different
populations of users over a time period.

You can create a first installation at creation of the application, or create it later via
its properties pages.
To create an application installation:
1. Open the application properties.
2. Select the Installation page.
w  The page can be hidden by default. To display it: to the right of the
properties pages, click the Show/Hide > Installation button.
3. In the Software Installation section, click the New button.
The Creation of Software Installation dialog box opens.
4. Enter the name of the deployment.
5. Select the Deployment Life Cycle from the drop-down list of this field.

154



6.

7.

10.

1.

Drawing up an Application Inventory .
Managing application installations .

Specify:

e Start Date, corresponding to the effective deployment date

e End Date, which can correspond to the application production end
date.

Select the Freeze the Source Object of the Software Installation to

avoid modification of the deployed application.

w  You cannot modify a locked application. If the application is to be
modified, a new version must be created.

w  for more details on variations, see the HOPEX Common Features
guide, "Handling Repository Objects", "Object Versions" chapters.
Click Next.
In the Hosting Location section, select the data center that hosts the
installation.
In the Usage Context, specify the usage context of the application,
including consumers and functionalities..
Click OK.
The new installation appears in the application properties.

Creating an Installation Usage Context

The usage context of an application or an application system enables specification
of the list of functionalities offered to each population of users for a given installation
over a period of time. Several contexts can be created for a given installation.

To create a usage context of an application installation:

1.
2,

No o

10.

Open the application properties.

Select the Installation page.

The list of installations associated with the application is displayed.
Select the installation that interests you.

In the Usage Contextsection, click the New button.

The Creation of Use Context dialog box opens.

Specify the Life Cycle, Start Date and End Date of the context.
Click Next.

Click the Connect button to select users specific to the usage context.
The consumer of a deployment can be an Org-Unit (such as an
organization, department or individual) or a Software Installation
Click Next.

Click the Connect button to select the functionalities that will be
proposed to users in the usage context.

Click OK.

The new usage context appears in the properties of the deployed
application.

Analyzing Application Life Cycle and Installations

A report

enables display in the same Gantt diagram of life cycle steps of the

application and its installations.
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A second report indicates any conflicts between life cycles of these objects.

To access these reports:
1. Open the properties of the application concerned.
2. Click the Reporting page.
3. In the reports list, select:
e Gantt Chart to view life cycles of the objects
e Gantt chart with conflicts to view any conflicts.

@), @) Scale step: 5 years

Name -2009 2010 - 2014 2015 - 2019 2020 - 2024 2025 - 2029
o I I | | . |
B &3 Application
Conflict Period 1 .

B £ Seftware Installation

9 pencenter Gormany nalag  prepeasion ([ radicien (1 (D

4! DataCenter USA Installation
Conflict Period 2 .

Conflict Period 3 -
Conflict Period 4 .

B 3 Software Technology

EB .NET Framework 4.8

EB ASP.NET 4.5

EB Node.js - 14.0

Detection of conflicts report on an application

See also: Creating an Application System Installation.

Creating an Application System Installation

When we refer to application system installation, this means installation of all or
only certain of its components.

You can create several installations for the same application system.

When you create an application system installation, the wizard allows you to
automatically create software installations for all application system components.
You can also manually define software installations to be associated with the
application system (see Defining Application System Software Installations).

To run application system installation:
1. Open the properties of the application system.
2. Select the Installation page.
3. In the Application System Installation section, select New.
4. In the window that appears, enter:
e installation name
e installation start and end dates
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Indicate if you want to install all components. In this case, the tool

creates these automatically.

Click Next.

You can specify:

e the Consumers, in other words the users of the deployed application
system.

e the Implemented Functions.

Click OK.

Application System Installation Contexts

A usage context is automatically associated with an application system installation
To this context you can connect consumers and implemented functions.

L The usage context of an application or an application system
enables specification of the list of functionalities offered to each
population of users for a given installation over a period of time. Several
contexts can be created for a given installation.

You can create several contexts for the same application system installation.

To add a context to an application system installation:

1.
2.

3.

4,

Open the properties of the application system.

In the Installation page, Application System Installation section,
select the application system installation concerned.

In the Application System Installation Context section, select New.
The context appears in the section.

Select the context created and in the next section, indicate the
Consumers of the context and the Implemented Functions.

Defining Application System Software Installations

To indicate manually which components are deployed in an application system

installation:
1. Open the properties of the application system.
2. In the Installation page, Application System Installation section,
select the application system installation concerned.
3. In the Software Installation section, select New.
4. From the listed components, select the application to be installed.

e If the selected application has no existing installation, create an
installation. A context is automatically created for this installation in
which the consumer is the installation of the application system.

e If the application presents existing installations, select the required
installation. A context is automatically created for this installation in
which the consumer is the installation of the application system.
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MANAGING APPLICATION VERSIONS

HOPEX IT Portfolio Management allows you to manage different versions of the
application assets.

The version management applies to following objects:
e Application

Microservice

IT Service

Software technology

Software technology stack

Managing Application Versions

Creating a new version of an application involves duplicating an existing application
and defining the elements that will make up the new version.

Each version constitutes a new application which inherits elements of the application
from which it is derived. When duplicating, the user can specify which elements to
keep or delete in the new application.

The versioning system makes it possible to track updates made to an application
over time.

To create a new version of an application:
1. Open the application properties.
2. Click the Versions page.

w  The page can be hidden by default. To display it: to the right of the
properties pages, click the Show/Hide > Version button.

3. Click the + New button.
4. In the window that opens, select the items to be retained or deleted and
click Create version.

w  For more details on versions, see the HOPEX Common Features
guide, "Handling Repository Objects", "Object Versions".
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MANAGING APPLICATION AND APPLICATION SYSTEM
CosTs

The aim of modeling costs with HOPEX IT Portfolio Management is to be able to
compare the cost of different components and to compare the different evolution
scenarios on identical financial criteria.

To be able to take account of the time (past and future), the cost of a component is
represented by a fixed part and a periodic part.

For example, a purchase price is specified in a fixed part,
and annual maintenance in a periodic part.

Finally, costs are characterized by different criteria that enable more detailed
comparison. Criteria are:
e the type to distinguish investment costs.
e the nature to isolate costs of infrastructure, license, service or
manpower.
e |ife cycle of the component concerned.

Cost Calculation Principles

Each fixed expense is associated with an amount and a date.

Each periodic expense is associated with an initial amount, a start date, and the
amount and periodicity of timespots.
w  For more details on modeling of costs, see Creating a fixed expense
and Modifying a periodic expense.
The cost of an application can be calculated in the absolute, or in the context of a
portfolio. In the case of a portfolio, sums are calculated between begin date and end
date of the portfolio.

We assume for example that retirement of an application
starts in July with a decreasing periodic cost. The periodic
cost is 500€ and the decreasing cost -100€.

Begin Date End date Period cost Ig::::::t
7/1/2012 7/30/2012 500 500
7/1/2012 8/1/2012 400 900
7/1/2012 9/1/2012 300 1200
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Begin Date End date Period cost Ig::::::t
7/1/2012 10/1/2012 200 1400
7/1/2012 11/1/2012 100 1500
7/1/2012 12/1/2012 0 1500

The cost calculation formula proposed as standard in HOPEX is based on fixed and
variable cost characteristics.

Specifying Application Costs

In HOPEX IT Portfolio Management costs on an application can be specified by:
a user with “Financial Controller” role, who has been declared responsible for the
application in question;

e the portfolio manager.

m To define those responsible for an application, see Application
Characteristics.

One or several cost lines can be associated with an application.
A cost line enables identification of cost kind and type.

A cost line is characterized by:
e atype : operating or capital.
e a nature: infrastructure (for a deployment), license (for an application),
service, manpower;
e a state of the life cycle of the component concerned, such as
specification or development phases.

Associated with a cost line can be:

e a periodic expense
e one or several fixed expenses

Creating a cost line
To associate costs with an application, you must begin by creating a cost line.

You can create cost lines singly, or automatically create three cost lines
corresponding to the three cost natures possible for an application: license, service,
manpower.

To create a cost line for an application:
1. Open the application Properties.
2. Click Costs.

w The page can be hidden by default. To display it: to the right of the
properties pages, click the Show/Hide > Cost button.

3. In the Cost linesection, click New.
The Creation of a cost line box opens.

4. Specify the Name of the cost line.
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Select the Cost Type.

Select the Cost Nature.

Select the State of the application life cycle.
w The states proposed in the drop-down list are the states of the life
cycle associated with the object life.

Click Next.

The periodic expenses creation dialog box opens.

w  Fijxed expenses, which can be multiple, are defined separately. For
more details on fixed expense creation, see Creating a fixed expense.

Define the periodic cost and click Next.
w  For more details on fixed expense creation, see Modifying a periodic
expense.

Click OK.

The new cost line appears in the Cost Line.

Creating a fixed expense

Fixed expenses associated with a component are accessible from the component
properties pages, in the Costs tab.

To create a new fixed expense on an application from a cost line:

1.

2,
3.
4

6.

Open the application Properties.

Click Costs.

In the Cost Line section, select the cost line that interests you.

In the Fixed Expenses section, the list of fixed expenses associated
with the cost line appears. In this section, click the New button.

The Creation of Expense dialog box opens.

Specify:

e the Name of the expense

e the Date of the expense,

e the Amount of the expense.

Click OK.
The new expense appears in the Fixed Expenses section.

Modifying a periodic expense

To modify characteristics of a periodic expense associated with an application:

Poobd=

Open the application Properties.

Click Costs.

In the Cost Line section, select the cost line that interests you.
Columns specific to the periodic expense are associated with the cost
line:

e Periodic cost

e Periodicity

e Up/Down Amount
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5. Click the column to be modified and enter the new value.

4 Components
Cost Line
+ New rli Reorganize

Local name t

® MEGA BANK Mobile App - Infrastructure

® MEGA BANK Mobile App - License

w [f you indicate a negative amount, at each time period the amount
will be deducted from the periodic cost until this reaches zero.

Scenarios of flows Deployment Architecture Assessment v Cost Decisions Repol
° Remove [Z) Instant Report =z [Z) Instant Report =z [Zh Instant Report
Cost Type Cost Nature State Periodic Cost
Operating Expense Infrastructure Production €70,000.00
Capital Expense Software License Production €40,000.00

Application System Costs

The cost of an application system can be calculated from its different components
or or globally:

When an application used by the application system is specified
"Application", the cost of this application is not charged to the application
system, in other words the cost relates only to the application.

When an application used is specified "Component", the cost of this
application is charged to the application system and is no longer listed on
the application.

To indicate that an application is used by the system as a component:

1.
2,
3.

4,

Open the properties of the application system.

Click Characteristics.

In the Component section, select Application Component to display
applications making up the application system

Select the required application , and in the Aggregation Type column,
select "Component".

Specifying a Currency

At the level of each HOPEX environment the currency used can be specified. The
monetary numeric format adapts as a result.

To modify currency:

1.

2.
3.

In the HOPEX installation folder, double-click the "Administration.exe"
file.

Access your work environment.

Right-click the desired environment and select Options > Modify.
The options window appears.
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4. In the navigator on the left, expand the Installation folder and select

Currency.
5. On the right indicate the currency.
6. Click OK.

The format of costs is modified depending on the specified currency. Note also that
the format of figures depends on the interface language.

Analyzing Application Costs

In HOPEX IT Portfolio Management , a report summarizes the costs of an
application and its deployments. The results are derived from values that you
specified in the cost page of the application and its deployments.

w The report is also available on an application system.

To view the report on costs of an application:

1. Open the properties of the application concerned.

2. Click the Reporting page.

3. In the Reports lits, select IT Portfolio Management > Application
Standard Cost.
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EVALUATING APPLICATION CRITICALITY

Criticality of an application is assessed related to criteria linked with the business,
to functionalities covered and to technologies used. The evaluation of an application
therefore involves different user types. For more details on users, see HOPEX IT
Portfolio Management Profiles.

Assessment can be done:

e in the properties of the applications in question. See Direct Assessment.
e through an evaluation questionnaire sent to the appropriate recipients:
see Assessment By Campaign.

The evaluation is supplemented by result analysis tools.

Application Evaluation Criteria

Evaluation of an application relates to:

e its Business Value enabling evaluation of the nesting level of the
application in enterprise production.

e Level 1: applications are those which have a limited impact on the
company'’s business objectives. Their absence or malfunction generally
does not significantly affect essential business processes. This may
include administrative support applications or individual productivity
tools.

e Level 2: applications are those which have a moderate impact on the
company's business objectives. Their absence or malfunction may lead
to disruptions or slowdowns in certain important business processes.
This may include applications such as human resources management
systems, customer relationship management (CRM) systems or
project management applications.

e Level 3: applications are those which have a significant impact on the
company'’s business objectives. Their absence or malfunction can lead
to significant financial loss or impact on customer satisfaction. This
may include applications such as order management systems,
enterprise resource planning (ERP) systems or operations
management systems.

e Level 4: applications are those which have an extremely high impact
on the company's business objectives. Their absence or malfunction
can have major consequences, such as massive revenue losses,
serious security problems or regulatory non-compliance risks. This can
include central, strategic applications that support essential business
operations.

e its Business Value enabling evaluation of the support level of the
application in enterprise process.

e Level 1: the application provides basic support features and resources
to help users use the application and perform basic business process



Drawing up an Application Inventory
Evaluating Application Criticality

tasks. This may include user guides, integrated tutorials, basic
documentation and self-service support.

Level 2: the application offers specific support for functionalities and
processes linked to the application itself. This may include context-
sensitive help features, task-specific guides, demonstration videos,
user discussion forums or e-mail support to answer application-related
questions.

Level 3: the application provides more in-depth assistance by
integrating support functionalities directly into business processes.
This may include integrated virtual assistants, chatbots or virtual
agents that offer real-time assistance while users perform specific
tasks.

Level 4: the application offers individualized assistance to meet the
specific needs of users and business processes. This can include
consulting services, customized training, tailor-made integrations with
other systems, or direct assistance from a dedicated support team.

w  For more details on businesses addressed and functionalities
covered, see Defining Application Functional Scope.

e its Technological efficiency enabling assessment of evolution
possibilities of the application from the techniques that support it.

Level 1: the application uses technologies that are still under
development or are relatively new to the market. These technologies
may have promising potential, but they may also involve risks and
uncertainties. At this stage, the application can be considered a "proof
of concept" or an experimental prototype.

Level 2: the application incorporates technologies that have been
widely accepted and adopted by the industry. These technologies are
proven and considered more stable and mature. The application can
leverage these technologies to improve functionality and deliver a
better user experience.

Level 3: the application is based on well-established technologies
widely used in the industry. These technologies are stable, mature and
have widespread adoption. They provide a solid, reliable foundation
for the application, enabling optimal performance and easy integration
with other systems.

Level 4: the application explores and adopts the latest technological
advances to stay at the forefront of innovation. This may include the
use of emerging technologies, advanced concepts such as artificial
intelligence, blockchain, machine learning or virtual reality, as well as
modern approaches to development and deployment.

w  For more details on technologies, see Specifying the Technologies
of an Application.

Direct Assessment

You can evaluate an application at precise moments, by creating a new assessment

measure each time.

To create an assessment measure:
1. Open the properties of the application to be evaluated.
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2. Select the Evaluation page.
3. Click the Evaluate button.
The assessment creation window opens.

4. Indicate the value of each criterion as well as the evaluation end date.
From evaluation data, a report allows you to classify applications of the installation

in a matrix and to rapidly identify the applications to be upgraded. See Application
Positioning.

Assessment By Campaign

You can create evaluation campaigns or sessions for applications contained in a
portfolio.

On creation of a campaign, questionnaires are sent to designated respondents to
obtain qualitative estimations on the applications for which they are responsible.

For more details on campaigns and sessions, see Assessment Campaigns in the IRM
solution guide.

Prerequisites for data assessment

Before starting an assessment campaign, you must first prepare the work
environment. Ensure that you have defined respondents for the applications.

Creating an assessment campaign on an application portfolio

To create an assessment campaign:

1. Click the Tools > Assessment Campaigns navigation menu.
2. In the edit area, click + New.
A creation wizard appears.

If necessary modify the name of the campaign.

Select the “Application Assessment - Per Portfolio” Assessment
template.

Specify the Begin Date and the End Date.

Select the portfolio of applications to be evaluated.

Click Next.

Indicate when to send the questionnaires.

Click OK.

A questionnaire is sent to respondents.

o

©oNoGa

Next step: Creating an Assessment Session Manually.

See the chapter “"Managing Assessment Campaigns > Creating an Assessment
Session” in the HOPEX Common Features guide.

166



Drawing up an Application Inventory .
Recording Architecture Decisions

RECORDING ARCHITECTURE DECISIONS

As part of an architecture arbitration, you can record the decisions made about
applications. HOPEX provides a set of predefined decisions: migration, deployment
and investment decisions, as well as a “general” decision type for decisions dealing
with other issues.

You can create a decision directly from the decision types provided, or from a SMART
analysis.

Decisions resulting from SMART analyses are automatically recorded and archived
in the relevant application properties. The Governance page of an application's
properties shows the history of decisions validated manually or through analysis.

Decision Types

HOPEX Provides four decision types:

Cloud Migration Priority (high or low migration priority)
Cloud Migration Type (replatform, repurchase, etc.)
Deployment (accepted or postponed)

General Decision (accepted or not)

TIME Decision (eliminate, invest, migrate or tolerate).

Cloud Migration Type and TIME Decision values can be determined through the
corresponding SMART analyses.

Recording a Decision from a SMART analysis
SMART analyses are a tool for evaluating application portfolios, to support
architecture arbitration decisions.

After evaluating the applications, the analysis provides recommendations that the
user can accept or reject. If accepted, the decision is automatically recorded on the
application.

For more information on SMART Analyses see SMART Analyses.

Entering a Decision on an Application

For migration or deployment decisions, the decision title is clearly defined by its
type, e.g. “Cloud Migration Priority”, with its value ("High” or “Low").
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For “general” decisions, a description should be entered in the form of a question,
e.g. “Maintain budget allocation?”, to which the chosen value (“Yes” or “No”) will
be applied.

~ Decisions

+ New CZ Reorganize [E) Instant Report 4

Date Decision Type Decision Value Description
& 1212/ € Cloud Migration Priority High Priority
J 1212/2... 0 General Decision Yes Maintain budget allocation?

To enter a decision on an application:
1. Open the application properties.
2. Click the Governance page.
w If the page is hidden by default, click the Show/Hide button and
select Governance.
3. Click the New button.
The decision creation window opens.
4. In the Comment field, enter a description.
5. Select the type of resolution and its value, e.g. “Cloud Migration Priority:
High Priority”.
6. Click OK.
The decision appears with its date, type and value.
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LIST OF ANALYSIS REPORTS AVAILABLE ON APPLICATIONS
AND APPLICATION SYSTEMS

HOPEX IT Portfolio Management provides predefined report templates that are
used to analyze the applications of your repository from different angles.

w  For detailed information on reports, see Generating Reports.

Application and Application System Embedded Reports

The “IT Portfolio Management” reports available for an application or an application
system are:

e Application / Application System Standard Cost: presents the
detailed costs of an application or an application system. See Analyzing
Application Costs.

e Gantt Chart and Gantt Chart with Conflicts: displays the lifeline of
the application / the application system and any conflicts in its
deployments. See Analyzing Application Life Cycle and Installations.

e Environment Graph: provides a graphical view of the environment of
the application / application system in terms of data flow, deployments,
functional scope. See Application Environment Graph of an application.

e Application Overview: presents a summary of the information
specified for the application or application system.

e Software Data Lineage Impact Report: allows you to visualize the
data used by an application and measure the impact between the
application and the data. See Analyzing Impact between an Application
and the Data it Uses.

Reports Applicable to a Set of Applications

Reports

You can generate reports on a selection of applications:
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Inventory

Application Overall State: shows the current state of applications in
their lifecycle (in preparation, in production, etc.)

Applications by Age: shows a graphical breakdown of applications by
age.

Business Capability Map Breakdown: allows you to visualize the
applications that cover the components of a business capability map.
See Generating the Business Capability Map of a Portfolio.

Functionality Map Breakdown: shows the applications associated with
a functionality map.

Obsolescence

Application Obsolescence : displays applications entering the
retirement phase and applications using technology entering the
obsolescence phase.

Technology Obsolescence Remediation. See Obsolescence Risk and
Remediation.

Rationalization

Cost

Instant reports

Decommissioning Plan. See Application decommissioning plan report.
Business Capability Coverage over Time. See Business Capability
Coverage over Time.

Business Capabilities Tree Map: displays a hierarchy of business
capabilities according to three possible criteria: number of applications,
ratio of applications, cost of applications.

See Business Capabilities Tree Map.

Functionalities Tree Map

Top 10 most expensive applications
Application Total Cost

Instant reports provide statistical graphic analysis of the data. You can generate
instant reports on a selection of applications in order to view certain data graphically
(for example, their exchanges) or to compare the applications for specific
characteristics (for example, costs).

To launch an instant report on a set of applications:

1.

2,
3.
4,

See also:

Click the Applications navigation menu.

In the edit area, select the applications in question.

Click the Instant Report button.

Select the type of report to create and then, if necessary, the application
data to be analyzed.

For example, to display a histogram of application costs,
select a "Quantitative" type report then select the "Cost"
attribute.

Managing Instant Reports.
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Application Exchange Graph for a set of applications.
Application portfolio reports

It is possible to analyze a set of applications within a portfolio. See Portfolio Analysis
Reports.
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DRAWING UP A TECHNOLOGY INVENTORY

Similarly to applications, HOPEX IT Portfolio Management enables to draw up an inventory of
available technologies and to collect information according to different criteria.

The following points are covered here:

NENENENENENENEN

Defining and Validating Technologies

Importing Technologies from BDNA
Inventorying Technologies with ITMC Discovery
Importing Technologies from IT-Pedia
Distinguishing Applications from Technologies
Defining Technology Life

Managing Deployments of Technologies
Managing Costs of Technologies
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DEFINING AND VALIDATING TECHNOLOGIES

Technologies associated with applications can be created and validated by the
enterprise architect or EA functional administrator.

Validation of technologies is assured by workflows. See Technology Validation
Workflow.

Creating a Technology

Technologies are visible under the Technologies navigation menu in the HOPEX
Enterprise Architecture desktop. You can filter their display:
e All technologies of the repository
e Technologies of the connected user portfolio
e Technologies outside portfolio (those not belonging to any inventory
portfolio)
Technologies to be validated
etc.

To create a technology:

Click the Technologies navigation menu.
In the edit area, select All technologies.
Click the New button.

In the dialog box that appears, indicate:

e jts name

e the vendor

5. Click OK.

When a technology is created in HOPEX IT Portfolio Management, a workflow is
automatically started. Validation determines the Company Standard attribute.
See Validating a Technology.

PoObd=

See also:
Importing Technologies from BDNA.

Importing Technologies from IT-Pedia.
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Defining Technology Properties

To access technology properties:
) In the list of repository technologies, select the required technology and

click the associated Properties button. =
The Properties window displays the following pages.

m  Some pages may be hidden by default. Click the ¢ button to
display them.

Overview

The Overview page presents indicators on the technology:

e The Company Standard : indicates the organization policy regarding
the use of technology. See Validating a Technology.

e Obsolescence Risk: its value is a function of the interval time between
the current date and the technology's end-of-support date (or extended
end-of-support date). The shorter the interval, the higher the risk. See
below for how to calculate its value.

Obsolescence risk Calculation
The following are taken into account in the calculation, in order of priority:

1. End-of-life Date.
If the end-of-life date is “Indefinite”, then the obsolescence risk is “Very
low”.

2. End-of-support dates
If there is no end-of-support date, extended end-of-support or end-of-
life:
e If one of these dates is “"Expired”, the obsolescence risk is “Very high”.
e If one of these dates is "Not Applicable”, the risk of obsolescence is

“Very low”.

e Otherwise, the indicator value is *Unknown”.

3. The interval between the current date and the support end date:

Interval current date / end Obsolescence risk .
Indicator Color
of support level
Less than 12 months Very high -
Between 12 and 24 months High
Between 24 and 30 months Medium
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Interval current date / end

Obsolescence risk

Indicator Color

of support level

Between 30 and 36 months Low

More than 36 months Very Low

Unknown Unknown Gray

See also: Defining Technology Life.

Characteristics

In the Characteristics page you can specifying:

e Identification of the technology:
e the Name of the technology

e the internal Code
e the Vendor

e The Company standard: this attribute indicates the organization
policy regarding the usage of a technology or technologies of a vendor.

w  See also Validating a Technology.

e a Comment.

e the Official Life Cycle of the technology, with its publication and

support end dates.

w The end of support date can be imported from BDNA or IT-Pedia, or

specified manually See Defining Technology Life.

See also: Support Alert Report.

e the Classification:

¢ Fulfilled Technology Capability

A technology capability is the ability to deliver a technology service
which is required by a technology artifact or an application.

e Responsibility: this is the person or persons responsible for the

technology:

e the management controller responsible for financial aspects of the

technology

e the local correspondent who is the main referrer for the technology

w This business role is not associated with a specific desktop.

e Gantt Chart presenting the technology life cycle. This is the life cycle
within the organization; it can differ from the official life cycle specified

by the supplier.

For more information on the object life cycle and its Gantt chart, see
Viewing Application Life (Gantt Chart).

For more information on the technology official life cycle, see BDNA

properties in HOPEX.

e associated Attachments.




Installation
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See Managing Deployments of Technologies.

Version
See Managing Deployments of Technologies.

Application
This page allows you to connect the technology to existing applications. For each
application you can indicate:

e Total expenses for the year

e Capital expenditure (CAPEX)

e Operating expenses (OPEX)

Cost
In this page you can define costs linked to the technology. The definition of costs of
a technology is the same as for an application. See Managing Application and
Application System Costs.
The “Costs Report” summarizes the costs of the technology.
Reports
The Reports page accesses analysis reports available on the technology.
w  For detailed information on reports, see Generating Reports.

e Technology Standard Cost: summarizes technology costs, by cost
nature and by year.

e Technology Overview: summarize the main characteristics of the
technology.

e Gantt Chart: displays technology life cycle steps. See Defining
Technology Life.

e Gantt Chart with Conflicts: this report presents possible conflicts
between the technology life cycle and the life cycle of the applications
that use it.

¢ Realization Graph Report: shows which elements of the dictionary the
technology implements.

BDNA
This page displays properties imported from BDNA. See Displaying BDNA properties
in HOPEX.
See also Importing Technologies from BDNA.

IT-Pedia

This page displays properties imported from IT-Pedia. See Importing Technologies
from IT-Pedia.
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Validating a Technology

Directly on a technology

To validate a technology:
1. Click the Technologies navigation menu.
2. Display the Technologies list.
3. Click the icon of the technology to be validated and select Assessment
of the Technology > Define the technology as Accepted.

The Expected command also validates the technology, but in a more pronounced
way, since it specifies that it is an expectation.

Company standard (calculated)

The Company standard attribute indicates the organization policy regarding the
usage of a technology or technologies of a vendor. This attribute, visible in the
technology characteristics, is modified depending on the validation workflow.

It can take the following values:

e Approved
e Accept

e Forbidden
e Unknown

If a technology belongs to a "prohibited" or "unknown"supplier, it automatically
takes the same value.

On demand

The portfolio manager can ask the local correspondent to validate a technology. To
do so, a local correspondent must have been specified in the technology's
properties.

Outside the workflow he/she can also request financial validation from the Financial
Controller responsible for this technology.

Defining a Technology Stack

A technology stack makes up a technology grouping.
It is obsolete when one of the technologies that it contains is obsolete.

It can be associated with applications.

Creating a technology stack

To define a technology stack:

1. In the desktop, click the navigation menu then Inventories >
Technologies > Technology Stacks.
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2. In the edit area, click New.

The technology stack creation dialog box appears.
3. Enter the name of the technology stack and an owner if necessary.
4. Click OK.

Specifying its properties

To specify the properties of the technology stack created:

) Click the technology stack to display its properties.

Among information you can specify:

its characteristics: identification, support alert, company standard.
its components (technologies)
its life cycle
its owner
related applications

See also Defining Technology Properties.

Support alert

The Support Alert attribute available on each technology compares the official life
cycle of a technology (imported from BDNA or defined manually) with its life cycle
in the organization.

On a technology stack, the value of this attribute is calculated using the values
defined for the technologies that it contains.
e If one of the technologies that it contains is "Not Supported”, the support
alert for the stack is "Not Supported".
e Otherwise, if one of the technologies that the pile contains is “"Delayed
Use”, the support alert for the stack is "Delayed Use".
e Otherwise, if one of the technologies that the pile contains is “Early Use”,
the support alert for the stack is "Early Use".
e Otherwise, the support alert for the stack is "Supported".

Company standard (computed)

The Company Standard attribute indicates the organization policy regarding the
usage of a technology.

w  See Validating a Technology.
This attribute can take values:

e Approved
e Accept

e Forbidden
e Unknown
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On a technology stack, the value of the Computed Company Standard attribute
is calculated using the values defined for the technologies that the technology stack
contains.
e If one of the technologies the stack contains is "Forbidden", the
Computed Company Standard is "Forbidden".
e Otherwise, if one of the technologies the stack contains is "Unknown",
the Computed Company Standard is "Unknown".
e Otherwise, if one of the technologies the stack contains is "Accepted",
the Computed Company Standard is "Accepted".
e Otherwise, the computed Company Standard is "Approved".

This computed value is providing a reference only. The director of the technology
can define a different value for the Company Standard attribute for the technology
stack.

Conflicts between a technology stack and its components

The “Gantt chart with conflicts” report is used to view any conflicts between the life
cycle of a technology stack and those of the technologies that it contains.

To display this report:
1. Open the properties of the technology stack.
2. Select the page Reporting > IT Portfolio Management > Gantt
Chart with Conflicts.
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IMPORTING TECHNOLOGIES FROM BDNA

BDNA™ is a large repository of technology market information. It provides an up-
to-date IT reference catalog of software and hardware information. HOPEX IT
Portfolio Management provides an integration tool with BDNA™, allowing
Enterprise Architects and Technology Portfolio Managers to take full benefit of this
information and make more accurate decisions on their IT asset.

With the BDNA Connector you can:

e Import new technologies (as well as technology types and vendors)
e Align BDNA technologies with existing technologies of your repository
e update technologies imported in your repository

Presentation of the BDNA Connector

Use Case in HOPEX ITPM

In ITPM solution, the BDNA Connector is available to the Functional Administrator.
He is in charge of importing data from BDNA. He/she can initialize a new repository
by importing software technologies from BDNA and use the Administration Desktop
to manage automatic update workflows and alert tools.

The Technology Portfolio Manager (TPM) is responsible for software technologies
and their life cycle. He can include his software technologies in the scope of the
automatic update in order to be notified automatically of any changes. He can also
send the Functional Administrator a request to prepare the import of new software
technologies from BDNA.

The Application Portfolio Manager should subscribe to the standard notification on
sensitive software technologies that are used by his applications. Thus, when these
software technologies are updated by automatic or manual import from BDNA
properties, he will receive a notification of the change. He will analyze the impact
and decide how to proceed (keep the software technology, use a new version or
change it).

Prerequisite Conditions

The BDNA Connector is available with HOPEX IT Portfolio Management and
requires the BDNA license that you will specify in the authentication settings.

To be able to connect BDNA, you must set the Data Exchange options related to
exchanges between HOPEX and third party tools.

To define the required options:
1. Start HOPEX Administration.
2. In the navigation tree, right-click the HOPEX site name and select
Options > Modify.
The site options window opens.
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Expand the Data Exchange > Import folder.
Click the BDNA folder.
In the right pane of the options window, enter information to access

BDNA APIs (provided by BDNA). These are the options visible under
Activate BDNA:

URL address of the BDNA API: this is the URL of BDNA public
catalog. The HTTP protocol is used by default but to secure the
exchanges you can use the HTTPS protocol by entering it directly in
the option.

Authentication user for the BDNA API: BDNA user
Authentication key for the BDNA API: password

6. Activate SMTP proxy if necessary (provided by your IT service):

Check the Authentication for the proxy option if required.
Enter the address of the proxy.
Enter the port.

7. Check the Authentication for the proxy option if required.

Scope of BDNA Connector

Within the context of the technology management in ITPM, the BDNA Connector
enables import of the following concepts:
e Technology types: categorizes software products by the function they
perform.
e vendors. Example: Microsoft

Software technologies. Example: MS Office

Mappings with HOPEX concepts are detailed below.

Object correspondence

BDNA HOPEX

Manufacturer (vendor) Org Unit

Taxonomy (technology type) _Type

Software Product Technology

Software Edition Variation of Software Technology
Software Standard Major/Minor Release Variation of Software Technology

In BDNA,

Only versi

software technologies are divided into:
Products (for example: Microsoft Office)
Editions (for example: Family, Professional)
Versions (for example: 2013, 2016)
Releases (major, minor)

ons and releases have information on the life cycle (publication date, end

support, end of extended support).
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Software Products imported from BDNA Technopedia™ into HOPEX are saved as
Software Technologies. Editions and versions of a software are represented by
variations of the Software Technology in MEGA.

Software Technology

—— Software Technalogy 1.0
\— Software Technology 1.1

L Software Technology 2.0

Importing new Objects from BDNA

Objects you can import from BDNA are:
e Technology types
e Vendors
e Technologies

Data import is carried out by the functional administrator.

To import data with the BDNA Connector:
1. Connect to ITPM as a Functional Administrator.
2. In the desktop, click the navigation menu then Tools > BDNA.
3. The edit window displays the following tiles:
e BDNA technology types
e BDNA vendors
e BDNA technologies

Technology types
Importing technology types implies import of all technology types of the BDNA
repository.

To import technology types:
1. Click the Tools > BDNA Technology Types navigation menu.

2. Click Import.
The list of technology types appears in the Technology Types folder.

Vendors

You can search vendors to be imported by name, specifying where applicable the
Industry and Owner.

The import wizard displays the search results and prompts you to select the vendors
to be imported from among the list displayed.
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The Direct Creation option speeds up the import by eliminating this intermediate
stage that lists and displays the vendors found; it creates the vendors found by the
wizard directly, without prior validation.

To import a vendor:
1. Click the Tools > BDNA Vendors navigation menu.
2. In the edit area, click the Import button.
You can search a vendor by specifying:

e the name (or a part of the name) of the Vendor.
Under the Advanced options, you can specify:

e The Industry within which a vendor belongs, based on the majority of
their products.
e The Owner of the vendor. For example, Microsoft is now the owner of
Skype.
e The Tier: categorization of vendors based on priority/importance. For
example level 1: well-known vendors.
w  Direct Creation: check this option if you want to ignore the results
display and directly create the technologies found.
3. Click Next.
The wizard displays the search results.
Select from the list the vendors you want to import.
(Optional) At this stage you can merge a vendor to be imported with a
vendor of your repository. To do that, click the Matching Vendor in
HOPEX column and select the vendor of your repository that
corresponds to the vendor to be imported.
w The existing vendor is maintained in the repository. In its

properties you can see the ID as well as the BDNA Name of the vendor
to which it corresponds. See also Merging technologies at BDNA import.

Click Next.

Select the import option:

* Now

e As soon as possible: execute the import after saving updates
e Scheduled: execute the import at the date and time specified
8. Click Import.

The imported vendors are shown in the edit area.

ok

No

Technologies

You can search software technologies to be imported by:
e their name
e the type of technology and the vendor.

The import wizard displays the search results and prompts you to select the
technologies to be imported from among the list displayed.

The Direct Creation option speeds up the import by eliminating this intermediate
stage that lists and displays the technologies found; it creates the technologies
found by the wizard directly, without prior validation.

Note that when importing minor technologies, the tool also imports the major
versions from which they are derived.

184



Drawing up a Technology Inventory
Importing Technologies from BDNA

Searching by name

To find a technology using its name:
1. Click the Tools > BDNA Software Technologies navigation menu.
2. Click Import.

3. Select the Import Software technologies by name query mode and
click Next.

4. Complete the following fields:

e Software Technology Name (enter the name or a part of the name)

e Technology Version

e Software Version Group (year)

Under the Advanced options, you can specify if it is:

e A minor or major version

e A technology suite

e A licensable technology
w Direct Creation : check this option if you want to ignore the
results display and directly create the found technologies.

5. Click Next.

The wizard displays the search results.

6. Select from the list the technologies you want to import.

7. (Optional) At this stage you can merge a technology to be imported with
a technology of your repository. To do that, click the Matching
Software Technology in HOPEX column and select the technology of
your repository that corresponds to the technology to be imported.

w  For more details, see Merging technologies at BDNA import.

BDNA Software Import - BDNA Import preview E @

B Excel ) Instant Report Y Display filters
ay

n‘lﬂ MR e e .I

e W

Ik Connect Software Technology...

AppManager for Citnix... V.. IT Asset Maintenanc. AppM._..
8. Click Next.
9. Select the import option:
* Now

e As soon as possible: execute the import after saving updates

e Scheduled: execute the import at the date and time specified
10. Click Import.

Searching by the type of technology and the vendor

To find a technology using its type and vendor:
1. Click the Tools > BDNA Software Technologies navigation menu.
2. Click Import.
3. Select the Import Software technologies by selecting technology
types and vendors query mode and click Next.
4. Select the technology type.
5. Click Next.
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Select the vendor.

Click Next.

8. If necessary, filter the technologies by name.

w Direct Creation : check this option if you want to ignore the
results display and directly create the found technologies.

9. Click Next.

The wizard displays the search results.

10. Select from the list the technologies you want to import.

11. (Optional) At this stage you can merge a technology to be imported with
a technology of your repository. To do that, click the Matching
Software Technology in HOPEX column and select the technology of
your repository that corresponds to the technology to be imported.

12. Click Next.

13. Select the import option:

e Now

e As soon as possible: execute the import after saving updates

e Scheduled: execute the import at the date and time specified
14. Click Import.

No

Filtering the display of technologies

You have the possibility to filter the display of technologies according to:

e Root technologies imported from BDNA: these are the technologies in
their first functional version, for which new versions may exist.

e All technologies imported from BDNA

e Technologies not imported from BDNA

Home / Tools / BDNA < |

BA All Technologies imported from BDNA A M

I BB Root Technologies imported from BDMA -

m All Technologies imported from BDNA

BB Technologies not imported from BDNA
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Note that additional commands appear when selecting technologies.

w (Click % to access hidden commands.

Home / Tools / BDNA / BDNA So =
echno OQIES \mpor e rom v mport paate emove or ow v nstan eporf H
All Technol ted f BDNA 1 t ) Updat R + Workfl Instant Report :
E
H E roperties
.
O BB .NET Data Collector - 7.3 85390520 & Follow
FE .NET Data Collector 82188402 B Excel
7 . ® 1 selected
O M 2 BrassRing - 12.0 252167682 6/3/2009 4 1 selecte;
- . Y Display filters
- m 2x BrassRing - 12.0 252452548
O B 2x erassRing 252167571
O BA 322-bit SDK for WebSphere Business Integration Ad... 1241741
See also:

Updating BDNA Objects Imported into HOPEX.

Merging BDNA technologies with existing technologies of your repository

Displaying BDNA properties in HOPEX

Most of BDNA properties imported into HOPEX appear in the BDNA property page
of the object concerned (software technology, technology type or vendor).

Overview Characteristics BDNA Reporting Workflows o Versions v

§ Manage sections

BODNA Identifier

1732882

~  Software Information

BDNA Identifier Name in BONA Version Group
1732882 NET Framework Language Pack - 3.5 3
Vendor Taxonomy
Microsoft > Platforms >
Is Licensable
Is Suite Is Major Version
No
Yes

~  Version Information

Version Sub Version

35

Release Level Patch Level
Version v
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Technology properties related to the official technology life cycle are automatically
defined in the Characteristics page of the technology properties.

e Release date
e End of Support
e End of Extended Support

w These properties can be specified manually if you do not use the
BDNA Connector

Owerview Characteristics BDNA Reporting Workflows a Versions W .

~ Identification
~ Responsibility

~  Life Cycle

Delete Object Life

Start Date Envisioning - End Date Emerging - End Date Confirmed - End Date OCbsolete - End Date

4/3/2007 9/4/2008 2/e/2010 7ha/zom 1213/2012

A Support Alert report uses this data to track technology obsolescence. For
example, the solution automatically detects current and future conflicts when an
underlying technology component becomes obsolete while the business application
is still in production.

See Support Alert report.

Merging BDNA technologies with existing technologies of your
repository

Your repository may contain technologies created outside of the BDNA import.
These technologies do not benefit from the provider data and updates supplied by
the BDNA connector, such as official life cycle dates, for example. To keep the data
for these technologies while benefiting from BDNA information, you can merge them
with the BDNA technologies that you import in HOPEX IT Portfolio Management.

You can merge technologies in three different ways:

e By merging the technologies (BDNA and non-BDNA) already contained in
your repository case by case

e By specifying, during the import of BDNA technologies, those that
correspond to technologies existing in your repository

e By specifying the BDNA identifier in the technology's properties

Merging two technologies in HOPEX

To merge two technologies:
1. Click the Technologies navigation menu.
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2. In the edit area, select the technologies to merge.

3. In the list menu bar, click More s Technologies .

ome / Technologies € | € Back

EB Al Technologies ) New (*) Remove { = Workflow ~ [Zh Instant Repert : 2 selected

H T Creme opjeas e

B -NET Data Collector - 7.3 = Merge Technologies

4. In the wizard that appears, enter:
e The source technology, which will be merged in the target technology
e The target technology, which will include information of the source
technology.
5. Click Next.
6. Select the properties you want to keep from the source and target
technologies. By default, properties of the target technology are

selected.
7. In the same way, select the links you want to keep.
8. Click OK.

Merging technologies at BDNA import

When you import technologies in your HOPEX repository, you can merge them with
technologies already present in your repository. The technologies merged in this
way are identified as BDNA technologies and can subsequently be updated as such.

In the same way, you can merge vendors.

Example of merged technologies

You want to import the "TX Controller V1.15" technology that corresponds to the
"Skype control" technology in your repository.
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Once the technologies are merged, the existing technology, "Skype control", is kept
in your repository. In its properties you can see the ID as well as the BDNA Name
of the technology to which it corresponds: "TX Controller V1.15".

MEGA_Technology

ER BDNA v

BDNA Release Level: Version

—  Software Information

BDNA Identifier: 193483211

BDNA Name: HOPEX-13

The "TX Controller" version has also been imported. This is the major version of "TX
Controller”, from which the imported version is derived. In its properties, in the
Version page, you can see the different versions of this technology that exist in

your repository.

FE | | Version & Installation +

—  Software Technology Version

® New B3 Excel =

. Seployment Dete

FE skype control

E T Controller

For more details on how to merge technologies and vendors at import, see
Importing new Objects from BDNA.

Modifying the BDNA Identifier of a technology in HOPEX

To define a technology as a BDNA technology, you can manually specify its BDNA
identifier.

To specify a BDNA identifier:
1. Select the technology in question.
2. Click the associated Properties button.
The properties of the technology appear.

3. Select the BDNA page.
4. In the Identifier field, enter the BDNA identifier number.
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See also: Updating BDNA Objects Imported into HOPEX.

Updating BDNA Objects Imported into HOPEX

At any time you can update information available on software technologies and
vendors imported into HOPEX.

To do so:

1. In the BDNA navigation pane, click BDNA Vendors or BDNA
Technologies , depending on the objects you want to update.
2. Select the object and click the Update button.

w [f necessary, click it display the hidden commands.

You can also define an automatic update.

Technology Automatic Updating and Alerts

Automatic update checks, at a given frequency, whether properties of software
technologies imported into HOPEX have changed in the BDNA repository, and if so,
carries these updates over to the corresponding technologies in HOPEX.

Defining Update Frequency

To activate an automatic update, you must create a trigger in the administration tool
which implements the BDNA Automatic Update macro.

Once the trigger is created, you can plan the update in ITPM.

To create a trigger:

Open the Administration module.

Open the environment.

Expand the repository folder concerned.

Right-click Scheduler and select Manage Triggers.

Click the Triggers Definitions tab.

Click the New button to create a trigger definition.

In the wizard, create a job definition that implements the macro "BDNA
Automatic Update Job Implementation”.

8. Complete the planning.

9. Click Finish.

Noakrwh=

To define automatic update on technologies:

1. Connect to ITPM as a Functional Administrator.
2. Click the navigation menu, then Administration.
3. Select the Scheduling Management navigation pane.
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4. In the edit window, click BDNA Automatic Update.
You can set the alert:

e Daily
o Weekly
e Monthly

Subscribing to Alerts

A user can be notified of updates made on the technologies he is in charge of.

To subscribe to an alert:
1. In the edit window, display the list of technologies.

2. Select the technology concerned and click the Follow 2 button.

w  For more details on alerts, see the HOPEX Common Features guide,
chapter "Communicating in HOPEX", section "Threads of Posts and
Alerts on Objects”.

Support Alert Report

A Support Alert MetaAtribute available on each technology compares the
technology life cycle (imported from BDNA or defined manually) with its life cycle in
the organization.
w  For more information on technology life, see Defining Technology
Life.
The Software Technology Support Alert report, available in the technology
portfolio properties, uses the Support Alert attribute to analyze the technologies
in the HOPEX repository and detect any conflicts between their use in the
organization and their official lifecycle.
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INVENTORYING TECHNOLOGIES WITH ITMC DISCOVERY

Eracent's ITMC Discovery™ tool provides automated discovery of an organization's
on-premises technologies and applications.

The data collected is stored in a local Eracent database. You can import this data
into your HOPEX repository through a Java job.

Once the technologies are created in HOPEX, you can import their life cycle from IT-
Pedia. This is the normalization phase.

w The HOPEX IT-Pedia connector allows you to directly import
technologies with their life cycle, without going through the ITMC
Discovery tool. The normalization of technologies is done automatically.
See Importing Technologies from IT-Pedia. See Importing Technologies
from IT-Pedia.

Installation of the Module

Before you can use the Eracent Discovery tool, you must complete the following

steps:

1.
2,

Install JAVA Standard Edition 8 or higher.

In case HOPEX is hosted on a server with a self-signed or internally
signed SSL certificate, you need to add this certificate manually to your
JAVA trust store:

First you must obtain the public certificate from the server where
HOPEX is installed. You can request it from the server administrator or
view it in any browser by visiting the HOPEX security information Web
page and saving a copy of the certificate.

Save the certificate in a file (.cer).

Add it to your Java Virtual Machine (JVM) truststore.

w In the $JAVA_HOME/jre/lib/security/ folder (for JREs) or the
$JAVA_HOME/lib/security folder (for JDKs), a file named "cacerts"
provided with Java contains the public certificates.

To import the new certification, run the keytool as a user with
permission to write to the cacerts file:

keytool -import -file <the cert file> -alias <any name> -
keystore <path to cacerts file>

You may be asked for a password. The default password supplied with
Java is “changeit”.

In case Eracent is hosted on a server with a self-signed or internally
signed SSL certificate, you must add this certificate manually to your
JAVA trust store:

You need to obtain the public certificate from the server where Eracent
is installed. You can request it from the server administrator or get it
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from any browser by displaying an Eracent security information web
page, and saving a copy of the certificate.
e Once you have saved the certificate to a file (.cer), you need to add it
to the trust list of your JVM.
w In $JAVA_HOME/jre/lib/security/ for JREs or $JAVA_HOME/lib/

security for JDKs, a file named “cacerts” which comes with Java contains
the public certificates.

e To import the new certification, run keytool as a user with write
permission to the "cacerts" file:
keytool -import -file <the cert file> -alias <any name> -
keystore <path to cacerts file>

e You may be asked for a password. The default password, as provided
with Java, is "changeit"

4. Go to the HOPEX HAS console and generate an API Key used to
authenticate to HOPEX:
¢ Go to Modules -> Authentication - > Api Keys -> Create.
e In the form, choose an "Open Session" and fill out the other input
fields with your user HOPEX parameters.

5. Go to the module installation folder in CONF/mega.properties and copy/
paste the generated key in the api_key property.

6. Launch the batch file
\EXE\EracentToHopex_Sequence\EracentToHopex_Sequence_run.ba
t to run the discovery tool:

##Connection to HOPEX website##

Hopex host==

Hopex URL _ query==HOPEXGraphQL/api/ITEM
api key==

##Connexion to Eracent server##

Eracent host==

Eracent_endpoint installed software==/Discovery/vl/InstalledSoftware/
Eracent_user==

Eracent_mdp==

Eracent_top==100

##Run parameters##

##Possibilities : version, main version, product
import_type==version
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Structure of the module

The structure presents the following folders:

COMF
EXE

LOG
ouTPUT
SRC
TEMP

CONF

This folder contains:
e The context file (variables to be filled by the user to run the process on
his machine)
e The file Types.csv, which contains the technology types from Eracent to
load into HOPEX
e The file Functions.csv, which contains the functions from Eracent to load
into HOPEX.

Set the configuration before running the .bat file. In the Types.csv and
Functions.csv files, in the "Import" column, enter 1 to load the type or function into
HOPEX, 0 otherwise.

See Configuration.

EXE

This folder contains the zip file that contains the .bat files you must run to get data
from Eracent and load them into Hopex.

See Retrieving Data Collected by ITMC Discovery.

LOG
This folder contains the logs files which are created every time you launch the .bat.

List of log files you can find in this folder:
e |og_dateOfTheDay.csv: the files with steps of the execution, errors
included
Hopex_requests.csv: all the requests sent to HOPEX
errors_WS_Hopex.csv: all the errors from HOPEX POST requests
e errors_response_Hopex.csv: the responses from HOPEX with code 200
which contains errors.
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OUTPUT

This folder contains the files used as history of each object already loaded into
HOPEX (Publisher_history.csv, Product_history.csv, Version_history.csv). When an
object (Technology, Vendor, etc.) has been loaded into HOPEX, it appears with its
idabs in the corresponding file. This history ensures that objects already transferred
to HOPEX are not altered (renamed, deleted).

If you try to re-import a scanned object after deleting it from HOPEX, it will not be
imported as long as it is present in the history file. The object must therefore be
manually removed from the history file before it can be re-imported into HOPEX.

SRC

This folder contains the .zip file which is the Talend project that can be imported into
Talend to be modified.

TEMP

This folder contains all the temporary files used during the execution.

Configuration

The folder CONF contains three files with a set of properties to configure the
Discovery tool:

Technical Configuration (mega.properties): a text file that contains a set
of connection properties to be defined to launch the tool.

##Connection to HOPEX website##

Hopex host=={paste here the URL where Hopex is hosted }
Hopex URL query==HOPEXGraphQL/api/ITPM

api key=={paste here the api key generated in the section
I.2}

##Connexion to Eracent server##

Eracent host=={paste here the URL where Eracent server is
hosted }

Eracent endpoint installed software==/Discovery/vl/
InstalledSoftware/

Eracent user=={paste here the username of the user who has
access to the Eracent server }

Eracent mdp=={paste here the password of the user who has
access to the Eracent server }

Eracent top=={Eracent network response package size (in
number of technologies) - default value = 100 - does not
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affect the number of item retrieved, only the size of the
network query response packages}

##Run parameters##

##Possibilities : version, main version, product
import type=={Select one of the possibilities above to
choose the type of technology you want to import }

e Type file (Types.csv): a table of all technology types that can be
imported from Eracent to the HOPEX repository.

Type Import
User Defined
Licensable Not Detect
Licensable
Unassigned

Mot Licensable
Unauthorized
Unknown

Child

Driver

Patch

Licensable Fonts
Obsolete

o O O QO QO e O e e e

For each type, enter 1 to load all technology of this type into Hopex, and
0 if you want to ignore the technologies of this type.

e Function file (Function.csv): in this file you can filter technologies so that
they are not imported into HOPEX, based on their source Function, and
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you can define an HOPEX Technological Functionality for the imported
technologies.

The column "Function" lists the technical functionalities that exist in
Eracent.

The column “Technical_Functionality” indicates the corresponding
technical functionalities in HOPEX.

Function Technical_Functionality Import

Unassigned 0
Operating System Platform 1
Office Suite Desktop tools 1
Word Processing Desktop tools 1
Spreadsheet Desktop tools 1
Database 0

You can filter the technologies you want to import from Eracent into
HOPEX based on these Functions: enter "1" in the "Import" cell to import
the Eracent technologies with the given Function, "0" otherwise.

Upon import, the HOPEX Technical Functionality input in the
“Technical_Functionality” column will be linked to all imported
technologies with the matching Eracent Function specified in the Function
Column. If no Technical Functionality is specified, no Technical
Functionality will be linked to the imported technology.

Retrieving Data Collected by ITMC Discovery

In the EXE folder of the module installation are the .bat files to be executed to get
the data from Eracent and load them into HOPEX:

GetDataFromEracent_run.bat: to retrieve the data stored in the Eracent
database.
GetDataFromHopex_run.bat: to import the data into HOPEX.
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IMPORTING TECHNOLOGIES FROM IT-PEDIA

IT-Pedia™, from Eracent, is an extensive catalog of existing technologies that
includes up-to-date information on computer software and hardware.

HOPEX provides an integration module with Eracent IT-Pedia to monitor technology
obsolescence. It allows Enterprise Architects and Technology Portfolio Managers to
make informed decisions about the evolution of their IT portfolio.

With the IT-Pedia connector you can:

e import new technologies
e align IT-Pedia technologies with existing technologies of your repository
e update information on technologies imported into HOPEX.

Prerequisite Conditions

The IT-Pedia connector is available as a module. You can install it in HOPEX IT
Portfolio Management and HOPEX IT Business Management.

w  For more details on importing a module, see Importing a Module
into HOPEX.

Communication and protocols
HOPEX connects to IT-Pedia using the java command: HttpURLConnection.
The server hosting HOPEX must have an active Internet connection.
HOPEX must have the right to establish outgoing connections.
The protocol used is HTTPS (standard port = 443).

Any firewalls must allow this connection to pass through.

Connection options to IT-Pedia

After installing the module, before you can import content from IT-Pedia, you must
authorize exchanges with IT-Pedia in HOPEX.

To set the required import options :

1. Open the Administration desktop.

2. In the edit area, click Environment Options.
The environment options window opens.

3. In the navigation tree, click Tools > Data Exchange> Import > IT-
Pedia.

4. In the right pane of the options window, enter information to access IT-
Pedia (provided by Eracent):
e IT-Pedia URL address: this is the URL of IT-Pedia public catalog.
e IT-Pedia API user
e IT-Pedia API password
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Eracent APIs are available at the following address: https://itpedia.eracent.com/
API/.

Initializing the list of your technologies in IT-Pedia

Before using the IT-Pedia connector, you must initialize the list of technologies in
your repository in IT-Pedia for standardization. This initialization is done through a

macro.

w Therafter you can standardize the technologies in your repository
with the Refresh command in the IT-Pedia connector. See Normalizing
Technologies.

To launch the macro:

1. Log into HOPEX (Windows Front-End) as Hopex Customizer.
2. Launch the initialization macro ~kKAycUFMZzWCIIT Pedia V3 - Initialize

my Products from Hopex Repository].

O

File Edit View Execute Help

MXxGE A O%BS O
'MegaContext (Fields,Types)

'Uses (Components)

Option Explicit

Sub MainRoot (mgRoot)
mgRoot . print ("Initialize my Products from Hopex Repository")
Dim oMacro : Bet oMacro = mgRoot.CurrentEnvironn

Dim meSoftwaretechnologies @ set meSoftwaretechnologies = mgRoot.GetCollection(
Dim sResultModels : sResultModels = ocMacro.AddModels (meSoftwaretechnologies)

mgRoot . print ("Done ... 1")
End Sub

After the macro is launched, the My Products Procurement list in IT-Pedia is
populated by HOPEX technologies to go through the normalization process.

Importing New Technologies from IT-Pedia

Data import is carried out by the enterprise architect or the functional administrator.

To import data with the IT-Pedia connector:
1. Click the Technologies > IT-Pedia navigation menu.
2. In the edit area, click the Import button.
The import wizard opens.


https://itpedia.eracent.com/API/
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3. Select:

a vendor

a product

the version

the platform (Mac or Windows)

IT-Pedia catalog - Query and import of software technologies

Vendor: Product:
Microsoft SQL servl
SQL Server

SQL Server 2000 Driver for JDBC

SQL Server 2000 Resource Kit

SQL Server 7.0 manual

SQL Server Access Database Synchronizer

SQL Server Advanced Analytics

4. Check the product of the selection that appears.

IT-Pedia catalog - Query and import of software technologies

Vendor: Product: Version: Platform:
Microsoft SQL Server
& Import <& Clear
I S S
Microsoft SQL Server & & 2005-12-31
Microsoft SQL Server 2000 2000 * 2009-06-30
Microsoft SQL Server 2000 Developer 2000 a3 2002-07-11
Microsoft SQL Server 2000 Developer 2000 Developer * Pending Research
Microsoft SQL Server 2000 Developer Developer 2000 Developer o pending Research
Microsoft SQL Server 2000 Developer Developer Win 2000 Developer Win 2002-07-11
Microsoft SQL Server 2000 Developer Win 2000 win 2009-06-30
Microsoft SQL Server 2000 Enterprise 2000 = 2002-07-11

5. Click Import.
6. Select the import option:
e Now
e As soon as possible: execute the import after saving updates
e Scheduled: execute the import at the date and time specified
7. Click OK.
A message indicates import progress and completion.
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Filtering the display of technologies

You have the possibility to filter the display of technologies according to:
e Normalized Technologies: all versions imported from IT-Pedia (versions

present in the IT-Pedia My Products list)
e Technologies out of synchronization: versions not present in IT-Pedia My

Products
e Normalization requests. See Normalizing Technologies.

m Normalized Technologies « & Import

Normalized Technologies
Technologies out of Synchronization

Normalization Requests

When you import technologies from IT-Pedia, these technologies are automatically
added to the "My Products" list of the IT-Pedia catalog. When updating a technology
in HOPEX, if the technology no longer exists in IT-Pedia, it is displayed in the list

“Technologies out of Synchronization”.

Note that additional commands appear when selecting technologies.

<E Inventory Portfolios Vendors IT Pedia Reports
m Normalized Technologies + & Import & Refresh All & Renormalize
-] Local name Catalog Item Name Version

B .NET Framework (1)

B Microsoft .NET Framework Win = @A Microsoft .NET Framework Win Any Version

B 50 Payroll (1)
B sage 50 Payroll 6.00 Win Sage 50 Payroll 6.00 Win 6.00

B Access Manager Access Server (1)

Updating IT-Pedia Technologies Imported into HOPEX

You can update information from IT-Pedia at any time. Updates are made to all
normalized objects in your repository that have an IT-Pedia identifier.

To update information available on software technologies:
1. Click Technologies > IT-Pedia.
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2. Click the Refresh All button.
At the end of processing, a message indicates the number of technologies
updated.

Synchronization of deletions in HOPEX and IT-Pedia

In the latest versions of the IT-Pedia connector HOPEX v5 and HOPEX Aquila
published in the HOPEX Store, when you delete a technology imported from IT-Pedia
from the HOPEX repository, the technology is also deleted from your product list in
IT-Pedia.

Normalizing Technologies

Normalizing the technologies of your repository means adding them to the list of My
Products Procurement list in IT-Pedia for standardization.

Normalization is applied to all technologies that have a defined vendor but no IT-
Pedia identifier.

Once normalization has been carried out in IT-Pedia, you need to run a manual
update to retrieve the IT-Pedia information in HOPEX.

To normalize the technologies:
1. Click the Technologies > IT-Pedia navigation menu.
2. In the drop-down list select Technologies out of Synchronization.
3. Select the technologies to normalize.
4. Click the Normalize button.

Requests for normalization are displayed in the Normalization requests list. Once
normalization has been done, the corresponding technologies are visible in the
global list of technologies in your repository.

See also: Initializing the list of your technologies in IT-Pedia.

Reporting Missing Technologies in IT-Pedia

From the IT-Pedia connector you can declare missing technologies and request that
they be added to the IT-Pedia catalog. This request for addition in IT-Pedia implies
automatic creation of the technology in HOPEX.

You can also request the addition of a technology in IT-Pedia via an Excel file.

Requesting new product from the connector

To request the addition of a technology:
1. Click the Technologies > IT-Pedia navigation menu.
2. Display the Normalized Technologies list.
3. In the edit area, click Import.
The IT-Pedia query and import tool appears.
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4. Click the Request New product button.
The product request wizard appears.

5. Specify:

the vendor

the product

the version

the platform

IT-Pedia New Product Request

Vendor *: Product *:
Google Android

Version: Platform:
15 Windows

Reguest New Product

6. Click the Request New product button.
The request is sent and a message confirms the creation of the product in
HOPEX IT Portfolio Management. A standardization process is running
in IT-Pedia. You can check the status of the request. See Following the
request below.

Following the request

To track the status of a new product request:
1. Click the Tools > IT-Pedia navigation menu.
2. In the edit area, click Import.
3. Click the Follow my Request button.
The list of requests appears, with their status.

Requesting new product via an Excel file

For versions of the IT-Pedia Connector prior to V3.0 that do not have the Request
New product command, you can import technologies into the IT-Pedia portal using
an Excel file:

1.  With your customer login, connect to the following address:
https://itpedia.eracent.com.

2. Click My Products > Procurement.

3. Click the Import button.
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4. Download the Excel file template and fill in the following fields:
e Manufacturer: indicate the name of the manufacturer
e Product Name: indicate the name of the technology
e \Version: technology version
e Manufacturer Part Number : enter "N/A"
5. From the same display, import the file.
Technologies are added to the MyProducts list and a standardization
process is carried out in IT-Pedia:
e Known products are matched
e Unknown products are added
e Life cycle data is updated.

To benefit from the additions and updates, use the Update function in HOPEX. See
Updating IT-Pedia Technologies Imported into HOPEX.

See also:

Merging IT-Pedia Technologies With Existing Technologies of Your Repository.
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Displaying IT-Pedia Properties in HOPEX

The IT-Pedia properties imported into HOPEX appear under the IT-Pedia
properties page of the relevant technology.

Corel WinZip 14.0 Any Edition (WZENGSU14PRSTD) X

R IT-Pedia v

IT-Pedia Identifier Catalog Item Name
57376 Corel WinZip 14.0 Any Edition (WZENGSU14PRSTD)

Software Information

Version Edition Taxonomy

14.0 Any Edition Compression

Vendor Manufacturer Part Number Operating System
Corel WZENGSU14PRSTD Any OS

License and price information

Unit Cost (USD) Default Licence Type Number of Ttems Per Product
- Per Named User 1
Price Date Notes of the price date

Main dates in the life of the product

Start of Life Release Date End of Support
10/1/2009 10/1/2009 = =]

Technology properties related to the official technology life cycle are automatically
defined in the Characteristics page of the technology properties, under the
Official Lifecycle section.

e Release date

e End of Support

e End of Extended Support

w These properties can be set manually when you are not using the
IT-Pedia connector.
A Support Alert report uses this data to track technology obsolescence. For
example, the solution automatically detects current and future conflicts when an
underlying technology component becomes obsolete while the business application
is still in production.

See Support Alert report.
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See also: Technology Automatic Updating and Alerts.

Modifying dates from IT-Pedia

The technology lifecycle dates from the IT-Pedia import may be in read-only mode.
Through an Excel file you can modify or complete the technology dates and update
them in your repository.

You can use the file in two ways:

e Download it and manually define the technologies and attributes to be
modified.

e Select the technologies and their attributes in HOPEX and export them to
the file via the Excel export tool.

Once the file is completed, you can import it into HOPEX to update the technologies
in your repository

To import the model:

1. Click the Main Menu then Import > Excel Template Download.
2. Select "Technology Lifecycle Date Import Template".

To export directly from HOPEX the technologies and their attributes in the Excel file:

1. Click the Main Menu then Export > Excel (*.xls; *.xlsx).

2. Select Using a Excel template.

3. Select "Technology Life Cycle Dates Import Template" and check Load
Mega objects.

4. Click Next.

5. Under Excel Worksheets, select "Software Technology".

6. Under Columns, select the attributes you want to set on the technology.

7. Click Next.

8. Select the Excel sheet and under Objects to be exported, add the
desired technologies.

9. Click Next.

10. Open the file that contains the technologies to be modified or completed.

11. For each technology, enter the desired dates in the corresponding
columns, for example "Start of Life".

Once the file is completed, you can import it into HOPEX.

207



208

The modified attributes appear in the IT-Pedia

technologies, with the note "Set by Mega".

Software Information

Version
0.3

Vendor

Google

License and price information

Unit Cost (USD)

Price Date

Main dates in the life of the product

Start of Life
10/29/2023

Start of Life notes
Set by Mega

End of Extended Support

See also: Defining Technology Life.

properties of the concerned

Edition

Any Edition

Manufacturer Part Number
N/A

Default License Type
Per Installation

Notes of the price date

Release Date
10/29/2008

Release date notes

End of Sale

Merging IT-Pedia Technologies With Existing Technologies of Your

Repository

Your repository may contain technologies created outside of the IT-Pedia import.
These technologies do not benefit from the provider data and updates supplied by
the IT-Pedia connector, such as official life cycle dates, for example. To keep the
data for these technologies while benefiting from IT-Pedia information, you can
merge it with the IT-Pedia technologies that you import HOPEX IT Portfolio

Management.

Merging two technologies

To merge two technologies:

1. Click the Technologies navigation menu.
2. In the edit area, select the technologies to merge.
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In the list menu bar, click More s Merge Technologies .

ome / Technologies = | € Back

EB 41l Technologies #) New (*) Remove § ¢ Workflow w [Eh Instant Report : 2 selected

H T creste Objects e

FE .NET Data Collector - 7.3 f= Merge Technologies

4,

N

In the wizard that appears, enter:

e The source technology, which will be merged in the target technology

e The target technology, which will include information of the source
technology.

Click Next.

Select the properties you want to keep from the source and target

technologies. By default, properties of the target technology are

selected.

In the same way, select the links you want to keep.

Click OK.

Technology Automatic Updating and Alerts

Automatic update checks, at a given frequency, whether properties of software
technologies imported into HOPEX have changed in the BDNA repository, and if so,
carries these updates over to the corresponding technologies in HOPEX.

Defining Update Frequency

To activate an automatic update, you must create a trigger in the administration tool
which implements the IT-Pedia Automatic Update macro.

A Trigger is based on a Trigger Definition. This definition consists of a job which
includes the macro that the Trigger will execute.

To create a trigger definition:

ol wN=

N

9.

Open the Administration module.

Open the environment.

Expand the repository folder concerned.

Right-click Scheduler and select Manage Triggers.
Click the Triggers Definitions tab.

Click the New button.

The trigger definition wizard opens.

Enter a name, for example: "Automated IT-Pedia Update".

In the System Job Definition field, select > Create System Job
Definition.

The Job definition wizard opens.

Enter a name for the Job, for example "Automated IT-Pedia Update -
System Job".

10. In the Implementation field, select > Connect Macro.
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11. Look for the macro entitled “IT Pedia V2 - Module - Update Software
Technologies From MyProducts - Scheduler Job”.

& HOPEX - Administration

File Help r 1
@ Trigoer vi
HOPEX |

= Creation of

System Trigger Definition

Name :

| o
Groex | Town T |

 IT Pedia update

=@ Erwironments

E‘a C:\Programl ® Cp I'.i System Job Definition: g

- Mame
d"ﬁ Syste Comput
2@t | g opjects|
' ML Reposita
@R | =

i @ S
i User man

— ' — 9 =
P ﬂw'smmerm? S

| <re
12. Click OK.

=3 (Creation of Systern Job Definition - Characteristics

Mame :

| Automated |T-Pedia Update - System Job

| IT Pedia v2 - Module - Update Softy

Read Virite Mode: | ReadWrite

External Identifier: |

ExecutionMode: | CUSTOM

EECES )

13. Back in the trigger fefinition wizard, click Next.

CunﬂliHeﬁ:|
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14. Define a schedule, e.g. each saturday at 2:00:00.

w  For more details on trigger scheduling, see Configuring the Trigger
Scheduling.

Time zone for all the scheduling time definitions:

- :

=l Start

[Jrelative Date
Start date (absolute): |[] 4/16/2024

Start time: | 00:00:00
I=l Date Recurrence
Recurrence Type: Weekly W

Execute at start date time

Repeat every N weeks: | 1

Days of week: Saturday >
=l Recurrence End
Recurrence End Type: | No End b

=] Time scheduling (for date recurrence)

Scheduling type: | Once b
Single trigger time: | 02:00:00

15. Click Finish.

To create a trigger:

In the Trigger Viewer window, click the Triggers tab.

Click the New button.

Select a trigger definition, e.g. “"Automated IT-Pedia Update”.

Give the trigger a name, e.g. "Automated IT-Pedia Update - Trigger".
Exit the Administration module.

ahwN=

Subscribing to Alerts

A user can be notified of updates made on the technologies he is in charge of.

To subscribe to an alert:
1. In the edit window, display the list of technologies.

2. Select the technology concerned and click the Follow o button.

w  For more details on alerts, see the HOPEX Common Features guide,
chapter "Communicating in HOPEX", section "Threads of Posts and
Alerts on Objects”".

w  For more details on alerts, see Managing Your Alerts on Object
Modification.
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Support Alert Report

A Support Alert MetaAtribute available on each technology compares the
technology life cycle (imported from IT-Pedia or defined manually) with its life cycle
in the organization.

w  For more information on technology life, see Defining Technology
Life.

A report uses the Support Alert MetaAttribute to analyze technologies in the
HOPEX repository and displays all possible conflicts between the use of these
technologies in the organization and their official life cycles.

See Support Alert Report.
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DISTINGUISHING APPLICATIONS FROM TECHNOLOGIES

Thanks to an Al-based analysis engine, AI-Driven APM automatically detects
business applications from the list of technologies, helping enterprise architects to
build their application repository.

Application detection is based on a repository of technologies standardized with IT-
Pedia. Following standardization of technologies in the HOPEX repository, you can
use the tool to identify technologies that turn out to be applications, and thus
distinguish technical bricks from business applications.
w  For more information on the normalization, see Normalizing
Technologies.
HOPEX creates its own classification of IT-Pedia technology products to help the
enterprise architect make the technical/business distinction, but also to indicate to
which business capability in HOPEX an application contributes. The tool makes
recommendations - it's up to the architect to arbitrate and validate them. HOPEX
records the decision and updates the repository.

Prerequisite Conditions

The application detection function is available with the AI-Driven APM module. The
module requires installation of the Aquila version of HOPEX and the IT-Pedia
module.
w  For more details on module installation, see Importing a Module
into HOPEX.
The recommendations provided by the Al-driven APM tool are based on a calculation
performed by the Remote-Taxonomy service hosted by MEGA.

To use the tool, you need to specify the URL of this service in the administration
options:

1. Access the HAS Console and stop HOPEX Core Back-End module. Make
sure to perform this action when users are not connected.
Open the HOPEX Administration window.
Right-click on HOPEX and select Options > Modify.
Unfold the Tools > Data Exchange > Remote Taxonomy folder.
In the Root URL of remote taxonomy field, enter the following URL:
https://ea-ai.saas.mega.com.
Click OK.
In the Administration application, connect to the environment and
perform an Automatic Environment Update.
8. Restart the HOPEX Core Back-End module.

ahwN
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Application Detection

HOPEX can identify which technologies correspond to which applications. For each
technology, it provides a recommendation; it's up to you to validate it or not.

Presentation of the wizard

The application detection wizard presents a list of technologies awaiting arbitration.

It consists of two steps:

e Qualification of software assets
e Preview and update of the repository

Qualify software assets
The software products displayed are the “Product” technologies standardized from
IT-Pedia, all versions included.

w [f a new version of a technology is imported, it is attached to the
existing technology. You can view the versions of a technology in its
properties, on the Version page.

Each software product has a recommendation associated with:
e a confidence level
w  Using this confidence rate, you can sort technologies.
e a justification.

Preview and update the repository

This second step presents the applications and their properties that will be created
in the HOPEX repository.

When you validate, all the lines you have modified are processed (name and objects
associated with the application).

The applications created are connected to the source technologies.

Starting application detection

You can launch application detection with the Enterprise Architect and EA Functional
Administrator profiles.

To launch application identification:

1. In the navigation bar, click Applications > Application Detection.
A table lists the technologies awaiting qualification.



Recommendation

Technology

Technology

Technology

Application
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2. For each one, validate or invalidate the recommendation by selecting
Yes or No in the Decision column.
Depending on the decision, the asset is qualified as Technologie or
Application.

w At this stage, objects are not yet created.

Rate Justification Decision Qualified Asset

O 98% Oracle Database Is a relational database management system [RDEMS) fr. s = W ~pplication

99% Oracle Database Server Is a powerful, reliable and secure relational databa... Technology

&

9% is a Business Intelligence [BI) and data visualization tool. it allows users to .. Yes No

O T Oracle Enterprise Linux is a Linux distribution based on Red Hat Enterpris...

3. Click on step 2: Preview and update repository.
A table lists the technologies that have been qualified as Applications.
4. If necessary, complete the information before creating them:

e when a technology corresponds to an application, the application takes
the name of the technology by default, but you can override the name.

e you can associate the application with a portfolio and a manager.

5. You may:

e create all the applications in the list at once: click the Create
Applications button. You will be prompted to validate. Click Yes to
create all the applications displayed.

e create applications one by one: tick the application in question and
click Create Applications.

6. Once the applications have been created, the wizard suggests to match
them to business capabilities.

w  You can also carry out this step at a later date. See Matching
Applications to Business Capabilities below.

Matching Applications to Business Capabilities

Once the technologies have been requalified as applications, the AI-Driven APM
tool defines the functional coverage of these applications by associating them with
business capabilities.

w  Applications must be linked to an application portfolio.

The recommended business capabilities come from business capability maps, which
are of two types:

e standard business capability maps supplied by MEGA, delivered in the
“Standard Industry Capability Maps” module:https://store.mega.com/
modules/details/sample.itbm.stdcapamaps?prerelease=False.

e customized capability maps, specific to your company
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For each application, the tool displays a list of capabilities to which it is likely to
respond. You can modify this list.

Launching Capability Smart Mapping

You can launch Capability Smart Mapping with the Enterprise Architect and EA
Functional Administrator profiles:
1. In the navigation bar click Tools> Capability Smart Mapping.
2. Select the portfolio containing the relevant applications and the business
capability map.
3. The wizard presents:
e the application list
e the recommended business capabilities
e business capabilities already linked to applications.

sTERT sTER2 sTER3
Link capabilities @ > Preview capability map > Update Repository >
'
Global Applications Portfolio Bany
Portfolic applications Without eapability
Application Name T Recommended Capabilities Existing Capabilities

ol - AirportMega.com
o “MEGA BANK Mobile App
o  Account Management Financial Performance Management Financial Account Management
ol Account Payable Financial Performance Management Financial Forecast Management
o Accounts Financial Performance Management Investment Banking Managem.
o Airlines Chack-in & Monetary Transfer Management
ol Airport Mobile VIO Manetary Transfer Management
ol Airport Mobile v2.0 Monetary Transfer Management
o airportMega.com v2.0 Manetary Transfer Management

You can define or modify recommended capabilities manually.
Recommended applications are displayed in the capability map in step 2.
If required, you can go back to step 1 and modify the recommendation.
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4. Click on step 2 to preview the business capability map.
Applications associated with business capabilities appear in green.

STEP y [EE2 5 ees 3
Link capabilities Preview capability map @ Update Repository

Levels AV show Application %

[ Recommendad Application :

e N S

Financial Account Management
Manatary Transfor Management
e

Aurlines Checkein
Alrport Mobiie V1.0
Financial Forecast Management
Airport Mobile v2.0
Account Payable AirportMega.com v20
ARING AirPlan
Financial Performance Management
ARING ExprossDrop
Account Management ARINC SelfDrop
Account Payable ARING VeriPax

m

5. Go to step 3.
6. You may:
e connect all applications on the list to the recommended capabilities at
once: click Link Applications to Capabilities and confirm.

connect applications one by one: check the application in question and
click Link Applications to Capabilities.

Reliability of recommendations

The model characterizes a business application on the basis of the following
elements:

e Product analysis:
e A product that brings added value to the company’s end-users.
e A product that supports a business function

e A product containing specific words such as Designer, Networker,
Backup, etc.

Training on a massive database: the machine learning model has been

trained on over 74,000 different technologies, assimilating the patterns

that distinguish one application from another.
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Model accuracy and performance measures:

Displayed confidence Reliability for Reliability for a
rate an application technology
>80% 99% 89%
60%-80% 65% 67%
<60% 66% 66%

The model’s recommendations may be interpreted differently depending on the
expertise of the sector and the user.

Expertise of the user

A software may be considered an application by one user, but a technology by
another, depending on their expertise and needs.

Example

Take software like Docker: it can be considered as an
application by a developer who uses it to build and run
applications, but it can be considered as a technology or
platform by a system administrator who uses it to manage
system resources, ensure container security, and so on.

The final categorization may also depend on the user’s level of expertise.

A less technical user may rely more on high-confidence recommendations, while a
more technical user may feel comfortable interpreting low-confidence
recommendations on the basis of their own knowledge and experience.
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DEFINING TECHNOLOGY LIFE

The technology life is characterized by:

e Its official life cycle, specified by the vendor
e Its life cycle within the organization; it can differ from the official life
cycle.

Based on this data, indicators and report types enable you to analyze the risks of
technology obsolescence and the applications concerned.

Official Life Cycle

Dates of the official technology life cycle are automatically defined in the
Characteristics tab of the technology properties.

e Release date

e End of Support

e End of Extended Support

These properties are defined automatically when you import a technology from
BDNA or IT-Pedia. To modify IT-Pedia properties, see Modifying dates from IT-
Pedia.

w  For more details on importing technologies, see Importing
Technologies from BDNA and Importing Technologies from IT-Pedia.

you can also set them manually.

Technology Life Cycle within the Organization (Gantt Diagram)
An object evolving over time can take different states (preparation, production,
retirement, etc.).

The Object life enables viewing of the planning of these different states in the form
of a Gantt chart.

To view the Gantt chart representing the different states of a technology:

1. Open properties of the technology.
2. In the technology properties window, click the Characteristics page.
3. Expand the Gantt section.

As with an application, you can initialize the lifecycle of a technology, see Viewing
Application Life (Gantt Chart).

Analyzing the life cycle of a technology and the applications that use it

A report enables display in the same Gantt diagram of life cycle steps of the
technology and those of the applications that use it.
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A second report indicates any conflicts between life cycles of these objects.

To access these reports:
1. Open the properties of the technology concerned.
2. Click the Reports page then:
e Gantt Chart to view life cycles of the objects
e Gantt chart with conflicts to view any conflicts.

Technology Support Alert

A Support Alert MetaAtribute available on each technology compares the
technology life cycle (imported from BDNA or IT-Pedia or defined manually) with its
life cycle in the organization.

Viewing the support alert of a technology

To view the Support Alert attribute on a technology:
1. Click the Technologies navigation menu.
2. Display “All Technologies”.
The Support Alert column defines the use of each technology within the
organization.

EB Al Technologies v (®) New
CI T e N

O BB .NET Framework 1.0 NA

O BB NET Framework 1.1 | Supported Usage

O BB .NET Framework 2.1 NA

O BB .NET Framework 3.0 NA

O BB .NET Framework 3.5 B Late usage

O BB .NET Framework 3.5 SP1 B Late usage

O BB .NET Framework 4.0 Early Usage

O BB .NET Framework 4.5 B Late usage
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The attribute can take the following values:

e Early life cycle: the technology has a life cycle in the organization which
started before the official release date of the software technology.

e Supported usage: the life cycle of the technology begins after the
release date of the technology and ends before the end of the support
date.

e Delayed use: the life cycle of the technology begins after the release
date of the technology and ends before the end of the extended support
date.

e Non-supported use: the life cycle of the technology begins after the
release date of the technology and ends before the end of the extended
support date.

Attribute calculation

The value of the Support Alert attribute is defined by the following parameters:

Technology life cycle Support Alert value
Life cycle not defined NA (Non applicable)
Support end date and extended support NA (Non applicable)

end date not defined

The release date of the technology is later Early life cycle
than the current date and the begin date of
use.

The support end date is not defined or later | Supported usage
than the usage end date, and the extended
support end date is later than the usage
end date.

The support end date is earlier than the Delayed use
usage end date, and the extended support
end date is later than the usage end date.

The usage end date is later than the sup- Non-supported use
port end date and the extended support
end date.

Support Alert report

The Software Technology Support Alert report uses the Support Alert
MetaAttribute to analyze technologies in the HOPEX repository and displays all
possible conflicts between the use of these technologies in the organization and
their official life cycles.

This report is available on an application portfolio or a technology portfolio.

To generate a Support Alert report:
1. Open the properties of the portfolio.
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2. Click the Reporting > Software Technology Support Alert page.
The report results appear.

Portfalio
Technology type:

< All Software Technologies

Refresh the report

£ 1. Software Technology Support Alert

H n

Early Lisags
[ supported Usage
I Latzusage

[ unsupported Usage

Obsolescence Risk and Remediation

You can visualize the risk of technological obsolescence for each technology, as well
as for technologies associated with a portfolio or a selection of applications.

For each technology, the Obsolescence Risk indicator is available in the
technology properties, and is calculated on the basis of the technology’s lifecycle
dates.

m  See Defining Technology Properties.

For a portfolio of applications or a selection of applications, you can analyze the
obsolescence risks of the technologies associated with the applications. The
Technology Obsolescence Remediation report shows, for the applications in the
portfolio, the list of software technologies, their support state for the coming years
and the potential new versions available to remedy their obsolescence.

w Remediation proposals are based on technologies developed by IT-
Pedia. See Importing Technologies from IT-Pedia.

To open this report:

1. Click the Reports menu.
2. To the right of the edit area, click the Create a report button.
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3. Search for the “Technology Obsolescence Remediation” report.
The report appears in the edit area.

4. Select the report type and click Create a report.
The report creation wizard opens.

5. Select the relevant application portfolio.
6. Click Preview then Continue.

7. Name the report.

8. Click Save and open.

The report displays:
e portfolio applications
e the technologies associated with the applications, with:
e The current version
e its life cycle for the current year and the next two years
e in the event of obsolescence, the proposed technology and version
e other applications concerned by the technologies analyzed
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MANAGING DEPLOYMENTS OF TECHNOLOGIES

HOPEX IT Portfolio Management enables management of deployments of
technologies.

Versions and Deployments

HOPEX enables association of a technology with one or several deployments. A
deployment is supported by a site or server and associated with a life cycle.

On the same site, a technology is deployed to offer different services to different
users. Each deployment is therefore associated with several usage contexts which
enable specification of lists of functionalities available to different users.

Consulting Technology Deployments

To access deployments of a technology:
1. Open properties of the technology.
2. Select the Installation page.
The list of associated deployments is displayed.
e deployment date
e planned retirement date

To access characteristics of a technology deployment:

1. In the Deployed Technology section, select a deployment.
The hostings and usage contexts associated with the deployment appear
in the following sections.

In Context of Use you can define :

e context begin date:
e proposed functionalities retirement date
e planned number of users (consumers)

Creating a Technology Deployment

Technology deployment on a site offers functionalities adapted to different
populations of users over a time period.

You can create a first deployment at creation of the technology, or create it later via
its properties pages.
To create a technology deployment:

1. Open properties of the technology.
2. Select the Installation page.



oo

10.
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In the Deployed Technology section, click the New button.

The Deployment creation window opens.

Specify the deployment name.

Select the Deployment Life Cycle from the drop-down list of this field.

Specify:

e Start Date, corresponding to the effective deployment date

e End Date, which can correspond to the technology production end
date.

Select the Freeze the Source Object of the Software Installation to

avoid modification of the deployed technology.

w  You cannot modify a locked technology. If the technology is to be
modified, a new version must be created.

w  For more details on variations, see the HOPEX Common Features
guide, "Handling Repository Objects", "Object Versions" chapters.
Click Next.
In the Deployment Support section, select the site or server that
hosts the deployment.
Click OK.
The new installation appears in the technology properties.

Creating an Deployment Usage Context

The deployment context of a technology enables specification of the list of
functionalities offered to each population of users for a given deployment over a
period of time. Several contexts can be created for a given deployment.

To create a usage context of an application installation:

1.

2,
3.
4

oo

10.

Open properties of the technology.

Select the Installation page.

Under Deployed Technology, select the deployment.
In the Usage Contextsection, click the New button.
The Creation of Use Context dialog box opens.

Specify the Life Cycle, Start Date and End Date of the context.

Click Next.

The wizard offers you to add consumers. It relates to the application
installations that will use the deployed technology in this context.

Click the Connect button to connect the consumers to the usage
context.

Click Next.

You can add functionalities to the context:

Click the Connect button to select the functionalities that will be
proposed to consumers in the usage context.

Click OK.

The new usage context appears in the properties of the deployed
technology.
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MANAGING COSTS OF TECHNOLOGIES

Similarly to application, HOPEX IT Portfolio Management allows you to specify
and analyze the costs of your organization's technologies.

The definition of costs of a technology is the same as for an application.

See Managing Application and Application System Costs.
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IMPORTING OBJECTS IN HOPEX IT
BUSINESS MANAGEMENT

HOPEX IT Business Management provides an Excel file template for bulk
importing objects into the repository.

Downloading the Excel Import Template

The Excel import template is available in the HOPEX Store.

To download the file:
1. Connect to the HOPEX Store.
2. Click Modules.
3. Search for the ITBM Excel Import Template.
4. Select the template and click Download.

Template Description

The file enables bulk import of the following object types:

e Strategy objects: enterprises, goals, strategies.

e Transformation objects: stages, objectives, tactics, exhibited business
capabilities.

e Business architecture objects: value streams, value stages, business
function areas, business functions, business partners.

The different types of objects concerned are presented in dedicated sheets.
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The _README sheet details the object import:

This HOPEX template provides means to bulk import ITBM data

Enterprises allows import of Enterprises : creating Enterprises with their properties (including

link with existing reference Business Capability Map)

Goals allows import of Enterprise Goals : creating Enterprise Goals and their Strategic
Themes

Strategies allows import of Enterprise Strategies - creating Enterprise Strategies and links to

Enterprise Goals (created in "Enterprise Goals" tab)

Transformation Stages Stages allows import of Stages : creating Stages with their properties

Objectives allows import of Stage Objectives : creating Stage Objectives and links to
Enterprise Goals (created in "Enterprise Goals" tab)
Tactics allows import of Stage Tactics : creating Stage Tactics and links to Enterprise
Strategies (created in "Enterprise Strategies” tab) and Enterprise Objectives
(created in "Enterprise Objectives” tab)

Exhibited Business Capabilities |Exhibited Business Capabilities allows import of Exhibited Business Capabilities : creating Exhibited Business

by Stage Capabilities with links to existing Business Capabilities and Stages. Stage
Objectives (created in "Stage Objectives” tab) and creating fulfillments by existing
Applications or Application Systems.

Mote : this means Business Capabilities. Application and/or Application Systems
have been previously captured in repository or imported with the ITPM import tool.

Business Architecture Value Streams allows import of Value Streams : creating Value Streams and their sub-Value
Streams

Value Stages allows import of Value Stages : creating Value Stages and links to their owning
existing Value Stream and required existing Business Capabilities
Business Function Areas allows import of Business Function Areas : creating Business Function Areas and
their sub-Business Function Areas
Business Functions allows import of Business Functions : creating Business Functions and links to
their owning existing Business Function Area, required existing Functionalities
and required Business Skills
Business Partners allows import of Business Partners : creating Business Partners

T - Format should be YYYY/MM/DD

Cells with missing data (for consistency) will be
highlighted like this

Empty cells by mistake



EVALUATING APPLICATION ASSETS

Each application manager can evaluate applications for which he/she is responsible based on three
criteria: business, functional and technological. See "Evaluating Application Criticality", page 164.

The Portfolio Manager can evaluate the application assets he/she supervises by creating an
application portfolio and associating with it additional evaluation criteria.

He/she can also evaluate the quality of the application code of a portfolio by launching a scan
campaign with CAST Highlight for the application managers.

The numerous reports proposed by HOPEX IT Portfolio Management to analyze applications
before starting the transformation phase.

The following points are covered here:

"Describing Inventory Portfolios", page 230

"Defining Portfolio Assessment Criteria", page 235

"Analyzing the application code of a portfolio with CAST Highlight", page 241
"Evaluating the Cloud Migration"

"Portfolio Analysis Reports", page 247

"Transforming the Application Portfolio"

ANENENENENEN
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DESCRIBING INVENTORY PORTFOLIOS

An inventory portfolio groups a set of applications.

Creating an inventory portfolio consists of defining all the information (comparison
criteria, etc.) needed to assess applications of the portfolio.

A portfolio enables representation of all investments of an
enterprise (or department) necessary to carry out changes required to
achieve strategic objectives. It comprises a set of objects (for example
applications for a an inventory portfolio) to be compared based on
comparison criteria associated with the portfolio.

You can also create inventory portfolios for technologies. The technology portfolio
definition uses the same methods than applications portfolios.

Creating an Inventory Portfolio

HOPEX IT Portfolio Management proposes two types of portfolios:

e The inventory portfolio: comprising different applications (or
technologies), it enables follow-up of a given set of applications.

e The transformation portfolio: this intervenes after the inventory and
assessment and comprises project lines (including deliverables that can
be applications or technologies) and can include several project lines for
the same application to measure the option costs of different scenarios.
See "Transforming an application portfolio", page 73.

To create an application inventory portfolio:
1. Click the Applications navigation menu.
2. In the edit area, select By portfolio.
The list of application portfolios appears.
3. Click New.
The new portfolio appears in the list. You can open its properties to define
its characteristics.

Defining Inventory Portfolio Content

All elements of a portfolio are accessible from its properties pages.

To access application portfolio properties pages:

) In the application portfolios list, click the one you wish to study.
Portfolio properties pages appear.
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Portfolio characteristics

Portfolio characteristics are divided into several sections:

¢ Identification: name, portfolio type, study dates, comment.

e Portfolio Criteria: see "Defining Portfolio Assessment Criteria", page
235

e Responsibility: displays person responsible for the portfolio
Sub-Portfolios

Report: enables creation of analysis reports on the portfolio. See
"Reports Embedded in a Portfolio", page 247.

Inventory

This page enables listing of portfolio applications - or technologies - and evaluation
of their criticality. See "Evaluating Application Criticality", page 164.

In this page, the portfolio manager can launch information gathering for a set of
applications. See "Collecting Data for a Set of Applications", page 231.

It is also possible to run instant reports on selected applications or technologies. See
"Instant reports", page 170.
Rating scale

This page enables definition of values of criteria associated with applications. See
"Evaluating Applications on Portfolio Criteria", page 238.

A criterion is a reference element used to compare objects in a
portfolio. Criterion values can be predefined.

Reports
This page displays the different dynamic analysis reports of the portfolio.

Collecting Data for a Set of Applications

Principle and prior conditions

The goal is to enable a portfolio manager to ask application owners to enter the
properties of a set of objects.

The local owner of the application receives a link to the questionnaire by email
enabling him/her to enter the properties in which the portfolio manager is
interested.

You must first ensure that each application has an owner. For this, in the application
properties window, expand the Responsibilities section, and link an application
owner if this has not already been done.
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Request completion of data via an assessment questionnaire

To ask the owner of an application to complete the data:
1. Select an application portfolio and open its properties.
2. In its properties window, click the Inventory page.
The portfolio components (applications) appear.
Select the applications for which you wish to collect data.

w Check that the objects selected are linked to an application local
owner.

d

Click the hidden commands button : then Fill Data.

Scroll the creation wizard and select the elements that you wish to make

available to the application owner:

e one or more properties pages (for example the properties page that
concerns risks if you want the application owner to specify the
application risks)

e advanced characteristics (special MetaAttributes, for example, the
validation date of the application)

Start the session immediately.

The application owner receives the questionnaire.

o &

o

Entering data for an application via a questionnaire

To view and fill in the assessment form that was sent to you by your manager:

1. In the navigation bar select Tools > Data Calls.

2. Click the form to open it.
The applications for which you must complete the data appear.

3. Once the fields are filled in, right-click on the questionnaire and select
Assessment Questionnaire (To be Filled In) > Complete.

Generating the Business Capability Map of a Portfolio

HOPEX IT Portfolio Management enables you to generate a business capability
map in the form of a report that reflects the functional coverage of an application
portfolio.

To generate a Business Capability Map from an application portfolio:

1. Display the portfolio properties.

2. Click the page Reporting > Business Capability Map Breakdown.
The report positions the portfolio applications in the areas that represent business
capabilities. It therefore reflects the functional coverage of portfolio applications.

w For more details on capability maps, see "Defining Business
Capabilities", page 20.
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Report parameters
This consists of defining report input data.

Settings Parameter object Comment

Business capabil- | Business capability / One object mandatory.

ity Business capability Map

In-depth This option displays the applications
research of the defined in the sub-portfolios of the
application in portfolio to which the report relates.

portfolios and
sub-portfolios.

Characteristics Evaluation criteria Displays in the report the application
See "Defining Portfolio evaluation results for the selected
Assessment Criteria", characteristics:
page 235. - Technology compliance
- Cost
- Technical efficiency
- Etc.

Select the form in which you want to
display a characteristic: graphic ele-
ment or highlighting of the applica-

tion concerned by the characteristic.

Example of a business capability map example

Alrport Capability Map

Analytics

Business Support Financial Management Marketing Management
Collaboration Billing Management Advertising
AT

Airline Safety

FIMRO System) " [purchasing] ™ ]
O (@] O
™ [communieation| ™ [accounts]
& ag . ent Managmen
bejen Managemend . Sasr .
[}
™ [Billing]
™ [rvallability [ ]
Cross Analytical Data . Corporate
and Methods il communications
Financial Applicatiol
Al ® " L AirportMega.com
Enterprise Level Administration ‘ .
hon e Satea P Jciaims Administratio ® ' ¥ Jairport Mobile vi.Q
Management ® ®
™ [TerminalLini
B'::::g R Corporate ' Messaging
B communications ¥ Taccount Payabig)
[ ]
P [ AirportMega.com) LA
Finance and Risk . = ‘
Valiation ¥ Lairport Mobile V1.0
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You also have the Business Capability Breakdown Time Report that shows the
evolution of the functional coverage of an application landscape over time.

See also "Portfolio Analysis Reports", page 247.
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DEFINING PORTFOLIO ASSESSMENT CRITERIA

You can compare applications defined in a portfolio based on common criteria
associated with the portfolio.

A criterion is a reference element used to compare objects in a
portfolio. Criterion values can be predefined.

To define portfolio criteria, you can:

e use existing criteria in the repository,
e Create new criteria and associated values.

w  (Criteria are defined from the MetaClass (object type)
TaggedValue. Some windows use this term rather than Criteria.

Using Existing Criteria

To connect existing criteria to an application portfolio:
1. Click the Applications navigation menu.
2. In the edit area, select By portfolio.
The list of application portfolios appears.
Display the portfolio properties.
Click the Characteristics page.
In the characteristics, expand the Portfolio Criteria section.
In the section, click the New button.
The search pane is displayed with a list of criteria already defined.

Select the criteria that interest you.
8. Click Connect.
Each selected criterion is displayed in portfolio characteristics.

o0k w

N

Using Existing Criteria

Standard criteria are proposed to process costs modeled on applications.

m  For more details on modeling of costs, see "Managing Application
and Application System Costs", page 159.
Standard criteria for analyzing the costs declared on applications according to their
type and nature are the following:
e For type:
e Capital expenses
e Operating expenses
e For nature:
e Infrastructure costs
e Software licenses costs
e Manpower costs
e Service costs

The names of standard criteria enabling analysis of costs declared on applications
carry the extension "Reference", for example "Reference Costs".
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Given that these criteria are automatically calculated, they cannot be modified from
the Inventory and Evaluation pages.

w  For more details, see "Evaluating Applications on Portfolio Criteria”,
page 238.

Creating a New Criterion

To create new criteria for portfolio application comparison:
1. Open the Criteria properties page of the current portfolio.
2. Click the New button.
The creation window opens.
3. Indicate the name of the site and click OK.
The new criteria appears in the list of portfolio criteria.

Defining criteria format

Specification of type and format of a criteria (or TaggedValue) is identical to that
of a MetaAttribute. For more details on declaration of criteria format, see chapter
"MetaAttributes" of the Studio guide .

To define characteristics of a criteria:

1. Open the Characteristics properties page of the current criteria.
2. In the MetaAttribute Type field, indicate the type that will take the
criteria values.

MetaAttribute Type Meaning

String Alphanumeric, the value of the MetaAttribute
Length attribute should then be specified

DateTime Date

VarChar ASCII text

VarBinary Binary text (reserved)

Boolean Boolean (0 or 1)

Short Integer (0-65535)

Long Integer (0- 4294967295)

Binary Binary (reserved)

Double Integer (0- 18446744073709551616)

Float Floating number
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3. In the MetaAttribute Format field, indicate the Format that will take
the criteria values. Possible values are:
e Standard: for character strings
e Currency: for currencies
e Enumeration: for a list of character strings with predefined values
e Enumeration (Opened): for a list of character strings open to the
user
e Duration: for dates
e Percent: to enter a percentage
e Double: to enter a number
e Object: to enter an object
e Signed Number: to enter a number possibly negative. In this case,
MetaAttribute Type must be Short, Long, Double or Float.
© The following formats are recognized in analysis reports:
Standard, Enumeration and Signed Number.
4. Click OK.

To define values associated with a criterion of Enumeration format:

1. Open the External Value properties page of the current criteria.
2. Click the New to create new values.

Defining Criterion Aggregation Rules

Aggregation of a criterion enables definition of calculation rules that will be applied
to application values to obtain the criterion value on a portfolio. In this way you can
compare portfolios.

To define criterion aggregation rules:

) Open the properties pages of the criterion.
) Click the Characteristics page.

Aggregation policies proposed as standard are:
e Minimum
e Maximum
e Average
e Sum

For example, the Cost criterion associated with a portfolio
can be obtained by calculating the average cost of
initiatives making up the portfolio, or the sum of costs of
each of the elements.

To fix more specific aggregation rules, the aggregation policy can be defined by a
Macro. The name of the macro is defined in the Aggregation Macro column.

w  For more information on Macros in HOPEX, see the guide All
about starting with APIs.

237



238

The result of aggregation of different criteria is accessible in the Aggregation
Value column.

Evaluating Applications on Portfolio Criteria

Portfolio applications are assessed against the various portfolio criteria.

w Standard criteria relating to costs are automatically calculated, they
cannot therefore be modified in this property page. For more details on
these criteria, see "Using Existing Criteria", page 235.

Accessing evaluated applications

To access evaluations of all portfolio applications:
1. Open the properties of the portfolio.
2. Select the Evaluation page.
The list of evaluations of all portfolio applications according to different
criteria is displayed.

PGenerating a PDF or Excel evaluation data file

The PDF and Excel allow you to generate PDF and Excel files of evaluation results.

w  For reasons of readability, the PDF file contains a maximum 12
columns.

Generating an instant report on evaluation data

Instant reports allow you to carry out drill-down analysis on evaluated objects. They
provide greater detail depending on specific analysis perspectives (quantitative,
time, etc.).

To generate an instant report on a list of evaluated applications:
1. Open the properties of the portfolio.
2. Click the Inventory page.
3. In the list of applications, select those to be analyzed.
If you do not select an application, by default the report covers all
applications.

4. Click Instant Report.

w If necessary, click * to display the hidden commands.

5. Select the required analysis type, for example "Breakdown".
6. Click OK.
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7. In the list of possible grouping criteria, select "Costs".
For all selected technologies, you receive the cost breakdown according
to their levels.

[ Pie chart | Bar chart | Data|

W o

€112,000.00

W f1z0000

W o0

For further information on instant reports, see the HOPEX Common Features
guide, "Generating documentation", "Launching instant reports on lists".

Portfolio costs report

A report automatically displays the global costs of applications contained in a
portfolio.

To access the portfolio cost report:
1. Open the properties of the portfolio.
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2. Select Reporting > Costs Report.

Reporting - Costs Report »

S0000—

W Mangower

= Infrastruchura

W Somware Licence

M Senice

= 2. Detailed Cost per Nature

Manpower Infrastructure Software Licence Service Total

Jan 2012 £28.667.00 £1,500.00 €3.167.00 £0.00 €33.334.00
Mar 2012  =20.6567.00 £23.500.00 £3,167.00 £0.00 €47.334.00
May 2012  €39.667.00 £1,500.00 £€3,167.00 £0.00 €44,334.00
Jul 2012 €20,667.00 £€2,500.00 €3,167.00 £0.00 €28,334.00
Sep 2012  =20.667.00 €13,500.00 £€3,167.00 £0.00 €37.334.00

An analysis report also summarizes costs of applications and of their versions and
deployments between the portfolio start date and end date.
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ANALYZING THE APPLICATION CODE OF A PORTFOLIO WITH
CAST HIGHLIGHT

On a portfolio containing in-house applications, the portfolio manager can launch a
code analysis campaign to analyze the quality of the application code and issue
alerts on any risks that might affect the portfolio.

Prerequisite Conditions

The CAST Highlight code analysis functionality requires:

e Entering the client number in HOPEX ITPM

e Identifying the functional administrator as the first CAST Highlight user
e Declaring other users in CAST Highlight

e Establishing the connection between HOPEX and CAST Highlight

Entering the CAST Highlight customer ID

The administrator must specify the CAST Highlight Customer ID in HOPEX. This
number is provided by the sales administration.

To specify the CAST Highlight Customer number in HOPEX ITPM:
1. Connect to HOPEX ITPM as HOPEX Administrator.
2. Click Environment options.
The options window appears.

3. In the left pane of the window, expand the Data Exchange folder then
Import/Export Synchronization.

Click CAST Highlight.

5. In the right pane of the dialog box enter the humber of the CAST
Highlight Customer ID.

Click Apply.

7. Click OK to close the window.

P

o

Identifying yourself as the first user (Functional Administrator)

As the first CAST Highlight user, the EA functional administrator must register with
the CAST Highlight portal.

Once registered, the functional administrator must enter his/her CAST Highlight
user number in HOPEX, which was allocated by CAST Highlight during his/her
registration.

To enter your CAST Highlight user number in HOPEX:

1. In the HOPEX desktop, click Administration > CAST Highlight >
Manage Cast Highlight User.
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2. Click the drop-down list, then Me to display your information relating to

CAST Highlight.
3. In the Action column relating to your name, click Properties.
The properties window of the user appears.

4. In the CAST Highlight ID field, enter your user number.
The functional administrator can then define other CAST Highlight users in HOPEX.

Declaring other users in CAST Highlight

Once the functional administrator is registered in CAST Highlight and has
established a connection between HOPEX and CAST Highlight, he/she can declare
other CAST Highlight users in HOPEX. The persons concerned receive an email from
CAST Highlight asking them to register in the account created in the CAST Highlight

portal.

To add a CAST Highlight user:
1. In the HOPEX desktop, click Administration > CAST Highlight >
Manage Cast Highlight User.
The list of users appears.
2. Select the user in question and click Create user in CAST.
The user receives an email from CAST Highlight to confirm the
registration, and the user connexion status switches to “Missing token”.

Establishing the connection between HOPEX and CAST Highlight

Before the first use of the code analysis functionality, each user, previously declared
as a CAST Highlight user, must establish a connection between HOPEX and CAST

Highlight.
To establish the connection between HOPEX and CAST Highlight:
1. In the HOPEX desktop, click Administration > CAST Highlight >

Manage Cast Highlight User.
2. Click the drop-down list, then Me to display your information relating to

CAST Highlight.

3. Select your name and click the More { > Generate Token button.
The window for creating a token appears.

4. Specify:
e your CAST Highlight user email
e your password entered in CAST Highlight

5. Click OK.

Launching a Code Analysis Campaign

The code analysis campaign is on the initiative of the application portfolio manager.
It relates to the portfolios whose applications are of the "Specific Development"

type.

m  The "Specific Development" application type is defined in the
application page, in the Identification section of the Characteristics

page.
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To launch a code analysis campaign on an application portfolio:
Display the portfolio properties.
Click the CAST Highlight Campaigns page.
Portfolios containing specially developed applications
Display "All Application Portfolios Developed Specifically".
Select the application portfolio concerned and click Scan Application
Source Code.
The campaign creation window appears.
6. Specify:
e The campaign name
e The closing date, which determines the date on which the scan results
are automatically transferred in HOPEX
e A message to the application managers
7. Click OK.

Following this creation, CAST Highlight sends a notification to the managers
concerned inviting them to launch an analysis of their application codes.

aRhLON=

Launching the Code Analysis

Following the notification received, each application manager connects to CAST
Highlight to:
e download the local agent if this has not already been done

w  The local agent is used to run code analyses and to create the
results file to be uploaded to the CAST Highlight portal.

e launch a code analysis on the applications concerned.

The analysis results are saved in a file. The application manager can transfer them
to the CAST Highlight portal.

To report the results of the analysis in HOPEX ITPM and update the analysis values
on an application:
1. Display the properties of the application in question.
2. Click the drop-down list then Assessment > CAST Highlight Metrics.
3. Click Update Metrics from CAST Highlight.
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EVALUATING THE CLOUD MIGRATION

The Cloud Migration assessment questionnaire is addressed to the IT managers and
owners of the evaluated applications. It presents a series of questions for each
application, the answers to which will enrich the analysis of application migration to
the Cloud.

w  For details of the migration analysis, see "Cloud Migration
Analysis”.

Presentation of the Cloud Migration Questionnaire

To launch a Cloud Migration Assessment Questionnaire:

8.
9.

Noakwh=

In the navigation menu, click Tools > Assessments.

In the edit area, click Session Follow Up.

Display “All sessions”.

Click New.

Select the "Cloud Migration Assessment" template.

Select the portfolio of applications to be evaluated.

Click Next.

A view of the assessment shows the number of objects assessed and the

list of respondents. The respondents are the people appointed “IT

Manager” or “Local Application Owner” on the applications in the portfolio.
w The people involved in a portfolio are visible in the properties of the
portfolio. See also "Designate People Responsible for Applications".

Click Next.

Indicate when to send the questionnaire to respondents:

e Now

e At a specific date and time.

10. Click OK.

The questionnaire is sent to respondents.

Questionnaire Content

The questions in the questionnaire concern an application and are intended to
determine the value of migrating the application to the cloud.

The questions addressed to the application respondents are as follows.

Motivations for moving the application to the Cloud

What are the reasons for moving the application to the cloud? The more options you
check, the more interest there is in moving to the cloud.
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Business and IT Agility

Check the possible motivations:
e Speed to market (quick availability of required resources)
Data and software accessibility from (quite) anywhere
Scalability (adaptation to workload)
Innovation (use capability existing only in cloud)
Obsolescence avoidance (to be always aligned with technical “state of
the art”)

Cost improvement

Check the possible motivations:

e Cost reduction (infrastructure assets, staff costs, sub-contractor
diversity)

e From Capex to Hopex: we go from innovation costs to operating costs

e Cost reduction (infrastructure assets, staff costs, sub-contractor
diversity)

Corporate identity

Green orientation.

Technical interest

Auto scale: automatic load distribution on the servers.

COTS Application

In the case of a COTS ("off-the-shelf") application, the level of customization must
be determined.

An application that requires a lot of customization is more difficult to migrate.

Saas Version of the COTS application

The existence of a SaaS version facilitates migration to the Cloud.

Data breach

Likelihood

Determine the risk of a data breach during and/or after Cloud migration.

Impact

What would be the impact of a data breach during and/or after Cloud migration.
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Service disruption risk

Likelihood

Determine the risk of a service disruption during and/or after Cloud migration.

Impact

What would be the impact of such an interruption?

Risk of out-of-control budget

Likelihood

What is the probability of an out-of-control budget risk during cloud migration?

Impact
What would be the impact?

Technical skills of the migration team

Determine the skill level of the migration team:

e Required skills are mastered
e It won't be a problem with a little training/coaching
e Required skills are totally new for the team

Migration effort

What would be the level of effort to migrate to the cloud?
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PORTFOLIO ANALYSIS REPORTS

HOPEX IT Portfolio Management provides predefined report templates for
application portfolio analysis.

Reports Embedded in a Portfolio

The different report templates proposed as standard by HOPEX IT Portfolio
Management are designed to compare applications of a portfolio based on specific
criteria. Different report types offer different analysis possibilities.

These reports are based on information provided by the application owners. They
do not require any configuration and are available to application portfolio managers.

To access existing reports on an application portfolio:

1. Open the properties of the portfolio.
2. Click the drop-down list then Reporting.

w  For detailed information on reports, see "Generating Reports”, page
375.

Costs Report
The report presents the cost analysis of the portfolio applications, by type
(manpower, infrastructure, etc.) and by year. It offers different views:

e A graphical view of the cost breakdown
e A table of costs by nature
e A table of costs by application

w  For further information on application costs, see "Managing
Application and Application System Costs".
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Example of costs (graphical view)

24,000,000 -
22,000,000
20,000,000
18,000,000
16,000,000
14,000,000 @ Manpower

12,000,000 @ Infrastructure

10,000,000 @ Software License

8,000,000 @ Service
6,000,000
4,000,000
2,000,000

0

Gantt Chart
The Gantt chart represents the lifelines of applications making up the portfolio.

The preparation, production and retirement phases are described for each
application.

w For more information on application life cycle, see "Defining
Application Life".

Example

Q Q Scale step: 5 years

Name 2008 - 2012 2013 - 2017 2018 - 2022 2023 - 2027
= €3 Application
[ Billing
[ Billing v2.0

[ Compliance Management

[ Finance Management

You can customize the report scale to 1, 2 or 5 years.
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Application Inventory and Dependencies

This report presents the functional characteristics of the portfolio's applications in
matrix form (lifecycle, associated technologies, business capabilities covered, etc.).

Example

Applications Application Life Software Business Process Categories Deployment Sensitive
Owner Cyclea Technologies Capabilities Consumers Data.
. ancia

Management

- m"ﬂ"ind(_‘%‘u: . Billing - P
| Management
Billing

B
Billing * & Tho _lda .

« A anne

Products on
Internet .

e
= [ sell Products .

=]
- . . Thornas .
Billing v2.0 e B Retirement

« A anne

Application Positioning

This report shows distribution of applications related to the business addressed,
functionalities covered and technologies used. This presentation enables rapid
identification of applications to be developed.

The report is based on the Business Value, Functional Support and Technical
efficiency from the latest application evaluation.

w  See "Evaluating Application Criticality".
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Example

Eliminate

Costs: €956,118.00 (1%)

3 applications (175%)

B Application == Technical Efficiency == Functional Support Reference Costs |

ol Payroll Management System [l Low Lo Medium €0.00
afl Practical Law W Low I Foor W Low €956,118.00
d Office Supplies Management . Poor . Poor .l’cur €000

Renovate

Costs: €133,267.00 (0%)

3 applications (17%)

B Application == Technical Efficiency == Eyunctional Support Reference Costs

d Investors management . Goed . Low

Medium €38200.00
J Risk Management . Good . Low Medium £82,067.00
JCMLTB Management Medium .Iloo' .(_.ucd

€13,000.00

Applications TIME Report

This report uses Gartner’s TIME (Tolerate, Invest, Migrate and Eliminate) model to
analyze the business value of applications.

In the Assessed characteristics, you can select functional support or technical
efficiency.
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Example

Technical Efficiency
4—

w See also "TIME Analysis".

Business Capability Maps

This report covers distribution of applications in business capabilities .
w See "Generating the Business Capability Map of a Portfolio".

Software technology support alert

This report tracks the obsolescence of technologies associated with the application
portfolio.

It uses the technology Support Alert attribute to detect any conflicts between their
use in the organization and their official lifecycle.

m  See "Defining Technology Life".
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Example

MNA
455 Early Usage
@ Supported Usage
@ Late usage
@ Unsupported Usage

Click on a percentage of the graph to access the list of technologies concerned.

Data handled by portfolio applications

This report presents the data used by the portfolio's applications in the form of a
word cloud.

w  See also: "Defining the Data Used by an Application”.

Data Category of Portfolio Dendrogram

This report displays in dendrogram form the data used by the applications in the
portfolio, according to their category.

w See also: "Defining Data Categories".

Other Reports

Other reports, available in the list of report templates supplied as standard, offer an
analysis of portfolio content.

See:
e "Application decommissioning plan report"

SMART Analyses

SMART analyses are designed to:
e Present repository data to support decision-making
e Formulate recommendations for a decision in a given field
e Preparing for action after the decision
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HOPEX IT Portfolio Management offers two SMART analyses to evaluate the
applications in a portfolio:

e TIME Analysis

e Cloud Migration Analysis

How the SMART analyses work

TIME Analysis and Cloud Migration Analysis are performed on a portfolio of
applications. They present, for each application in the portfolio, the values of
aggregated indicators, as well as the decision recommendation, when available.

Aggregate indicators are calculated from basic indicators that have a default weight
in the calculation.

The value of the aggregated indicators is accompanied by a data completeness
percentage that evaluates the relevance of the analysis.

In the analysis report, commands allow you to:

e recalculate the values of the aggregated indicators

e graphically view the values of the aggregated indicators

e see the data completeness details: a matrix indicates which basic
indicators have been filled in for each application

e finalize analysis

TIME Analysis
TIME analysis provides rationalization recommendations for the applications in a
given portfolio.
Indicators and their weight in the analysis

The recommendations displayed in the analysis are calculated on the basis of
aggregated technical and business indicators.

N .. Defaul

Aggregated indicators Basic indicators etau t

weight
Business indicator Business value 60%
Functional support 30%
Service-level agreement (SLA) 10%
Technical indicator Technical efficiency 40%
Technology obsolescence 40%
Application life cycle 20%
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Sources of basic indicators

The analysis is based on the following basic indicators:

e Business Value, Functional Support and Technical efficiency from
the latest application evaluation.
w See "Evaluating Application Criticality".
e The Service Level Agreement (SLA) defined in the Service Level
Agreement section of the application properties.
e The Obsolescence risk: this corresponds to the highest risk of the
technologies linked to the application.

w  See the obsolescence risk in the "Overview" of an application.

e The Life cycle; the analysis looks for the application’s production end
date and calculates the difference with the current day.

m  See also "Defining Application Life".

Decision options

The possible decisions are as follows:

e "Tolerate": applications that create sufficient business value and whose
costs are manageable, maintained for various reasons.

e "Invest": applications that are most lucrative and interesting in terms of
investment.
“Migrate”: applications that need to be modernized.

e "Eliminate": applications that have low business value or high risk. They
must be eliminated.

Cloud Migration Analysis
Cloud migration analysis presents migration recommendations for applications in a
given portfolio.
Indicators and their weight in the analysis

The recommendations displayed in the analysis are based on the following

indicators.
ﬁ‘gcﬁ::s:::d Basic indicators Source szfiagl:‘l:
Migration Appetite Last “Time"” decision Repository 30%
Latest application criticality assessment Repository 15%
Motivation: number of motivations Questionnaire 25%
Life cycle (the end of production is Repository 15%
approaching)
Auto scale Questionnaire 15%
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ﬁ,%?:g?:rt:d Basic indicators Source Bv‘:fiagl#:
Migration Easyness Number of different application flows Repository 25%
Number of partner applications Repository 25%
Data regulations Repository 25%
Shared databases Repository 25%
Migration Readiness CAST Cloud Ready Score Repository 20%
Migration effort Questionnaire 20%
Application COTS (Customization Questionnaire 20%
weight)
Saas Version of the COTS application Questionnaire 20%
Technical skills of the migration team Questionnaire 20%
Migration Safeness Response time requirement Repository 20%
Big data transfer required Repository 20%
Data Breach Risk Questionnaire 20%
Service disruption risk Questionnaire 20%
Risk of out-of-control budget Questionnaire 20%

Sources of basic indicators

The analysis calculates a score between 0 and 4 for each basic criterion. The value
of the indicator is then aggregated with a weight assigned to it. The aggregate score

is normalized to 100.

w The aggregate score is not an integer.
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The value of the basic indicators is based on:

The TIME matrix values:

e "Tolerate": means that the application has a good technical score but
less at business level. It is kept pending a decision. Migration score: 2.

e “Invest”: high business and technical value. The application is already
good as it is. Score: 3.

e "Mitigate": applies to applications that we want to keep but
restructure. The migration score is high: 4.

e "Eliminate": applications to be excluded. Value: 0.

The last criticality evaluation of the application (business, functional,

technology).

w See "Evaluating Application Criticality".

The migration motivations from the migration assessment questionnaire:
the more options are checked, the higher the score. If 4 or more options
are checked, the score is 4.

w  See "Evaluating the Cloud Migration".

Application lifecycle: the more distant the end date, the more interesting
it is to migrate to the Cloud. The value of the indicator takes into account
the number of months between the start date and the end date of
production:

between 0 and 6 months = 0

between 7 and 12 months = 1

between 13 and 30 months = 2

more than 49 months = 4

m  See also "Defining Application Life".

The number of application flows sent or received by the application: as
the number of flows increases, the migration score decreases (as a large
number of flows increases security risks, bandwidth problems, etc.).
The number of distinct partner applications for flows sent or received by
the application: the more partner applications there are, the lower the
score.
The number of regulatory frameworks associated with the data
categories managed by the application: the more regulations there are,
the lower the score.
The number of deployed databases used by application software
installations that are also used by software installations of other
applications. The more databases, the lower the score.
CAST Cloud Ready Score: this is CAST Highlight's analysis of an
application's source code. The higher the parameter value, the higher the
migration score.
Application flows with “Required latency " qualification: the higher the
latency value, the higher the score.
Application flows with the “"Communication weight" qualification. As the
weight of communication increases, the score decreases.

m  See IT Architecture Guide > Modeling application architectures >

Describing an Application Data Flows > Using a Scenario of an
Application Flows diagram > Application flow qualification.
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Recommandations and decisions

By default, the recommendations are calculated from the ranges of the Business
Value and Technical Efficiency. indicators. The other indicators are not included
in the recommendation.

Recommandations of the analysis are:
e Rehosting/Re-platforming
e Refactoring/Repurchasing
e Retire
e Retain

On these recommendations, possible decisions are:
Replatform

Repurchase

Retain

Refactor

Rehost

Retire

Once the decision to migrate is made, it can be recorded for each application in the
portfolio.

Running a Smart analysis

To run the analysis:

In the navigation bar select Tools > Smart Analyses.

Select the analysis type.

Select the portfolio to be analyzed.

Run analysis.

Recommendations are colored to highlight the decisions to be made.

5. Select the decision from the associated drop-down list.

PoOobd=
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TRANSFORMING THE APPLICATION PORTFOLIO

To upgrade the application and technological assets according to the objectives set,
ITPM provides the tools to plan and follow up on the transformation projects to be
achieved.

Transformation projects can concern business capabilities, applications, application
systems, technologies, etc.

With these objects, depending on your connection profile, you can:

e submit an idea that could become a project demand
e submit a project demand
e directly launch a candidate project

The objects concerned are attached to the project demand or the candidate project
as deliverables.

Once submitted, the ideas and projects are completed then assessed before being
validated or rejected.

For more information on project portfolio management, see "Introduction to Project
Portfolio Management".



MANAGING THE DATA USED IN THE

APPLICATION ASSETS

The following points are covered here:

NENENENEN

Introduction to Data Management in HOPEX IT Portfolio Management
Creating a Business Glossary in HOPEX IT Portfolio Management
Drawing up a Data Inventory in HOPEX IT Portfolio Management
Defining the Data Used by an Application

Assessing the Data Quality in HOPEX IT Portfolio Management

259



260

INTRODUCTION TO DATA MANAGEMENT IN HOPEX IT

PORTFOLIO MANAGEMENT

Scope

HOPEX IT Portfolio Management allows you to link application assets to the data
they use. You can therefore:

make the inventory of data

build a business glossary

connect the data to the relevant applications

assess data quality

generate reports on an application to visualize the scope of the data used
and measure the impact of an application removal on this data.

Thanks to the integrated HOPEX platform you can exploit this data inventory in the
solution dedicated to the data architecture description HOPEX Information
Architecture.

For more details on data governance see the HOPEX Information Architecture

guide.

Profile Associated with Data Management

The Data Asset Manager is responsible for the creation of information assets.

The other profiles of HOPEX IT Portfolio Management can read access these
assets and use them, for example in data flows.
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CREATING A BUSINESS GLOSSARY IN HOPEX IT
PORTFOLIO MANAGEMENT

HOPEX IT Portfolio Management allows you to make an inventory of the
concepts that define business terms and generate a business glossary from which
you can view their definitions, synonyms and illustrations.

Consulting the list of Concepts and their Definitions
HOPEX IT Portfolio Management offers a tool for easy consultation and creation
of concepts from which you can generate a business glossary.

To display concepts and their definitions:
1. Click the Data > Business Dictionaries navigation menu.
2. In the edit area, click Concepts.

For more information on concepts, see: Defining Business Information.

Creating Concepts

To create a concept:
1. In the list of concepts, click + Browse.
2. In the dialog box that appears, specify:
e the term name
e the owner
e the definition of the term
A term is the designation of a concept in a given language.
Example: the "Country" concept has the "Pays" in French and "Country”
in English.
3. Click OK.
The new concept appears in the edit area.
By default, a term is automatically associated with it.

Generating a Business Glossary

HOPEX provides a ready-to-use glossary report to automatically build the business
glossary with terms derived from a set of Business dictionaries. For each term, the
glossary displays a list of associated definitions with their text, synonyms and

components list.

To launch a glossary report:
1. Click the Reports navigation menu.
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To the right of the edit area, click the Create a report button.
Search for the "Glossary Report" and create the report.
Select the source business dictionary(ies).

w  You can select more than one.
Click Preview.

Click Continue to give it a name, a description and rights.
Click Save and open.
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DRAWING UP A DATA INVENTORY IN HOPEX IT PORTFOLIO
MANAGEMENT

In HOPEX IT Portfolio Management you can define business data (Concepts,
Terms, etc.) and logical data (Classes, Attributes, etc.).

Business Dictionary

A business dictionary collects and structures a set of concepts that expresses the
knowledge of a particular area.

The basic component of a business dictionary is the Concept.

A concept expresses the essential nature of a being, an object, or a
word through its properties and characteristics or its specific qualities.

The word that is associated with a Concept and which depends on language is a
Term.

A term is a word or word group, that is used for a specific meaning
in a specific context.

To create a business dictionary with HOPEX IT Portfolio Management:

1. Click the Data > Business Dictionaries navigation menu.

2. In the edit area, select Hierarchy.

3. Click the icon of the Business Dictionaries folder and click New >
Business Dictionary.

4. Specify:
e The name of the business dictionary
e the owner (optional)
e a description (optional)

5. Click OK.

From the Hierarchy View of the business dictionaries you can create concepts and
terms, as well as concepts domains.

For the definition of terms see also Creating a Business Glossary in HOPEX IT
Portfolio Management.

Concept

To create a concept from a business dictionary:

1. In the Hierarchy view, click the icon of the business dictionary then
New > Business Information Building Block.

Select the “Concept” object type.

Click Next.

4. Enter the Name of the concept.

@n
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Concept Domain

The Existing Terms section lists terms with the same name as the new
concept. You can choose to use an already existing term, or create a new
term.

A term is a word or word group, that is used for a specific meaning
in a specific context.

w [f a term has already been created with the same name as the new
concept, this term is automatically connected and appears automatically
in the Term section.

In the Definition Text field, enter the text of the concept definition.
Click Next to associate an image with the concept or OK to finish.

A concept domain is a sub-set of elements of a business dictionary that reduces the
scope of a field.

To create a concept domain:

1.

2
3.

In the Hierarchy view, click the icon of the business dictionary then
New > Business Information Building Block.

Select the “Concept Domain” object type.

Click Next.

The concept domain appears in the Concept Domain folder of the
business dictionary.

Concept Domain Map

A Concept Domain Map is a business information urbanization tool. It represents the
concept domains of a business dictionary and their dependency links.

Creating a Concept Domain Map

To create a Concept Domain Map:

1.

Click the business dictionary icon then New > Concept Domain Map.
The map appears under the business dictionary.

Creating the map diagram

To create the diagram of the concept domain map:

)

Move the mouse over the map and click the Create a diagram button.

B §, Health Centerm

Health Domain Map B + & @ 3% s OB

@ cConcept Domain

Adding components to the map

See The Components of a Concept Domain Map.
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Data Dictionary

A data dictionary collects and structures a set of logical data.

Logical data is a realization of business data (concepts). You can define logical data
to describe the data used in applications (Data Store) and in flows exchanged
between applications.

See also: Defining the Data Used by an Application.

Defining Data Categories
The data category is a mechanism for classifying data such as concepts or classes.
You can define one or more categories on the data.

Examples of data classification:

e Sensitive data

e Reference data

e Confidential data
e etc.

Importing the module of Categories

To use the categories, your administrator must import the Privacy Management
Content module in your environment.

For import a module in HOPEX, see “Importing a module in HOPEX” chapter in the
HOPEX Administration guide.

Accessing the list of categories

To access the list of data categories:

1. Click the navigation menu then Data > Data Architecture.
2. In the edit area, click the Hierarchy tile.
3. Expand the Data Categories folder to see the list of data categories.

Indicating the Category of a Data Item
You can define the category of a data in the data properties.

You can also specify the category when you connect data to an application. See
Connecting Data to an Application.

Visualizing the data of a data category

The Data Categories Dendrogram report allows you to visualize where the data
of a category is used, for example in the application inventory.
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To launch this report:

1. Click the category to display its properties.
2. Click the Reporting page.
3. Select the Data Categories Dendrogram report.

You can also run a report from a portfolio of applications to view data from specific
categories used by the applications in that portfolio.
To launch the report on a portfolio of applications:

1. Open the properties of the portfolio in question.
2. Click Reports > Data Category of Portfolio Dendrogram.

Importing Data in HOPEX IT Portfolio Management

Two Excel templates are available for importing and exporting data:

e The "Concept Template" to import a list of terms with their definitions,
synonyms, etc. See Importing Business Data from an Excel File.

e The "Data Excel Template" template to import classes, attributes, parts,
etc. See Importing Logical Data from an Excel File.

Importing classes can result in the creation of concepts or the linking to concepts
that exist under the same names. In this way, business and logical data are
automatically linked. This mechanism is used to initialize a business dictionary. It
can be configured using the Business dictionary initialization option. For further
details, see Initializing a Business Dictionary Using Logical or Physical Data.
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DEFINING THE DATA USED BY AN APPLICATION

Within the framework of personal data protection, the application owner and data
manager have the possibility to document the data used by the applications and the
way in which this data is accessed.

The information you can enter on an application is:
e the personal data processed by the application, with access rights
(CRUD).
the rights of the persons concerned.
the management of information to the persons concerned and their
consent.

Connecting Data to an Application

To connect data to an application:
1. Open the properties pages of the application.
w  See also Accessing Application Properties.
Click the Characteristics page.
Expand the Data section.
Click New.
In the wizard that appears, select the object type that represents the

data item (Class, Entity, Data view) and the object in question.
6. Click Next.

aroODd

Once the data has been defined, you can specify:
e the access to the data: in create mode (Create), read mode (Read),
update mode (Update), or delete mode (Delete).

w The content of the Data access column is calculated automatically
according to the selected actions ("CRUD" is the default value).

e the category of data: biometric, financial, medical, etc. See Defining
Data Categories.
e if the application is “Golden Source” or “Golden Copy” of this data.

Analyzing Impact between an Application and the Data it Uses

The Data Impact property page allows you to visualize the scope of data used by
an application and to measure the impact of application on the data, and vice versa.

For further information, see Data - Data Gouvernance > Data Architecture and Tools
> Use of Data by the Information System.
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See in which Applications a Data is Used

Reports allow you to see where data is used in your application assets.

To access these reports in ITBM:

1. Click the navigation menu then Reports > Data Reports.
Data usage report templates appear in the edit area.

For further information, see Data - Data Gouvernance > Data Analysis Reports >
Data Usage Reports.
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ASSESSING THE DATA QUALITY IN HOPEX IT PORTFOLIO
MANAGEMENT

An assessment is designed to give values, in a specific context, to data
characteristics.

In HOPEX IT Portfolio Management it is possible to carry out a direct assessment
on the data, as an expert.

w  For an assessment campaign on the data, you need the HOPEX
Information Architecture solution.

The evaluation is supplemented by result analysis tools.

Assessing a Data Item

The assessment can focus on business data such as concepts or logical data such as
classes.

To directly assess a data item:

Open the properties of the data item in question.

Select the Evaluation page.

Click New.

On the page that appears, select a value for each question.
w  For certain identified problems, an optional remediation plan can be
created for data cleansing.

5. Click OK.

Pobd=

Data Evaluation Criteria

HOPEX IT Portfolio Management provides by default a data evaluation template
that focuses on the following criteria:
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Completeness

Identifies percentage completeness of data and missing properties.
Example

Below some columns have no value (in red) and others are
truncated (Dupont@Samp.gm)

First Name  Last Name  Billing Address Shipping Address  Email

Dupont _9 rue Rene Coty Paris 75002 NULL Dupont@Sample.gm

Durand Robin 344 rue de Rivoli 75001 NULL Durand@Sample.com
Accuracy

Identifies the percentage of accurate, reliable data.
Example

Below, for Dupont, the position and the department are
reversed.

For Durand, the item displays a typographical error

For Rene, the department displays an erroneous value.

First Name  Position Department Email

Dupont Product Management Business Analyst Dupont@Sample.gmail

Durand Sftware Engineer Product Development Durand@Sample.com

René Test Analyst xxupoi*£ Rene@Sample.com
Consistency

Identifies the percentage of inconsistency in the data.
Example

Below is an inconsistency in the data format.

Order Number Client Id ShipDate Total

1000 1 1/12/2018 1005
1001 2 1/12/2018 200£
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Validity
Identifies the percentage of invalid data.
Example
The value of the "Available units" field on Prodl should not
be negative.
A withdrawal date is set to Prod2 but the field "Available
units" does not display a null value.
Product Code Name Units Available Retire Date

Uniqueness

This criterion evaluates duplicate data.
Example

The "Client" table must not contain the same occurrence
twice, each record must be unique.

Freshness

This criterion assesses whether the information is available at the required time.

Data Quality Evolution Report

A report template allows you to follow the evolution of the quality of classes and
concepts.

To launch this report:
1. Click the pop-up menu then Reports > Data Reports.
2. In the edit area, click the Data Quality Evolution tile.
The report appears.
3. Select the information concerned (class or concept).
4. Click Refresh the report.
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INTRODUCTION TO PROJECT PORTFOLIO
MANAGEMENT

Project Portfolio Management (PPM) is an approach used by an organization to analyze the potential
return of a set of projects. Its primary aims are to:

e Control the suitability of projects with respect to the strategic objectives
of the organization.

e Ensure consistency between the projects and the organization's
capability.

This approach examines the risks, the available funds, the probable duration of a project and the
expected results. A group of decision-makers assesses the benefits and the priority to be given to
each project to determine the best way to invest the capital and the human resources of the
organization.

In HOPEX IT Business Management and HOPEX IT Portfolio Management solutions, the
HOPEX Project Portfolio Management option offers a set of features to:

e Submit and assess the project demands and candidate projects.

e Validate the candidate projects: the project demand goes through a
validation process that results in a project creation.

e Select and define the project priority: a limited list of projects is drawn
up according to selection criteria (strategic, financial, etc.)

e Analyze and arbitrate the projects.

e Follow project progress.

w  For more details on HOPEX features, see the HOPEX Common

Features guide which presents features common to all HOPEX
products.
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THE ScoPE COVERED BY PPM

The HOPEX Project Portfolio Management option covers the following concepts:

e The management of project demands and candidate projects
e Project portfolio management

Prerequisites for Creating Projects

Importing the PPM module

To be able to use functionalities of HOPEX Project Portfolio Management, you
must first import the PPM module in your environment.

For import a module in HOPEX, see “Importing a module in HOPEX"” chapter in the
HOPEX Administration guide.

It contains:
e The following portfolio types:
e project demand portfolios
e candidate project portfolios and projects in progress
e The states of the project:
e Project demand
e Candidate project
e Ongoing project
e The two criteria weighting models:
e PPM value & risk weighting model
e PPM flat weighting model

Defining project domains

Each project belongs to a project domain.
Before creating a project, you must create the corresponding domain.

See Defining Project Domains.

Managing Project Demands and Candidate Projects

Identifying and documenting demands

The demand manager can create a project demand or research a project demand
created from an idea.

w  For idea creation, see Submitting and evaluating ideas.
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The demand manager can document the project charter and its business case. He/
she can in particular:

e Define the scope of the project in terms of deliverables or impact on the
capabilities of the enterprise,

e Define a forecast budget,
Identify the project risks,
etc.

Assessing demands

The demand manager can assess a project demand:

e According to qualitative and quantitative criteria defined in the project
demand portfolio.

e Through the qualitative assessment (business value level, strategic
alignment, cost, global risk level), which is used to calculate a global
score for the project and compare the projects between each other.

Validating demands
The demand manager can submit a project demand to the demand approver.
The approver can validate or reject the project demand.

A validated demand leads to the creation of a candidate project, submitted for
assessment to project portfolio managers.

Assessing candidate projects

In the same way as demands are assessed, candidate projects can be assessed:

e According to qualitative and quantitative criteria defined in the project
demand portfolio.

e Through the qualitative assessment (business value level, strategic
alignment, cost, global risk level), which is used to calculate a global
score for the project and compare the projects between each other.

Validating candidate projects
The approver can validate or reject the candidate project.

When a candidate project is validated, it takes on the status of a project in progress.

Follow-up of ongoing projects

The project portfolio manager assigns a manager to the project, responsible for
follow-up of the progress of the project. You can view the calendar and the progress
of a project in a report.
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Project Portfolio Management

Selecting the projects and defining priorities

Portfolio managers and administrators define the project domains that determine
the strategic perspectives of the organization in which the projects are classified (for
example: "Business projects"”, "IT projects").

Arbitration portfolios are automatically associated with the domains of the projects
created. They group the projects in the domain, classifying them according to their
type (project demands, candidate projects and ongoing projects).

In an arbitration portfolio, the project portfolio manager and approver can create
analysis portfolios; they represent a sub-set of projects in the arbitration portfolio
and can be assigned to a specific project portfolio manager.

In an arbitration portfolio or an analysis portfolio, the project portfolio manager can:

e Browse, in read-only, the criteria assessed at the project level (for
example, the strategic alignment level, the risk level, the cost level and
other attributes specific to the project).

e Assess the criteria specific to the portfolio (other than the project
criteria).

e Generate project comparison reports (for example, bubble charts) based
on these criteria.

Using an arbitration portfolio or an analysis portfolio, the project portfolio manager
can create scenarios.

In a scenario, the project portfolio manager can choose to select or not a given
portfolio line (which is different from the project validation), and note the impact of
this choice in dedicated reports.

Analyze and arbitrate portfolio projects

Using a portfolio, the project portfolio manager can generate analysis and
comparison reports to compare, for example, the accumulated risks or costs of a
given scenario.

The project portfolio manager can keep one scenario or a set of scenarios.
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ROLES IN HOPEX PROJECT PORTFOLIO MANAGEMENT

HOPEX Project Portfolio Management includes by default profiles and business
roles with specific rights and tasks.

They are part of the workflow associated with objects.

Requester

The requester is the person who creates the demand (role created automatically on
demand creation).

Demand Approver

The demand approver is responsible for validating the demand. The approvers can
be defined globally for a project domain or a portfolio, or on a project-by-project
basis.

Project Portfolio Approver

The project portfolio approver is responsible for validating the demand. The
approvers can be defined globally for a project domain or a portfolio, or on a project-
by-project basis.

Project Manager

The project manager is responsible for project completion and follow-up.

Project Portfolio Manager

The Project Portfolio Manager is responsible for the overall review and approval or
rejection of candidate projects. He/she is responsible for assessing the risk level,
the strategic alignment and the costs/benefits of the project in the project portfolio,
and to thus define the relative benefits of the candidate projects and projects in
progress.

Project Stakeholder

Project stakeholder is the role of an individual, team, or organization that represents
their interests in the project outcomes.
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DEFINING ENTERPRISE PROJECTS

According to the PMI® standard PMBOK, "a project is a temporary enterprise chosen with the aim
of creating a product, a service or a unique result".

A project has a purpose in terms of an acquired, improved/extended or abandoned capability. A
project generates project deliverables.

With HOPEX Project Portfolio Management option, you can:

Submit project demands

Define project content

Assess project demands and candidate projects.
Follow project progress

The points covered here are:

Defining Project Domains
Managing Project Demands
Managing Candidate Projects
Assessing a Project

Follow-up of Ongoing Projects
Project Analysis Reports

ANENENENENEN
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DEFINING PROJECT DOMAINS

A project can be defined in a given project domain.

The project domain defines the sector and the application scope of the project (for
example: business function, IT, search and development). It is the container of a
set of projects on which an arbitration can be conducted.
Two arbitration portfolios are automatically associated with a project domain:

e demand portfolios

e candidate project portfolios and projects in progress

For more details on arbitration portfolios, see Grouping Projects by Portfolio.

Creating a Project Domain

To create a project domain:
1. Click the Projects > Project Domains navigation menu.
2. In the edit area click New.
The create a project domain window appears.

3. Enter the name of the domain.
4. Click OK.

When you create a domain, the two types of portfolios that correspond to the
different project statuses (project demands, candidate projects and projects in
progress), are also created. They are visible in the Project Portfolios.

Assigning a Domain to Persons

It is possible to define particular roles for users on a domain; these roles are then
valid for all the projects in the domain.

To assign a person to a domain:

Display the domain properties.

Click the Assignment page.

Click New.

In the window that opens, select the person or person group.
Select their role. You can define the following roles:

e Demand Approver

e Project Portfolio Approver

e Project Portfolio Manager

6. Click OK.

aprODd=
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MANAGING PROJECT DEMANDS

The demand creators and the demand managers can create new project demands
and view the project demands that were generated using ideas.

Demand managers can document the project charter as well as the business case.
They can in particular define the scope of the project in terms of deliverables and
the risks associated with the project.

Demand Management Process

The project demand process is broken down into three parts:
e (Creating the demand
e Evaluating the demand
e Approving or rejecting the demand

Creating a Project Demand

To be able to create projects, you must import the PPM module. See Prerequisites
for Creating Projects.

You must also have created a project domain. See Defining Project Domains.

To create a project demand:
1. Click the Projects > Projects navigation menu.
2. In the edit area, click the Projects tab.
3. Display “All projects”.
4. Click New.
The window for creating a project appears.
Select the "Demand” project type and click Next.
6. Specify:
e The project name
e the owner project domain
e the project code (optional)
[ ]
[ ]

o

the planned start date
the planned end date
Click OK.

N

Defining the Project Charter
To define the charter for a project:

1. Click the Projects > Projects navigation menu.
2. In the edit area, click the Projects tab.
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3. Display “All projects”.
4. Click the project concerned to display its properties.
5. In the project properties window, click the Project Charter page.

The definition of the project charter includes:
e The identification:
project name
project owner domain
project code (optional)
project manager
state (life cycle status) Defined automatically.
status (workflow step). Defined automatically.
description (comment)
e The project category or categories. See Idea category.
e The initiating ideas: ideas that have inspired the project.

Defining the Business Case of a Project

To define the business case for a project:

Click the Projects > Projects navigation menu.

In the edit area, click the Projects tab.

Display “All projects”.

Click the project concerned to display its properties.

In the project properties window, click the Business case page.

apRhoN=

Transformation objective

A project has an objective with respect to the capabilities of the enterprise (as
defined in a capability map); it can:
e deliver the means to acquire a new capability (innovation)
e extend the coverage of a capability already held (improvement)
e restrict or abandon the coverage of an existing capability
(rationalization).

To add a transformation objective to the project:

1. In the Transformation Objective section, click New.
The creation dialog box for a transformation objective opens.

2. Specify:
e its name
e the transformation type (Innovation, Improvement, Rationalization)
e the capability transformed

3. Click OK.

Project deliverables

A project deliverable defines the result of a project and its impact on or its
contribution to the architectural solution landscape of the enterprise.
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It is defined by a solution block (example: an organization, an application, an
infrastructure element) delivered by the project in the target architectural
landscape. Within the framework of a project deliverable, a block can be:

e New: the project delivers a new block to the target architectural
landscape.

e Updated: the project modifies an existing block in the current landscape,
for example by extending its lifecycle, and delivers the updated version
to the target architectural landscape.

e Deleted: the project deletes an existing target architectural block, which
will therefore not be part of the target landscape.

To add a deliverable to the project:
1. In the Project Deliverables section, click New.
The window for creating a deliverable appears.
2. Specify if you want to:
e create a new block
e update an existing block
e decommission an existing block
3. Click Next.
4. Specify:
e the deliverable name
e the deliverable type
e the deliverable production dates
5. Click OK.

Deliverable production dates

To model component change scenarios for elements in your portfolio without
impacting the life of components in place, you will associate an object life with the
deliverables.
The object life is a set of time periods representing the updated
calendar of object life cycle states.
When the project is terminated (via the corresponding workflow command), the life
cycle of deliverables is automatically transferred to the objects concerned.

To define the life of a project deliverable:
1. In the Deliverables section, select the deliverable in question.
2. Click Properties.
The properties window of the deliverable appears.
3. Click the drop-down list then Object Life.
4. Click New.
The creation of object life dialog box appears.
5. Specify the following characteristics:
e the life cycle that defines the list of possible object states.
w  For more information on proposed life cycles, see Defining Life
Cycles.
e a Begin Date and an End Date which enable positioning of the object
life in time.
6. Click OK.
A Gantt char is used to view the steps of the life cycle of a deliverable.
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On the project, the Gantt char for the lifecycle of the project deliverables
details the lifecycle of the project deliverable.

Project dependencies

A project can depend on other projects:

e In a "positive" sense: a project can have another project as a
prerequisite, of which one of the deliverables is necessary to build a
deliverable of the dependent project (this is the equivalent of an AND
logic: both projects must be conducted jointly to reach the final result).

e In a "negative" sense: two projects can be concurrent and mutually
exclusive (this is the equivalent of the OR logic: only one of the projects
must be managed, not both).

To associate a dependency with the project:
1. In the Project Dependencies section, click New.
2. Specify:
e The name of the dependency
e The project required
e The type of dependency: "Exclusive" or "Prerequisite".
3. Click OK.

Project costs
The specification of the costs of a project take place through the cost lines.

One or more cost lines can be associated with a project.
A cost line enables identification of cost kind and type.

A cost line is characterized by:
e atype: operating or capital;
e a nature: infrastructure (for a deployment), license (for an application),
service, manpower;
e state of the cost line .

Associated with a cost line can be:
e a periodic expense
e one or several fixed expenses

Creating a cost line

To create a cost line for a project:

1. Expand the Costs section.
2. Under Cost Line, click New.
The Creation of a cost line box opens.

To create a single cost line, select option Create only one cost line.
Click Next.

Specify the Name of the cost line.

Select the Cost Type.

Select the Cost Nature.
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8. Select the state of the cost line.

w The states proposed in the drop-down list are the states of the life
cycle associated with the object life.

9. Click Next.
10. Define the periodic expense.

w  Fixed expenses, which can be multiple, are defined separately. For
more details on fixed expense creation, see Adding a fixed expense.

11. Click OK.
The new cost line appears in the Cost Line.

Adding a fixed expense

To associate a fixed expense with a cost line:
1. In the Cost Line section, select the cost line that interests you.
2. In the Cost Line Expensessection, click New.
The Creation of Expense dialog box opens.
3. Specify:
e the Name of the expense
e the Date of the expense,
e the Amount of the expense.
4. Click OK.
The new expense appears in the Fixed Expenses section.

Project benefits

You can specify:

e the Qualitative Benefits: to be entered as a comment.

¢ the Financial Value of the project: in currency = project NPV (net
present value), calculated outside the tool according to the standards of
the enterprise.

e the Return on Investment: calculated attribute, as a %
(Financial value - Budget) / budget

e the Forecast Return on Investment: calculated attribute, as a %
(Financial value - Estimated total cost) / Estimated total cost

e the Actual Return on Investment: calculated attribute, as a %
(Financial value - Real total cost) / Real total cost

Project risks

With HOPEX IT Portfolio Management, you can identify the risks linked to a
project. Each risk is associated with a single project.
To create a project risk:

1. Expand the Risk section.
2. Click New.
The risk creation dialog box appears.

3. Enter the name of the risk and the type of risk (cost, deadline, quality).
4. Click OK.

For risk assessment, see Assessing the Risks of a Project.
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Assigning a Project to Persons

The persons who can be assigned to a project are those who perform one of the
following business roles:
e Demand Approver
Requester
Project Manager
Project Holder
Project Portfolio Approver
Project Portfolio Manager
Project Stakeholder

The author of the idea and the innovation manager can assign persons to a project.

To assign a person or a person group to a project.

1. Click the Projects > Projects navigation menu.

2. In the edit area, click the Projects tab.

3. Display “All projects”.

4. Click the project concerned to display its properties.

5. In the project properties window, click the Assignment page.

6. Click New.

7. In the dialog box that appears, select a Person or a Person Group, as
well as their Business Role.

8. Click OK.

Repeat this procedure to assign other persons to the project.

Validating or Rejecting a Project Demand

After assessment, the demand manager can submit the project demand to a
demand approver.

w  For more details on assessment, see Assessing a Project.

The approver approves or rejects the demand.

Validating a project demand

A validated project demand becomes a candidate project; the state of its life cycle
is automatically modified and it is transferred to the portfolios of the candidate
projects in the domain to which it belongs.

Rejecting a project demand

A rejected project demand remains in the list of projects, with the "Demand
rejected" status. It can be archived.
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MANAGING CANDIDATE PROJECTS

Candidate Project Management Process

The management process of a candidate project is broken down into three parts:

e (Creating the Project

e Assessing the project

¢ Defining the scenarios

e Approving or rejecting the project

Creating a Candidate Project

A project demand validation leads to a candidate project.

The project portfolio manager can create a candidate project directly without going
through the demand management phase, or an ongoing project (in other words
validated) if needed.

To be able to create projects, you must import the PPM module. See Prerequisites
for Creating Projects.

You must also have created a project domain. See Defining Project Domains.

To create a project candidate:
1. Click the Projects > Projects navigation menu.
2. In the edit area, click the Projects tab.

Use the drop-down list to display:

e all projects

e projects by status (candidate projects, ongoing projects)

e the projects assigned to you

Display all projects.

In the demands for the edit area, click New.

The window for creating a project appears.

Select the "Candidate" project type.

Click Next.

Enter the name of the project.

Click Next.

Specify:

the owner project domain

the project code (optional)

the planned start date

the planned end date

the project leader

10. Click OK.

See also: Creating a Project Demand.

o
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Completing the Candidate Project Definition

Once the project is created, you can complete its properties in the same way as for
a project demand.

See:
e Defining the Project Charter
e Defining the Business Case of a Project
e Assigning a Project to Persons

See also:

e Assessing a Project

Validating or Rejecting a Candidate Project

After assessment, the demand manager can submit the candidate project to the
project portfolio approver.

This presupposes that an approver has been previously linked to the project,
portfolio or project domain in question.
m To assign a project to a person, see Assigning a Project to Persons.
w  For more details on assessment, see Assessing a Project.

The project portfolio approver approves or rejects the project.

Validating a candidate project

A validated candidate project becomes an ongoing project; its lifecycle status is
automatically changed.

Rejecting a candidate project

A rejected candidate project remains in the list of projects, with the "Project
rejected" status. It can be archived.
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ASSESSING A PROJECT

A first assessment of a project takes place with the definition of the business case
of the project; you can specify the deliverables, the dependencies with other ideas
or risks, the costs, the benefits, the risks.

The business case elements can be defined on project demand, and subsequently
completed. For more details, see Defining the Business Case of a Project.

Once the project characteristics are defined, an evaluation tool facilitates the
selection of projects and helps define priorities.

The demand managers can assess the projects:

e At the level of the project, via:
e the qualitative review of the project (business value, level of strategic
alignment, etc.)
e the assessment of the project risks
e according to qualitative and quantitative criteria defined in the project
portfolio. See Assessing Portfolio Projects.

Assessing a Project

An assessment can concern a project demand or a candidate project.

To assess a project:

Click the Projects > Projects navigation menu.

In the edit window, click the Projects tab and display all the projects.
Click the project to display its properties.

In the project properties window, click the Project Assessment page.
In the Assessment section, click New Assessment.

An assessment line appears.

6. In each corresponding column, specify:

the business value level

the strategic alignment level

the cost level

the global risk level

aRhwN=

To validate the assessment, select the assessment line and click Validate
Assessment.

w The Project Note attribute visible on a portfolio is calculated
automatically based on these values.
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Assessing the Risks of a Project

Assessing the risks of a project can start on project demand. This can take place
globally on the project (in the Project Assessment) or for each risk associated with
the project (in Risk Assessment).

To assess the risks of a project:

1. Click the Projects > Projects navigation menu.
2. In the edit area, click the Projects tab.
3. Display “All projects”.
4. Click the project concerned to display its properties.
5. In the project properties window, click the Risk Assessment page.
6. Click New Assessment.
7. In the window that appears, select the risks to be assessed.
e Some
o All
8. Click OK.

The assessment appears in the properties window.
You can define:

e TheImpact: characterizes the impact of the risk when it occurs.

e The Likelihood: characterizes the probability that the risk will occur.

e The Inherent Risk Level: The inherent (or gross) risk indicates the
risk to which the organization is exposed in the absence of measures
taken to modify the likelihood of occurrence or impact of this risk. This
is the result of multiplying the impact value and the likelihood value
before taking account of risk prevention or reduction measures.

In summary, an inherent risk = impact x likelihood
It is calculated automatically.

e The Control Level: The Control level characterizes the efficiency level
of control elements deployed (controls) to assess the risk.

e The Net Risk Level: the residual (or net) risk indicates the risk to
which the organization remains exposed after management has
processed the risk. This is the difference between the Inherent Risk
and the Control Level. It is calculated automatically.

See also Analyzing the Project Risks of a Portfolio.
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FoOLLOW-UP OF ONGOING PROJECTS

Process for Follow-up of Ongoing Projects

Ongoing projects result from the validated candidate projects.

m A project portfolio manager can also directly create an ongoing
project.

The project portfolio manager assigns a manager to the project, responsible for
follow-up of the progress of the project.

Project follow-up consists of the following steps:

Starting the project

Specifying the project milestones
Updating the project progress
Terminating the project

Starting a Project

The project portfolio manager and project managers can start a project.

To start a project:

1.

2.
3.
4

oo

Click the Projects > Projects navigation menu.

In the edit area, click the Projects tab.

In the drop down list, select the list of ongoing projects.

Click the icon of the project concerned and select Project Workflow
(Project to Start) > Start the Project.

A dialog box appears:

Enter a comment if required and click OK.

Specify the effective start date of the project and click OK.

The project workflow status switches from "To be started" to "Ongoing
Project".

Specifying the Project Milestones

Between the scheduled start and end dates, intermediate milestones can be defined
and associated with deliverables.

A project milestone defines an intermediate delivery step in the life
cycle of the project life. A project deliverable can be associated with a
project milestone if it is delivered during the project and on the project
date.

w  Associating a project deliverable with a milestone does not affect
automatic initialization of its life cycle; it can be subject to a manual
modification if appropriate.

293



Within the framework of project progress follow-up, you can define the level of

progress for each milestone.

To add a milestone to a project:

oarwN=

Click the Projects > Projects navigation menu.

In the edit area, click the Projects tab.

Display all projects.

Click the project concerned to display its properties.
In the project properties window, click the Project Milestones page.
In the Milestones section, click New.

The window for creating a milestone appears.
Specify:

e The local name

e The scheduled date of the milestone

e A comment if required

Click OK.

Assessing the Progress State of a Project

You can indicate the progression of a project in progress and the different

milestones defined on a project.

Example

My project is 25% complete at this time.

I have reached the first milestone, so I can put it at 100%

this same day.

Updating the project progress

To update the progression of a project in progress:

oaprwN=

8.

Click the Projects > Projects navigation menu.

In the edit area, click the Projects tab.

Display all projects.

Click the project concerned to display its properties.

In the project properties window, click the Execution Monitoring page.

In the History of Project Progression Updates section, click New.
The progress rate creation window appears.

In the Progress Rate section, specify:

e progress rate

e the progress rate date

e the assessment of the progress rate (On time or Late)

e the forecast end date

e the amount spent

e the remaining forecast amount

Click OK.

Viewing the timeline of a project

A report enables you to view the timeline of the project.
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To access them:

1. In the project properties, select the Reports page.
2. Select the "Lifecycle Gantt Chart for Project Deliverables" report.
The project calendar appears.

1. Project Timeline

@ P sae Frogress Project

timeframe

. : . . Forecasted
; P o Dela Forcast delay to 10/31/2017
Milestones il
Actual Start Date : 0472572017
20% - Milestane-1 (8/30/2017) Delivercbles
35% - Milestc
W20

<} === ]

Putting a Project on Stand-by/Canceling a Project

For a project in progress, you can:

e Cancel the project: the project remains visible but cannot be recovered
Update the project on stand-by: the status changes from "Project in
progress" to "Project on stand-by". Subsequently, you can:

e Recover the project on stand-by
e (Cancel the project on stand-by

Terminating a Project

Terminating a project updates the lifecycle of the objects attached to the project.

To terminate a project in progress:
1. Click the icon of the project then Project Workflow (Ongoing
Project) > Terminate the Project.
A message prompts you to confirm the changes to the lifecycle of the
architecture building blocks concerned.

2. Click OK to confirm.
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PROJECT ANALYSIS REPORTS

Dynamic reports are provided by default for projects; they are used to analyze
project content from different angles as well as their impact on the business
capabilities and architecture building blocks.

Reports on the Project Content

Embedded reports on a project are visible in the Reports page of the project
properties window.

Project Costs

This report details the project costs for a given period and by cost type (labor,
infrastructure, etc).

Its input data concerns the costs defined in the project properties (on the Business
case page).
m  To define the costs of a project, see Project costs.

It is possible to configure the cost consolidation period via the Time Period
parameter; for example a sub-total of project costs is possible per quarter.

Time Period: Quarter v

Refresh the report

=] 1]

1. Project Costs fra.s

- g e
Cost Line Total
-“

€51,000.00  €34,000.00 €85,000.00

o) Manpower £51,000.00 | €34,000.00 | €85,000.00
Licence €5,100.00 €3,400.00 €8,500.00
® Licences | £5.100.00 | £3,400.00  £8,500.00

€56,100.00 €37,400.00 EsET AL

Project and Deliverable Timeline Gantt Chart
This report presents the lifecycle of deliverables in the project schedule.

Its input data concerns the production dates of the deliverables as well as the
milestones defined for the project.
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The progress of the project and the projected deadlines declared during the follow-
up of the execution of the project are also reported on the graph.

1. Project Timeline

ﬁ P Scale step: 2 months

Potential De o7

33% - Revue Sprinf 1 (FR) (9/30/2017]

45% - Revue §|

See also:
e Project deliverables
Specifying the Project Milestones
Assessing the Progress State of a Project
Analyzing the Road Map for Portfolio Projects.

Project KPIs

This report analyses the key indicators of the project. It collects the following data:

e The progress and any delays in the project (defined on the Execution
Follow-up page for projects in progress)

e The budget and the costs defined on the project properties (on the
Business case page).
The Return on Investment (calculated)
Cost variance (calculated)

e The project risks

Progression and delays

Project progression and delays are defined using the last update performed on the
project.
w  For further details, see Assessing the Progress State of a Project.
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Budget and costs

A bar chart presents the following data:
e The planned budget, input manually.
e The total forecast cost, calculated according to the last update of the
project (amount spent + remaining to be spent)
e The effective cost, input manually at the end of the project.

w  The "Total cost" displayed in the Costs section is calculated based
on cost lines; it is for information purposes and is not used in the report
calculations.

For information on project cost input, see Project costs.

Return on investment

A bar chart presents the following data:

e Forecast ROI (as a percentage)
e FEffective ROI (as a percentage)

Calculation of the ROI = (profit - budget) / budget.

Forecast variance and effective variance

A gauge displays the following data:

e Forecast variance = (total forecast cost - budget) / budget, as a
percentage.
e Effective variance = (effective cost - budget) / budget, as a percentage.

Forecasted Cost Variance Actual Cost Variance

Risks
A bar chart displays the risks per risk level (low, high, etc.)
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Project summary

This report offers a summary of the characteristics of the project, that is:
The project charter

The persons responsible

The Business case

The execution follow-up

The key project indicators.

Impact Reports for Projects
The Project Portfolio Manager can use reports to analyze the impact of
transformation projects on business capabilities.

This report aims to identify, for the business capability map of a given Enterprise
phase, the relevant transformation projects and their impact on capabilities,
according to the objective of the transformation projects.

To generate the impact report of transformation projects:

1. Click the Reports navigation menu.
2. In the edit area, click Create a report.
3. Search for report type "Projects Impact on Capability Map".
4. Create a report of this type.
Report parameters

The report takes as input:

e A capability map. The list of capability maps included in an enterprise
phase is proposed by default.
e A project portfolio.

Filters allow you to customize the display of objects in the report:

e Enable Purpose Type Criterion: you can display or hide the purpose
type of the projects. This option is enabled by default, with the form "Fill
color": a color highlights the capabilities and projects in the report
according to the type of purpose of the projects.

e Capability Filter: you can only display capabilities that are covered by
solution building blocks. Criteria also allow you to represent the
functionalities associated with capabilities in a specific shape (circle,
triangle, etc.).

e Project Filter: you can display only on-going projects. Criteria also
allow you to display the assessment levels defined on the projects
(business value, cost, etc.).

w  Other filters can be added in customization (by specific queries
connected to the type).

Report Results
The report presents two chapters:

Transformation Projects Impact on Capability Map
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By default, projects are displayed in the relevant capability boxes and highlighted in
a color that depends on the type of transformation purpose.

e Innovate -> green

e Improve -> yellow

e Rationalize -> red

Capabilities are highlighted in a color depending on the associated transformation
purposes.

e Majority of innovation -> green

e Majority of improvement -> yellow

e Majority of rationalization -> red

oject Deliverables Im_. " | [ TST PPM Project Impac...

Transformation Purpose Type
Transformation Purpose Type . .
Agpregated Transformation Purpose Type @ [l Il
Project
O Business Value Lavel .Oo @.
£\ Overall Risk Level AANANAA
DCasf Lovel .EDD.
O Sirategic Alignment Level - .OO @.

Show Levels = All Levels ¥ ¥ Uniold all items

=
& BankATM

= 1 lhamys)

[P Loss of Revenue @ARC

L3
Function Account Type

= 1 ltlemy{s) El 1 them(s)

I (O IS .00

Function Bank Account

Enterprise Stage and Transformation Projects

This chapter displays in a table the projects that are not mapped in the capability
map selected at report entry.
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They correspond to the following elements:
e projects that produce new capabilities in the "target" capability map
e projects that do not achieve any capability

e projects that achieve capability but are not declared in the enterprise
phase.

Within each capability, projects and delivered building blocks (e.g. applications) are
identified as "new", "updated" or "deleted". Project deliverables are listed and
highlighted by color coding based on the type of impact of the deliverable.

e New: in green

e Updated: in yellow

e Deleted: in red

Each solution block is highlighted in a color based on the average impact type of the
project deliverables.
e If the majority of the deliverables are 'new’ - > green
e If the majority of the deliverables are 'updated’ (or not defined) - >
yellow
e If the majority of the deliverables are 'deleted’ - > red

Following this map a table lists the new building blocks that are not listed in the
capability map of the report.
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PROJECT PORTFOLIO MANAGEMENT

Whereas project management aims to focus on scheduling and executing an individual project,
project portfolio management analyzes all projects in progress or potential projects and their
viability in reaching the objectives of the enterprise.

The portfolio management process can be represented in three sub-steps:

® Project selection: a restricted list of projects is drawn up according to
selection criteria (strategic, financial etc.). The projects are classified
according to the strategic perspectives (the domains) used in the
organization.

e Analysis and arbitration: the best project combination is defined to
maximize the objectives and the restrictions of the portfolio.

e Follow-up: the portfolio's performance indicators ensure the alignment of
the portfolio with the strategy of the organization.

The points covered here are:

v Grouping Projects by Portfolio
v Assessing Portfolio Projects
v Analyzing and Arbitrating Portfolio Projects
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GROUPING PROJECTS BY PORTFOLIO

Grouping projects by portfolio summarizes the information relating to different
projects to facilitate decision-making.

Portfolio Types

There are two types of project portfolios:

e Arbitration portfolios, created automatically, which are divided into two
groups:
e project demand portfolios
e candidate project and ongoing project portfolios, used to compare

candidate projects with ongoing projects

e Analysis portfolios you can create later and which make up sub-sets

within the arbitration portfolios.

Arbitration portfolio

Project arbitration portfolios group all the projects created according to their
domain.

When you create a project domain, two types of arbitration portfolios are created
by default and associated with this domain:
e Domain name - demand arbitration portfolio
e Domain name - arbitration portfolio of candidate projects and ongoing
projects

Each new project appears in the dedicated portfolio.

In an arbitration portfolio, the projects can be assessed and compared according to
a number of criteria:

e project criteria: these come from information on the projects (for
example, the costs) or the qualitative evaluation of the project (for
example, the level of strategic alignment).

e portfolio criteria: criteria that can be defined at the portfolio level, above
the project criteria.

See also: Defining Project Domains.

Analysis portfolio

You can create an analysis portfolio in an arbitration portfolio; it groups a sub-set
of parent arbitration portfolio projects. It can be defined to assign certain projects
to a specific portfolio manager.
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Portfolio Lines

For each project added to a portfolio, a portfolio line is created.

A project portfolio line is used to assess the project in the context of a portfolio. It

is linked to assessment criteria and provides the global note of the project in the
context of the portfolio.

See also Assessing Portfolio Projects.

Assigning a Portfolio to Persons

The persons who can be assigned to a project portfolio are:
e the demand approver
e the portfolio manager
e the portfolio approver

For more information on profiles, see Roles in HOPEX Project Portfolio Management.
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ASSESSING PORTFOLIO PROJECTS

You can compare projects defined in a portfolio based on common criteria.

You can also add specific assessment criteria to the portfolio.

Defining Portfolio Assessment Criteria

You can compare the projects defined in a portfolio based on common criteria
associated with the portfolio. This is used in particular to define the priorities for
each project within the portfolio.

Some criteria are provided by default. You can create new criteria.

To create a criterion on a project portfolio:
1. Display the portfolio properties.
2. Click the Projects page.
The criteria appear in the Portfolio Criteriasection.

3. Click New.

The dialog box for creating a criterion opens.
4. Specify:

* jts name

e its type

e its length

e its format
5. Click OK.

Criteria weighting model

A criteria weighting model defines, for a set of criteria, the weight relative to each
of the criterion in the calculation of a weighted scoring criterion, used to
automatically calculate the rank of a project in the context of this portfolio with
respect to its score on these criteria.

Creating a Project Assessment

To create an assessment for the projects of a portfolio:

Display the portfolio properties.

Click the Projects Assessment page.

Click New Assessment.

In the window that appears, select the projects to be assessed.
e Some

o All

PON=
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5. Click OK.
An assessment line is created for each portfolio project with the different
criteria in a column.

6. To define the value of a criterion for a project, select the line of the
project concerned and click in the criterion column.

Assessing common criteria

The criteria common to all projects are calculated automatically on the basis of
assessments performed specifically on the projects.

w  For the qualitative evaluation of a project to appear in the portfolio
properties, the assessment must have been validated at the project
level.

Assessing criteria specific to the portfolio

For criteria created specifically for the portfolio, and are therefore not displayed in
the project properties, you can define them directly on the project assessment line
(drop-down list for a list or direct entry for a number/a text).
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ANALYZING AND ARBITRATING PORTFOLIO PROJECTS

In a portfolio, a number of projects can concern a single object to represent different
hypotheses, exclusive of each other, for the change in this object.

Scenarios can then be created by selecting a set of projects to be produced. The
different scenarios can be compared by means of specific reports:

Using a project portfolio, the project portfolio manager can generate scenario
analysis and comparison reports to decide which scenarios to keep or reject.

In an arbitration portfolio, if several scenarios have been selected for different
analysis portfolios, the project portfolio approver has access to an analysis tool
which provides an overview. This is used, for example, to determine whether
contradictory choices exist for a single project in the different scenarios selected.

Creating a Scenario

Using an arbitration portfolio or an analysis portfolio, the project portfolio manager
can create a number of scenarios.

A scenario defines, in a portfolio, a set of projects that can be implemented. It is
used to generate analysis reports to assess the impact of this set of projects.

To create a scenario:
1. Open the portfolio properties.
2. Click the Transformation Scenarios page.
3. In the Transformation Scenarios section, click New.
The dialog box for creating a scenario opens.

4. Enter the name of the scenario and click OK.
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Defining the properties of the scenario

To define the properties of the scenario:

1. In the portfolio properties, in the Transformation Scenario page,
move the mouse over the scenario in question and click the associated
Properties button.

Characteristics Projects Transformation Scenarios Projects Assessment

[ ¢ Manage sections ]

~ Scenarios of Transformation

+ New

Local name 1

= Focus on Baggage Mana... = |B

2 Properties
= Focus on Passenger Management a

2. In the scenario properties, select the Characteristics page.
Note that for each project held in the portfolio, a scenario line is created.

Scenario lines
For each project held in the portfolio, a scenario line is created.

A scenario line corresponds to a project line in the source portfolio. It uses the
values of the criteria and lifecycle defined on the project line of the portfolio. It is
used to record the potential decision with respect to the project (validated, rejected)
within the framework of the scenario analysis.

In a scenario, the project portfolio manager can decide to select or not select a given
portfolio line in a simulated scenario (which is different from validation of the
project).

Accepting or Rejecting the Project Lines of a Scenario

A project line must be accepted in order to be taken into account in a given scenario.
Conversely, a project line must be rejected if you want the scenario to ignore it.

To accept or reject a project lines in a scenario:

1. Open the properties pages of the scenario.
2. Select the Characteristics page.
3. In the Scenario Lines section, select the project line you want.
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4. In the Decision column, select one of the following values:
e Accepted: the project line is integrated in the scenario.
e In progress: the project line is under review; it is integrated in the
scenario
e Rejected: the project line is not taken into account in the scenario.

Analyzing and Comparing Scenarios

With embedded reports, you can analyze and compare the scenarios created in a
project portfolio.

To view these reports:

1. Display the properties concerned.
2. Click the Reporting page.
3. Select the report concerned.

Comparing scenario costs

This report compares the costs of the selected scenarios.

It relates to the project costs, it does not take into account the impact of the
scenario on the operating cost of the applications.

Project deliverables by scenario
This report details the deliverables included in a scenario; they are classified by
status and whether the projects within the scenario are validated or rejected.
m  See Accepting or Rejecting the Project Lines of a Scenario.

In the example below, two deliverables are part of the projects that were accepted
in the scenario; a new CRM application and a server update.

The solution building blocks will thus be created/updated in the scenario.

1. Projects Deliverables -
Project Impact Validated Projects Rejected Projects
Type

New

Updated

Analyzing the Road Map for Portfolio Projects

The "Project RoadMap" report displays the Gantt chart for projects and the road
maps for project deliverables.
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To see this report:
1. Display the properties concerned.
2. Click the Reporting page.
3. Select the "Project RoadMap" report.

Project Gantt chart

The Gantt chart presents one row per project. The following information is provided
for each project:
Start and end dates
Progress
Dependencies
Declared delays
m  See also

- Follow-up of Ongoing Projects
- Project dependencies.

Roadmap of portfolio project deliverables

The following information is displayed for each portfolio:
e The projects included
The dependencies
The status of projects
The project progress
The dates defined for the project
w See also Follow-up of Ongoing Projects.

Analyzing the Project Risks of a Portfolio
An embedded report for the project portfolio is used to display, in the form of a
heatmap, the risks inherent to the portfolio projects.

To view this report:

1. Display the properties concerned.
2. Click the Reporting page.
3. Select the "Project Portfolio Risk Roadmap".

The heatmap displays the number of risks per risk level (low, high, etc.)

See also: Assessing the Risks of a Project.

Dashboard for Portfolio Projects

This report analyzes the projects included in a portfolio using different graphics.

To launch this report:
1. Display the properties concerned.
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2. Click the Reporting page.
3. Select the "Project Dashboard" report.

Project bubble chart

The bubble chart is used to connect the different key indicators of the portfolio
projects.

To define the project indicators to be displayed in the graph:
1. In the X-axis field, select the first indicator, for example, the profit.

w The profit indicator refers to the financial value. See Project
benefits.

2. In the Y-axis field, select the second indicator, for example, the total

cost.
3. In the Bubble size field, select the third indicator, for example, the ROI.
4. Click Refresh the Report to take the selected data into account.

Project matrix by criteria

For this graph, the parameters selected for report input must be of "enumeration”
type (e.g. Risk level, Business Value Level).

It allows to consult evaluations of a larger number of projects than the bubble graph
(several hundred projects vs. a few dozen).

When you modify the input parameters, you must click on Refresh the Report to
take into account the input data, then click the refresh button of the £ chapter to
update it.

Summary table for project assessments

This table presents the latest assessment of the key indicators of the portfolio

project.
3. Projects Assessment Summary Table =
= strategic T Business — Risk — Cost — Budget — Benefits — Return — ) = X
Alignment Level Value Level  Level  Level on Project Project
Investment Score Rank
= PRO01 Billing Automation 6 - Medium 1-Very 10 - €500,000.00  £€1,000,000.00 100% 3.94 5
Low Very
High
= PRO02 Definition of the Billing 5 - Medium 6 - £€40,000.00 £€40,000.00 0% 473 3

Business Capacity Memurn Medium

= PR03 New Booking Very High Very Low 1l] - - £1,000,000.00  €1,500,000.00 50% 21 T
Application H i Medlum
g

= PRO04 New Online sales 2- Vbry Low 6 - Medium €600,000.00  €700,000.00 1% 4.16 4

administration capacity Medlum Medlurn

= PRO06 Web interface design 6 - Medium 6 - LR €50,000.00 €60,000.00 20% 3.66 6
Medium High

See also Assessing a Project.
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Analyzing the Impact of Portfolio Projects on the Architecture

See Impact Reports for Projects.
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HOPEX IT PORTFOLIO MANAGEMENT
WORKFLOWS

This chapter presents HOPEX IT Portfolio Management workflow diagrams.

v "Application Update Workflow", page 316
v "Technology Validation Workflow", page 317
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APPLICATION UPDATE WORKFLOW

Using workflows, portfolio managers can launch campaigns to update technical and
business information for one or more applications in their portfolios. These
workflows can also be run for all portfolios.

Note that the Application Owners must be correctly specified in the applications for
the workflow to run correctly.

Application Owner

Request Approval

1 :Updemng Aftribute Update Status of the Application

Request IT and Business Update Update In Progress Approval in progress

Accept
[Funct.] v

»

Update Validated

[Funct,

IT and Business Update ‘workflow

L iEmalI the Application Ownér on the End d:
LIEmail the Application Cvvner on the reminder date

{ Unlock ohject with prapagstion

{Updating Attribute Update Status ot the Application

o Updating Attribute Upden:s Status of the Application
Refuse ;

Mpdating Aﬂribu;‘e Updste Status of the Application

Parttolio Manager

When the campaign is launched, an e-mail is sent to the owners of the application.
It includes the following information:
e List of applications to be updated
e End date of the update campaign (which is set at the end of the month
following the date of the request. For example: if the request is made on
September 21, 2023, the end date of the campaign will be October 31,
2023).

The applications to be updated appear in the list Applications to update. A reminder
is automatically sent by email fifteen days before the campaign end date.

Once the application information is updated, the Application Owner submits the
changes to the Portfolio Manager for approval.
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Technology Validation Workflow

TECHNOLOGY VALIDATION WORKFLOW

Functional Administrator and Enterprise Architect profiles can launch the validation
workflow on a technology.

When a vendor is prohibited, all the vendor's technologies automatically change to
"Prohibited" status.

A user holding the role of "Local Correspondent” on a technology can evaluate it and
define it as "Validated", "Accepted" or "Approved". This correspondent must first be
defined in the technology's properties.

—

Set automaticaly the technology s Prohibited due to vendor status

Technalogy Auto Prohibited

Admini.straisfs'

&

Set the technology &5 Probjekg:d

Technology Prohibited
Erterprize Architects

Mew Technology

h 4

Technology Aszessment N | . Setthe technology as Acce
3 La

Civctity Head of Technology Stuety

Wpdating Technology State
Waddating Workflowe Status of Technolocgy

Technalogy Accepted

Set the technology as Apprgved

AN J : I Technology &pproved

Chief Technalogy Officer
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